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 Tinjauan

 Tinjauan keselamatan pribadi

Jika Anda ingin meninjau, membatasi, menghentikan, atau mencegah orang lain mengakses 
perangkat Apple, akun, atau informasi pribadi Anda, petunjuk ini dapat membantu.

Catatan: Sumber daya ini diterapkan utamanya bagi perangkat Apple dengan sistem 
operasi terbaru (iOS 18, iPadOS 18, dan macOS 15), tetapi juga diterapkan ke Apple Watch 
dan HomePod.

 Tidak yakin apa yang Anda butuhkan?
•	 Petunjuk Mendapatkan keamanan dapat membantu dengan solusi segera.

•	 Petunjuk Tetap aman dapat membantu perencanaan ke depan.
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 Mencari solusi spesifik?
•	 Tinjau dan kelola hal yang Anda bagikan (dan dengan siapa) menggunakan Pemeriksaan 

Keselamatan atau Daftar Centang (lihat di bawah).

•	 Akses semua konten di petunjuk ini menggunakan bidang pencarian atau daftar isi 
(di kiri atas setiap halaman petunjuk), atau gunakan indeks berbasis topik kami untuk 
petunjuk pencarian lebih lanjut.

 Pemeriksaan Keselamatan
Pemeriksaan Keselamatan menawarkan cara mudah untuk meninjau dan mengelola 
informasi yang Anda bagikan dengan app dan individu dengan cepat—semuanya di iPhone 
Anda dengan iOS 16 atau lebih baru. Untuk mengetahui versi iOS Anda, buka Pengaturan > 
Umum > Mengenai. Untuk memperbarui, lihat “Memperbarui perangkat lunak Apple Anda” 
nanti di petunjuk ini.

Untuk mengakses Pemeriksaan Keselamatan, gunakan iPhone Anda untuk membuka 
Pengaturan  > Privasi & Keamanan > Pemeriksaan Keselamatan.

Untuk mempelajari lebih lanjut mengenai Pemeriksaan Keselamatan (persyaratan, petunjuk 
arah, FAQ), lihat Pemeriksaan Keselamatan nanti di petunjuk ini.

 Daftar centang
Meskipun banyak orang menganggap Pemeriksaan Keselamatan lebih mudah digunakan, 
Apple juga menawarkan daftar centang nanti di petunjuk ini untuk membantu Anda 
meninjau dan mengelola hal yang Anda bagikan secara manual:

•	 Daftar Centang 1: Membatasi akses perangkat dan akun

•	 Daftar Centang 2: Mengelola informasi lokasi

•	 Daftar Centang 3: Mengelola konten

﻿Bantuan offline
Jika Anda ingin merujuk informasi ini nanti secara offline, Anda dapat:

•	 Mengunduh petunjuk lengkap sebagai PDF menggunakan tautan Unduh petunjuk ini  
(kiri bawah semua halaman petunjuk).

•	 Mencetak halaman individual menggunakan ⌘-P atau Control-klik > Cetak Halaman. 
Agar tautan tetap dapat diklik dalam salinan yang Anda unduh, pilih Simpan sebagai PDF 
di menu PDF kiri bawah di jendela pencetak Anda.

 Masalah lain
•	 Dukungan Apple (https://support.apple.com/): Akses solusi untuk semua produk dan 

layanan Apple Anda—termasuk petunjuk pengguna, bantuan jika lupa kata sandi, dan 
lainnya.

•	 Sumber daya dukungan lainnya (nanti di petunjuk ini)—Jika Anda merasa keselamatan 
Anda terancam, sumber daya tambahan berikut mungkin berguna.

Petunjuk ini diperbarui secara berkala untuk menyediakan informasi yang Anda butuhkan agar 
merasa aman saat menggunakan produk Apple. Lihat Apa yang baru nanti di petunjuk ini.

https://support.apple.com/
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 Apa yang baru di keselamatan pribadi

 Perubahan nama ID Apple
ID Apple kini disebut Akun Apple. Pembaruan ini diberlakukan di seluruh layanan Apple.

 Pembaruan Petunjuk Pengguna Keselamatan Pribadi
Apple telah melakukan perubahan luas pada petunjuk ini, termasuk:

Konten baru

•	 Berhenti berbagi AirTag dan Berhenti membagikan lokasi AirTag yang hilang 
memungkinkan Anda mengontrol siapa yang memiliki akses ke lokasi AirTag Anda.

•	 Merekam dan mentranskrip panggilan di iPhone menjelaskan cara Anda dapat 
menggunakan—atau menghentikan—rekaman panggilan selama panggilan telepon.

•	 Mengelola Pencerminan iPhone membantu Anda melihat komputer Mac mana yang 
diatur untuk pencerminan iPhone, mencabut akses, dan menyesuaikan pengaturan.

•	 Mengunci atau menyembunyikan app menawarkan ketenangan pikiran jika Anda tidak 
ingin orang lain mengakses app tertentu.

•	 Mengelola Berbagi Layar dan Kontrol Layar membantu Anda memahami apa yang dapat 
dilakukan seseorang saat melihat atau mengontrol layar Anda.

Peningkatan

•	 Menjaga agar Akun Apple Anda tetap aman mencakup tugas baru mengenai cara keluar 
dari iCloud.com di semua browser dan mematikan akses web.

•	 Melakukan panggilan darurat atau mengirim teks darurat di iPhone atau Apple Watch 
mencakup tugas baru mengenai cara berbagi video dan foto dengan layanan darurat.

•	 Pemeriksaan Keselamatan mencakup poin baru mengenai Pencerminan iPhone.

•	 Daftar Centang 1: Membatasi akses perangkat dan akun mencakup langkah-langkah 
baru mengenai Pencerminan iPhone serta mengubah kode sandi dan kata sandi Anda.
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 Strategi dan solusi

 Petunjuk mendapatkan keselamatan
Jika Anda atau seseorang yang Anda kenal khawatir bahwa mereka mungkin mengalami 
penguntitan atau pelecehan terkait teknologi pada produk Apple, atau ingin memutuskan 
hubungan digital dengan seseorang, strategi di bawah ini dapat membantu. Untuk 
terhubung dengan organisasi advokasi yang menyediakan dukungan terkait pelecehan, 
kekerasan dalam rumah tangga, penguntitan, atau masalah lainnya, lihat halaman web Siap 
Membantu (https://learn.appleservices.apple/here-to-help).

Jika Anda mencari cara proaktif untuk melindungi diri dari masalah terkait teknologi di 
masa mendatang, lihat petunjuk Tetap Aman nanti di petunjuk ini.

 Strategi untuk mendapatkan keselamatan
Gunakan langkah-langkah di bawah ini untuk membantu mengelola hal yang Anda bagikan 
dan mengamankan perangkat dan akun Anda.

Langkah 1. Utamakan keselamatan

 PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan Anda.

Anda dapat mengunduh atau mencetak salinan petunjuk Mendapatkan keselamatan ini 
untuk referensi di masa mendatang dengan Control-klik dan memilih Simpan Halaman 
Sebagai atau Cetak Halaman.

Langkah 2. Perbarui perangkat lunak Apple Anda

Untuk membantu mengamankan perangkat Anda, pastikan semua perangkat Apple Anda 
memiliki sistem operasi terbaru yang terinstal dengan pembaruan keamanan dan privasi 
terkini. Untuk mempelajari caranya, lihat Perbarui perangkat lunak Apple Anda.

Catatan: Pembaruan perangkat mungkin memerlukan waktu dan daya perangkat untuk 
diselesaikan. Jika Anda berada dalam situasi mendesak atau darurat, Anda mungkin ingin 
melanjutkan ke langkah berikutnya.

 

https://learn.appleservices.apple/here-to-help
https://learn.appleservices.apple/here-to-help
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Langkah 3. Gunakan solusi terpandu

Sebagian besar masalah keselamatan pribadi terkait teknologi berkaitan dengan berbagi 
dan akses. Untuk bantuan terpandu mengenai hal ini, gunakan salah satu dari berikut:

•	 Pemeriksaan Keselamatan: Cara tercepat dan termudah untuk melihat dan mengelola 
berbagi langsung di iPhone Anda. Untuk mempelajari caranya, lihat Pemeriksaan 
Keselamatan nanti di petunjuk ini.

Untuk mengakses, gunakan iPhone Anda dengan iOS 16 atau lebih baru: Buka 
Pengaturan > Privasi & Keamanan > Pemeriksaan Keselamatan. (Anda mungkin perlu 
menggulir ke bawah.)

•	 Daftar centang: Untuk iOS 15 atau lebih lama, atau untuk perangkat Apple lainnya, lihat 
hal berikut nanti di petunjuk ini:

•	 Membatasi akses

•	 Berhenti berbagi

•	 Mengelola lokasi

Langkah 4. Melangkah lebih jauh

Beberapa hal tidak dapat ditinjau atau diubah menggunakan solusi terpandu. Tinjau 
langkah tambahan penting ini.

Petunjuk ini berisi berbagai macam artikel keselamatan pribadi yang berkaitan dengan 
perangkat, fitur, dan pengaturan. Jika Anda menginginkan bantuan dengan fitur atau 
masalah tertentu, gunakan:

•	 Bidang pencarian (kiri atas)

•	 Daftar isi petunjuk ini (kiri atas)

•	 Bantuan untuk situasi tertentu (di bawah)

 Tindakan mendesak
 PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 

potensi dampak keselamatan dan privasi Anda.

Bantuan cepat

•	 Menghentikan semua berbagi dengan cepat menggunakan Pengaturan Ulang Darurat 
(pilihan satu)

•	 Melakukan panggilan darurat atau teks darurat di iPhone atau Apple Watch

•	 Memblokir panggilan dan pesan dari orang tertentu

•	 Menolak percobaan masuk yang tidak diketahui

•	 Menerima peringatan mengenai gambar dan video sensitif

•	 Mengontrol aksesori Rumah Anda dengan aman

•	 Mengelola sidik jari Touch ID
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Mengumpulkan bukti

•	 Merekam aktivitas mencurigakan

•	 Mendapatkan bukti yang terkait dengan Akun Apple lain

 

Mengembalikan perangkat ke pengaturan pabrik

Jika Anda ingin menghapus semua informasi dan pengaturan—termasuk app apa pun 
yang diinstal tanpa sepengetahuan Anda—dan mengatur ulang pengaturan privasi Anda 
agar Anda tidak berbagi lokasi dengan orang atau app mana pun, lihat Mengembalikan 
perangkat ke pengaturan pabrik.

 

Mode Kuncitara

Jika Anda yakin bahwa Anda mungkin telah menjadi target serangan siber yang sangat 
canggih, seperti yang dilakukan oleh perusahaan swasta yang mengembangkan spyware 
sewaan yang disponsori negara, lihat Memperkuat perangkat Anda dengan Mode Kuncitara.

 Bantuan untuk situasi tertentu
Disarankan agar Anda memulai dengan langkah 1–4 di atas, tetapi Anda juga dapat 
menggunakan bagian di bawah ini untuk menemukan artikel yang mungkin berguna bagi 
situasi Anda dengan cepat.

  Seseorang selalu tahu lokasi saya

Ini mungkin terkait dengan seseorang yang berbagi Akun Apple Anda, grup Keluarga 
Berbagi, atau berbagi lokasi atau konten (seperti kalender bersama atau foto yang 
diunggah di media sosial atau kalender bersama).

Mulailah dengan langkah 1–4 di atas. Jika Anda menggunakan daftar centang di Langkah 3, 
mulai dengan Membatasi akses dan Mengelola lokasi.

  Saya tidak bisa masuk ke Akun Apple saya

Untuk mendapatkan kembali akses ke Akun Apple Anda, pertimbangkan artikel Dukungan 
Apple berikut:

•	 Jika Anda merasa Akun Apple Anda telah diretas

•	 Jika Akun Apple Anda terkunci, tidak aktif, atau dinonaktifkan

•	 Jika Anda lupa kata sandi Akun Apple Anda

•	 Cara menggunakan pemulihan akun saat Anda tidak dapat mengatur ulang kata sandi 
Akun Apple Anda

Setelah akses Anda kembali, pertimbangkan hal berikut:

•	 Mengubah alamat email utama Akun Apple Anda — Artikel Dukungan Apple

•	 Mengamankan kata sandi perangkat, app, dan situs web Anda

•	 Membantu mencegah penguncian Akun Apple dan perangkat

•	 Cara proaktif untuk melindungi diri dari masalah di masa mendatang: petunjuk  
Tetap aman

https://support.apple.com/102560
https://support.apple.com/102640
https://support.apple.com/102656
https://support.apple.com/118574
https://support.apple.com/118574
https://support.apple.com/109353
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﻿Seseorang mengunci saya dari perangkat saya, atau saya tidak dapat membuka 
perangkat saya

Untuk mendapatkan kembali akses, lihat artikel Dukungan Apple Jika Anda lupa kode sandi 
iPhone atau iPhone Anda dinonaktifkan.

Setelah akses Anda kembali, pertimbangkan sumber daya berikut untuk membantu 
melindungi perangkat Anda di masa mendatang:

•	 Daftar Centang 1: Membatasi akses perangkat dan akun

•	 Mengatur kode sandi atau kata sandi perangkat yang unik

•	 Menggunakan Touch ID untuk mengamankan perangkat Anda atau menghapus sidik jari 
yang tidak dikenal

•	 Mengamankan perangkat Anda dengan Face ID (iPhone atau iPad)

•	 Mempertimbangkan penambahan kontak pemulihan akun

•	 Mempertimbangkan untuk mengambil tindakan pencegahan menggunakan Petunjuk 
tetap aman.

  Saya ingin melarikan diri atau sedang mempertimbangkan untuk meninggalkan 
hubungan yang tidak terasa aman

Untuk terhubung dengan organisasi advokasi korban yang menyediakan dukungan terkait 
pelecehan, kekerasan dalam rumah tangga, penguntitan, atau masalah lainnya, lihat 
halaman web Siap Membantu (https://learn.appleservices.apple/here-to-help).

1.	 Gunakan solusi terpandu (di atas) untuk meninjau akses dan preferensi berbagi Anda—
dan buat perubahan jika aman bagi Anda untuk melakukannya.

2.	 Tinjau tindakan mendesak ini untuk mempelajari lebih lanjut tentang pemblokiran, 
pengumpulan bukti, dan lainnya.

3.	 Tinjau langkah keselamatan tambahan ini yang mencakup peringatan pelacakan yang 
tidak diinginkan, akun non-Apple, paket seluler, dan lainnya.

  Saya perlu melindungi sesuatu yang lain

 Akses ke perangkat Anda

Tinjau Daftar Centang 1: Membatasi akses perangkat dan akun.

Juga pertimbangkan:

•	 Mengatur kode sandi atau kata sandi yang unik

•	 Membantu agar tidak terkunci

•	 Menggunakan Mode Kuncitara

Untuk melihat artikel lain mengenai melindungi perangkat dan akun Anda, lihat Daftar Isi 
(pojok kiri atas) di bawah “Membatasi akses akun atau perangkat—artikel.”

https://support.apple.com/118430
https://support.apple.com/118430
https://learn.appleservices.apple/here-to-help
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 Lokasi Anda
Tinjau Daftar Centang 2: Mengelola informasi lokasi.

Juga pertimbangkan:

•	 Menjaga kerahasiaan riwayat penelusuran Anda di Safari dan Peta

﻿Konten Anda
Tinjau Daftar Centang 3: Mengelola konten.

Juga pertimbangkan:

•	 Mengelola cara Anda meneruskan konten—mail, pesan teks,  
dan panggilan — dengan aman

•	 Peringatan gambar dan video sensitif

•	 Mengelola pengaturan berbagi Foto

•	 Mengelola metadata lokasi di Foto

﻿App dan browser Anda
•	 Keamanan kata sandi

•	 Kata sandi dan kunci sandi bersama

•	 Fitur privasi app

•	 Meninjau dan menghapus app

•	 Pengaturan app pihak ketiga

•	 Privasi riwayat penelusuran Safari

•	 Pesan

•	 Pengaturan keselamatan

•	 Memblokir panggilan dan pesan dari orang tertentu

•	 Menggunakan Periksa

•	 Foto

•	 Mengelola pengaturan berbagi Foto

•	 Mengelola metadata lokasi

﻿Keluarga dan rumah Anda
•	 Keluarga Berbagi

•	 Aksesori rumah
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﻿Perangkat apa saja yang Anda miliki?
iPhone, iPad, dan Mac

Hampir semua konten Petunjuk Pengguna Keselamatan Pribadi berlaku untuk iPhone, iPad, 
dan Mac.

•	 Untuk meninjau, membatasi, atau menghentikan orang lain mengakses perangkat, akun, 
atau informasi pribadi Anda, lihat Strategi untuk mendapatkan keselamatan sebelumnya 
di petunjuk ini.

•	 Jika Anda berencana untuk mencegah orang lain mendapatkan akses, lihat Petunjuk 
tetap aman.

•	 Untuk cara tambahan untuk berinteraksi dengan berbagai konten di petunjuk pengguna 
ini, lihat tinjauan.

Untuk topik lain terkait perangkat ini, lihat Petunjuk Pengguna iPhone, Petunjuk Pengguna 
iPad, atau Petunjuk Pengguna Mac.

 Apple Watch

Untuk informasi keselamatan pribadi yang relevan dengan Apple Watch, lihat:

•	 Mengelola berbagi Aktivitas di Apple Watch

•	 Menggunakan Lacak untuk mengelola berbagi lokasi

•	 Membuat pesan teks darurat

•	 Mengamankan NameDrop (proaktif)

•	 Menggunakan Periksa untuk Pesan (proaktif)

Untuk topik lain, lihat Petunjuk Pengguna Apple Watch.

Aksesori rumah

Untuk informasi keselamatan pribadi khusus untuk Rumah, lihat Mengontrol aksesori 
Rumah Anda dengan aman.

Untuk topik lain, lihat Petunjuk Pengguna Rumah.

AirTag

Untuk informasi keselamatan pribadi khusus AirTag, lihat Mendeteksi pelacak yang tidak 
diinginkan.

Untuk topik lain, cari Dukungan Apple untuk “AirTag”.

https://support.apple.com/guide/iphone/welcome/ios
https://support.apple.com/guide/ipad/welcome/ipados
https://support.apple.com/guide/ipad/welcome/ipados
https://support.apple.com/guide/mac-help/welcome/mac
https://support.apple.com/guide/watch/welcome/watchos
https://support.apple.com/guide/home/welcome/mac
https://support.apple.com/id-id
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 Petunjuk tetap aman
Halaman ini ditujukan bagi siapa pun yang berupaya secara proaktif melindungi diri dari 
potensi penyalahgunaan, penguntitan, atau pelecehan melalui teknologi. Jika saat ini 
Anda mengalami masalah terkait, lihat Petunjuk mendapatkan keselamatan sebelumnya 
di dokumen ini. Untuk jenis bantuan lain dengan produk atau layanan Apple, lihat Sumber 
daya dukungan lain nanti di dokumen ini.

 Strategi untuk tetap aman
Apple memiliki banyak fitur untuk membantu mendukung keselamatan dan privasi pribadi 
Anda. Berikut adalah beberapa cara untuk memanfaatkannya:

Level 1: Perlindungan minimum

Sebagai garis pertahanan pertama, setiap orang harus mengambil langkah-langkah ini 
untuk melindungi perangkat dan Akun Apple mereka.

•	 Perbarui perangkat lunak Apple di semua perangkat Apple Anda untuk memastikan Anda 
memiliki pembaruan keamanan dan privasi terkini. Lihat Memperbarui perangkat lunak 
Apple Anda. Untuk mempelajari caranya, lihat Perbarui perangkat lunak Apple Anda.

•	 Lindungi akses ke perangkat Anda:

•	 Atur kode sandi atau kata sandi yang unik.

•	 Amankan iPhone atau iPad Anda dengan Face ID.

•	 Mengelola sidik jari Touch ID.

•	 Kelola kata sandi dan kunci sandi bersama.

Amankan Akun Apple Anda:

•	 Jaga agar Akun Apple Anda tetap aman.

•	 Gunakan autentikasi dua faktor.

•	 Atur kontak pemulihan akun.

Level 2: Perlindungan yang lebih baik

Selain level 1, pertimbangkan app Anda, melindungi kata sandi terkait, dan mengelola data 
yang Anda bagikan dengan app tersebut.

•	 Perkuat kata sandi perangkat, app, dan situs web Anda.

•	 Tinjau pengaturan berbagi tertentu:

•	 Gunakan pilihan Mengelola Berbagi & Akses (pilihan dua) Pemeriksaan Keselamatan 
di iPhone dengan iOS 16 atau lebih baru.

•	 Daftar Centang 3: Mengelola konten (Di perangkat lain atau iOS 15 atau lebih lama).

•	 Mengamankan AirDrop.

•	 Mengamankan NameDrop.

•	 Mengelola Grup Tab bersama di Safari.

•	 Mengelola pengaturan Dibagikan dengan Anda.
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•	 Kelola privasi app:

•	 Fitur privasi app.

•	 Tinjau dan hapus app.

•	 Pengaturan app pihak ketiga.

•	 Safari dan Peta: Menjaga kerahasiaan riwayat penelusuran Anda.

Level 3: Perlindungan terbaik

Selain level 1 dan 2, pelajari mengenai alat keselamatan pribadi Apple dan jadikan 
keselamatan sebagai kebiasaan untuk perlindungan terbaik.

•	 Bersiap

•	 Mengaktifkan pemberitahuan pelacakan.

•	 Menghindari permintaan menipu untuk berbagi info.

•	 Menolak percobaan masuk yang tidak diketahui.

•	 Mempelajari cara memblokir orang tertentu.

•	 Pesan, AirDrop, FaceTime: Mengatur peringatan konten sensitif.

•	 Mempertimbangkan penggunaan Periksa untuk Pesan untuk memberi tahu teman 
saat Anda sudah sampai di rumah secara otomatis.

•	 Mengetahui cara melakukan panggilan darurat atau mengirim pesan teks  
(iPhone atau Apple Watch; tergantung negara atau wilayah).

•	 Jadikan keselamatan sebagai kebiasaan

•	 Ambil langkah tambahan untuk melindungi Akun non-Apple Anda, app pihak ketiga, 
kata sandi dan media sosial, serta Rumah, Dompet Apple, dan Keluarga Berbagi.

•	 Gunakan Pemeriksaan Keselamatan di iPhone dengan iOS 16 atau lebih baru secara 
teratur untuk mengelola hal yang Anda bagikan.

Tambahan di bawah ini

•	 Mengelola sidik jari Touch ID.

•	 Memperkuat perangkat Anda dengan Mode Kuncitara.

•	 Mengelola pengaturan keamanan di Pesan.

•	 Mendapatkan bukti yang terkait dengan Akun Apple lain.

https://support.apple.com/119874
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 Pemeriksaan Keselamatan

 Pemeriksaan Keselamatan untuk iPhone dengan iOS 16 atau 
lebih baru
Pemeriksaan Keselamatan—fitur yang tersedia melalui app Pengaturan di iPhone dengan 
iOS 16 atau lebih baru—memungkinkan Anda meninjau, memperbarui, dan berhenti 
membagikan informasi Anda dengan orang dan app tertentu dengan cepat. Pemeriksaan 
Keselamatan memiliki dua pilihan:

•	 Kelola pilihan berbagi dan akses untuk meninjau dan membuat perubahan individual.

•	 Gunakan Pengaturan Ulang Darurat untuk segera berhenti membagikan semua 
informasi.

Untuk mengakses Pemeriksaan Keselamatan, gunakan iPhone Anda untuk membuka 
Pengaturan  > Privasi & Keamanan > Pemeriksaan Keselamatan.

 PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan dan privasi Anda.

 Persyaratan
•	 Memiliki iPhone dengan iOS 16 atau lebih baru.

•	 Untuk mengetahui versi iOS Anda, buka Pengaturan  > Umum > Mengenai.

•	 Untuk memperbarui dari iOS 15.8.3 atau lebih lama: Pengaturan  > Umum > 
Pembaruan Perangkat Lunak. Lihat Perbarui perangkat lunak Apple Anda untuk 
pilihan tambahan.

•	 Memiliki Akun Apple yang menggunakan autentikasi dua faktor.

•	 Masuk ke Pengaturan > [Nama Anda] di iPhone Anda.

Catatan: Anda mungkin memperhatikan perbedaan di Pemeriksaan Keselamatan jika iPhone 
Anda menyalakan Perlindungan Perangkat Curian. Untuk informasi lebih lanjut, lihat artikel 
Dukungan Apple Mengenai Perlindungan Perangkat Curian untuk iPhone.

https://support.apple.com/120340
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 Alternatif: Daftar centang
Jika Anda menggunakan perangkat lain (iPad, Mac) atau mengalami masalah saat 
menggunakan Pemeriksaan Keselamatan, Anda dapat menyesuaikan berbagi dan akses 
secara manual menggunakan daftar centang berikut:

•	 Daftar Centang 1: Membatasi akses perangkat dan akun

•	 Daftar Centang 2: Mengelola informasi lokasi

•	 Daftar Centang 3: Mengelola konten

﻿Tinjauan
Pemeriksaan Keselamatan di iPhone memungkinkan Anda untuk segera berhenti berbagi 
informasi, atau meninjau dan memperbarui berbagi dengan orang dan app tertentu.  
Anda dapat:

•	 Memeriksa dengan siapa Anda berbagi informasi

•	 Meninjau dan mengubah perangkat yang terhubung ke Akun Apple Anda

•	 Mengatur ulang izin privasi sistem untuk app

•	 Mengubah kode sandi iPhone Anda

•	 Mengubah kata sandi Akun Apple Anda

•	 Melakukan perubahan tambahan
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 Pertimbangan keselamatan sebelum Anda memulai
 PENTING: Rencanakan keselamatan Anda.

•	 Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan potensi 
dampak keselamatan dan privasi Anda.

•	 Keluar Cepat membantu Anda melindungi privasi Anda dengan cepat. Ketuk Keluar 
Cepat untuk segera menutup app Pengaturan dan kembali ke Layar Beranda (pojok 
kanan atas di semua layar di Pemeriksaan Keselamatan). Perubahan apa pun yang Anda 
buat sebelum menggunakan Keluar Cepat akan disimpan.

•	 Untuk memulai ulang berbagi dengan seseorang setelah menggunakan Pemeriksaan 
Keselamatan, buka app atau layanan yang informasinya ingin Anda bagikan dan bagikan 
konten tersebut lagi. Beberapa app atau layanan memberi tahu Anda bahwa Anda telah 
melanjutkan berbagi informasi.

Anda dapat menggunakan Pemeriksaan Keselamatan untuk memeriksa dengan siapa Anda 
berbagi informasi, membatasi Pesan dan FaceTime ke iPhone Anda, mengatur ulang izin 
privasi sistem untuk app, mengubah kode sandi Anda, mengubah kata sandi Akun Apple 
Anda, dan lainnya.

Jika Anda ingin memulai kembali berbagi dengan seseorang setelah menggunakan 
Pemeriksaan Keselamatan, buka app atau layanan yang informasinya ingin Anda bagikan 
dan bagikan konten itu lagi.

Jika Anda menyalakan Perlindungan Perangkat Curian, Pemeriksaan Keselamatan mungkin 
berfungsi dengan sedikit berbeda. Untuk mempelajari lebih lanjut mengenai Perlindungan 
Perangkat Curian, lihat artikel Dukungan Apple Mengenai Perlindungan Perangkat Curian 
untuk iPhone (https://support.apple.com/120340).

Catatan: Jika iPhone Anda menyalakan pembatasan Durasi Layar atau menginstal 
profil manajemen perangkat bergerak (MDM) masih dapat menggunakan Pemeriksaan 
Keselamatan, tetapi beberapa pilihan mungkin tidak tersedia.

https://support.apple.com/120340
https://support.apple.com/120340
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 Apa yang saya perlukan untuk menggunakan Pemeriksaan Keselamatan?
Pemeriksaan Keselamatan hanya tersedia di iPhone dengan iOS 16 atau lebih baru. 
Untuk menggunakan Pemeriksaan Keselamatan, Anda harus memiliki Akun Apple yang 
menggunakan autentikasi dua faktor. Anda juga harus masuk ke Pengaturan > [nama Anda] 
di iPhone Anda. (Untuk menemukan versi perangkat lunak yang diinstal di perangkat Anda, 
buka Pengaturan  > Umum, lalu ketuk Mengenai.)

Untuk mengakses Pemeriksaan Keselamatan, buka Pengaturan  > Privasi & Keamanan > 
Pemeriksaan Keselamatan. (Anda mungkin perlu menggulir ke bawah.)

Catatan: Jika Anda tidak memiliki akses ke Pemeriksaan Keselamatan atau mengalami 
masalah saat menggunakan fitur tersebut, Anda dapat menyesuaikan pengaturan berbagi 
dan akses ke perangkat dan akun Anda secara manual. Lihat Daftar Centang 3: Mengelola 
konten nanti di petunjuk ini.

  Langkah 1: Membuka Pemeriksaan Keselamatan

Di iPhone Anda, buka Pengaturan  > Privasi & Keamanan > Pemeriksaan Keselamatan. 
(Anda mungkin perlu menggulir ke bawah.)
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  Langkah 2: Memilih opsi

Pemeriksaan Keselamatan menawarkan dua cara untuk mengelola berbagi, akses, dan 
keamanan akun:

•	 Pengaturan Ulang Darurat: Pengaturan ulang berbagi segera dan menyeluruh untuk 
semua orang dan app.

•	 Kelola Berbagi & Akses: Tinjau dan sesuaikan berbagi dan akses untuk orang dan app 
individual.

Untuk detail spesifik mengenai hal yang dapat diubah dalam Pemeriksaan Keselamatan, 
lihat FAQ Pemeriksaan Keselamatan nanti di petunjuk ini.
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  Pengaturan Ulang Darurat (pilihan satu)

Gunakan Pengaturan Ulang Darurat untuk:

•	 Segera menghentikan berbagi dengan semua orang dan app (lihat FAQ Pemeriksaan 
Keselamatan untuk informasi spesifik).

•	 Meninjau kontak darurat Anda.

•	 Meninjau perangkat yang terhubung ke Akun Apple Anda.

•	 Meninjau nomor telepon yang digunakan untuk memverifikasi identitas Anda.

•	 Mengubah kata sandi Akun Apple Anda dan meninjau keamanan perangkat dan akun.

•	 Ketuk Pengaturan Ulang Darurat, lalu ikuti instruksi di layar. Kemajuan disimpan sesuai 
proses Anda.

Catatan: Jika Anda menyalakan Perlindungan Perangkat Curian, Pemeriksaan 
Keselamatan mungkin berfungsi dengan sedikit berbeda. Untuk mempelajari lebih 
lanjut mengenai Perlindungan Perangkat Curian, lihat artikel Dukungan Apple Mengenai 
Perlindungan Perangkat Curian untuk iPhone (https://support.apple.com/120340).

https://support.apple.com/120340
https://support.apple.com/120340
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  Mengelola Berbagi & Akses (pilihan dua)

Pilihan Mengelola Berbagi & Akses membantu Anda meninjau dan mengelola informasi yang 
Anda bagikan dengan orang lain, informasi yang dapat diakses oleh app, dan memperbarui 
keamanan perangkat dan Akun Apple Anda. Ikuti lima langkah berikut:

1.	 Ketuk Kelola Berbagi & Akses. (Perubahan akan disimpan selagi Anda melakukannya.)

2.	 Untuk meninjau dan berhenti membagikan informasi dengan orang lain:

•	 Ketuk Orang: Pilih orang dalam daftar, tinjau informasi yang dibagikan dengan orang 
tersebut, lalu putuskan informasi mana yang ingin Anda hentikan berbagi dengan 
orang yang dipilih.

•	 Ketuk Informasi: Pilih app dalam daftar, tinjau informasi yang dibagikan dengan orang 
tersebut, lalu putuskan informasi mana yang ingin Anda hentikan berbagi dengan 
orang yang dipilih. Jika app Apple tertentu telah dihapus, seperti Kebugaran atau 
Catatan, Anda mungkin perlu mengunduhnya lagi untuk melihat informasi apa yang 
Anda bagikan.

3.	 Untuk meninjau dan berhenti berbagi informasi dengan app lain:

•	 Ketuk App: Pilih app dalam daftar, tinjau informasi yang dibagikan dengan app 
tersebut, lalu putuskan informasi mana yang ingin Anda hentikan berbagi dengan app 
yang dipilih.

•	 Ketuk Informasi: Pilih informasi yang ingin dibagikan dalam daftar, tinjau informasi 
yang dibagikan dengan app, lalu putuskan informasi mana yang ingin Anda hentikan 
berbagi dengan app yang dipilih.
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4.	 Ketuk Lanjutkan, lalu lakukan salah satu hal berikut:

•	 Tinjau dan hapus perangkat yang terhubung ke Akun Apple Anda.

•	 Tinjau dan perbarui nomor telepon yang digunakan untuk memverifikasi identitas 
Anda.

•	 Perbarui kata sandi Akun Apple Anda.

•	 Tambah atau perbarui kontak darurat Anda.

•	 Perbarui kode sandi perangkat Anda, atau informasi Face ID atau Touch ID.

•	 Jika Anda telah menyelaraskan komputer, Anda dapat meninjau dan menghapusnya 
(khusus iOS 17 atau lebih baru).

•	 Jika Anda memiliki komputer dengan pengaturan Pencerminan iPhone, Anda dapat 
meninjau dan menghapusnya (khusus iOS 18 atau lebih baru).

•	 Jika Anda memiliki iCloud+ dan belum menyalakan Relai Pribadi, Anda dapat 
melakukannya sekarang (hanya iOS 17 atau lebih baru).

5.	 Ketuk Selesai.

6.	 Setelah selesai, buka tugas berikutnya untuk memverifikasi bahwa Anda telah 
menghentikan berbagi.

 PENTING: Tinjau langkah tambahan nanti di petunjuk ini untuk mempelajari kiat 
untuk melindungi informasi pribadi Anda di luar Pemeriksaan Keselamatan.
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  Langkah 3: Memverifikasi perubahan Anda

Setelah menggunakan Pemeriksaan Keselamatan, Anda dapat mengonfirmasikan segala 
perubahan yang Anda buat pada pilihan berbagi menggunakan 4 langkah ini.

1.	 Ketuk tombol Kembali (atau Anda dapat keluar dan membuka kembali Pemeriksaan 
Keselamatan).

2.	 Verifikasi bahwa perubahan yang Anda inginkan telah dilakukan terkait dengan informasi 
yang Anda bagikan dengan orang lain.
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3.	 Verifikasi bahwa perubahan yang Anda inginkan telah dibuat terkait dengan informasi 
yang Anda bagikan dengan app.

4.	 Verifikasi setiap perubahan akun yang Anda buat di:

•	 Perangkat yang terhubung ke Akun Apple Anda.

•	 Nomor telepon yang digunakan untuk memverifikasi identitas Anda.
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•	 Kontak darurat yang Anda tambahkan atau ubah.

•	 Komputer yang diselaraskan yang Anda hapus.



25Petunjuk Pengguna Keselamatan Pribadi

 Di Luar Pemeriksaan Keselamatan
Pemeriksaan Keselamatan tidak dapat meninjau atau mengubah beberapa jenis informasi 
yang dibagikan, termasuk:

•	 Akun dan kata sandi non-Apple.

•	 Berbagi media sosial.

•	 Perangkat tempat Anda masuk ke Akun Apple lain.

•	 iPad atau Mac dengan pengaturan berbagi informasi dinyalakan untuk app lain.

 FAQ Pemeriksaan Keselamatan

 App dan fitur Apple mana yang dapat saya tinjau dan kelola di 
Pemeriksaan Keselamatan?
Anda dapat menggunakan Pemeriksaan Keselamatan untuk meninjau atau berhenti berbagi 
informasi dengan orang lain dari app Apple berikut:

App Informasi yang ingin Anda kelola

Aktivitas

Barang bersama di Lacak

Catatan Bersama

ETA Peta Bersama

Foto Bersama (Termasuk Perpustakaan Bersama dan 
Album Bersama)

Kalender Bersama

Kata Sandi Bersama

Kesehatan

Lokasi bersama menggunakan Lacak

Periksa

Rumah
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 Akses app pihak ketiga apa yang dapat saya tinjau dan kelola di 
Pemeriksaan Keselamatan?
Anda dapat menggunakan Pemeriksaan Keselamatan untuk mematikan akses app pihak 
ketiga ke jenis informasi yang tercantum di bawah ini.

Bluetooth®

Kalender

Kamera

Kontak

File dan Folder

Kesehatan

Jaringan Lokal

Layanan Lokasi

Media dan Apple Music

Mikrofon

Gerakan & Kebugaran

Foto

Pengingat

Penelitian

Pengenalan Ucapan
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 Perubahan apa yang dapat saya buat pada Akun Apple saya 
menggunakan Pemeriksaan Keselamatan?
Pemeriksaan Keselamatan dapat digunakan untuk mengubah informasi yang terkait dengan 
Akun Apple Anda. Misalnya:

•	 Tinjau dan hapus perangkat yang masuk ke akun Anda.

•	 Tinjau dan perbarui nomor telepon tepercaya.

•	 Mengubah kata sandi Akun Apple Anda.

•	 Perbarui kontak darurat Anda.

•	 Memperbarui kode sandi perangkat Anda dan informasi Face ID atau Touch ID.

Jika Anda menyalakan Perlindungan Perangkat Curian, Pemeriksaan Keselamatan mungkin 
berfungsi dengan sedikit berbeda. Untuk mempelajari lebih lanjut mengenai Perlindungan 
Perangkat Curian, lihat artikel Dukungan Apple Mengenai Perlindungan Perangkat Curian 
untuk iPhone (https://support.apple.com/120340).

 Mengapa ada tombol Keluar Cepat?
Individu yang berada dalam situasi kekerasan mungkin perlu segera menyembunyikan 
penggunaan Pemeriksaan Keselamatan mereka. Tombol Keluar Cepat menawarkan cara 
untuk melakukannya.

 Langkah-langkah keselamatan tambahan
Sebagian besar masalah keselamatan pribadi berkaitan dengan berbagi dan akses. Untuk 
bantuan terpandu dalam mengelola hal ini, gunakan salah satu dari berikut:

•	 Pemeriksaan Keselamatan: Di iPhone dengan iOS 16 atau lebih baru, buka Pengaturan  > 
Privasi & Keamanan > Pemeriksaan Keselamatan, atau lihat Pemeriksaan Keselamatan.

•	 Daftar centang: Untuk iOS yang lebih lama atau perangkat lain, lihat daftar centang 
berikut: Membatasi akses, Berhenti berbagi, atau Mengelola lokasi.

Beberapa hal tidak dapat ditinjau atau diubah menggunakan Pemeriksaan Keselamatan 
atau daftar centang. Untuk membatasi berbagi lebih jauh, pertimbangkan untuk mengambil 
langkah-langkah tambahan di bawah ini.

 PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan dan privasi Anda.

https://support.apple.com/120340
https://support.apple.com/120340
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 Langkah-langkah non-Apple
App non-Apple

App yang diinstal di perangkat Anda dapat mengumpulkan informasi mengenai lokasi umum 
Anda. Dengan mempertimbangkan potensi dampak terhadap keselamatan dan privasi 
Anda, Anda mungkin ingin meninjau app yang diinstal dan menghapus app yang tidak Anda 
gunakan atau kenali. Lihat Meninjau dan menghapus app dan Pengaturan app pihak ketiga.

 

Akun dan kata sandi non-Apple

Lindungi informasi pribadi sensitif dalam akun seperti perbankan, belanja, email, media 
sosial, pendidikan:

•	 Ubah kata sandi akun.

•	 Tinjau pengaturan keamanan dan privasi.

•	 Tinjau akun komunikasi (email, telepon, pesan) untuk memastikan tidak ada yang 
diteruskan tanpa izin Anda.

 

Media sosial, belanja, dan akun lainnya

Memposting foto dan informasi pribadi lainnya di media sosial, belanja, atau situs web 
lainnya dapat mengungkapkan detail mengenai lokasi dan kehidupan pribadi Anda.  
Pastikan Anda:

•	 Memeriksa pengaturan privasi dan keamanan di media sosial, belanja, dan akun  
berbasis web lainnya

•	 Meninjau daftar koneksi dan pengikut Anda

•	 Memikirkan baik-baik apa yang Anda posting untuk mencapai level privasi yang Anda 
butuhkan

•	 Mengelola metadata lokasi di Foto

Lihat “Mengelola metadata lokasi di Foto” nanti di petunjuk ini.

 

Perangkat lain yang Anda miliki atau gunakan

Periksa pengaturan berbagi dan akses untuk perangkat lain yang Anda gunakan untuk 
membantu mengamankan informasi Anda. Untuk mempelajari caranya, lihat daftar centang 
Membatasi akses perangkat dan akun. Jika ada orang lain yang bersama Anda, seperti anak 
atau teman, ingat bahwa perangkat mereka mungkin juga berbagi informasi.
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Paket seluler

Jika Anda adalah bagian dari paket seluler bersama, anggota paket lainnya mungkin 
memiliki akses ke lokasi, aktivitas panggilan dan pengiriman pesan, atau detail tagihan 
Anda. Hubungi operator Anda untuk mempelajari lebih lanjut mengenai paket Anda dan 
untuk melihat tindakan keamanan tambahan apa yang dapat diterapkan pada akun Anda, 
seperti PIN akses atau kode, keamanan sebelum perubahan dapat dilakukan.

Jika Anda tidak memiliki paket bersama, tetapi orang lain memiliki akses online ke akun 
paket seluler Anda, mereka mungkin juga memiliki akses ke lokasi, aktivitas panggilan  
dan pengiriman pesan, atau detail tagihan Anda. Dengan mempertimbangkan dampak 
potensial terhadap keselamatan dan privasi Anda, Anda mungkin ingin mempertimbangkan 
untuk memperbarui kata sandi, pin, dan fitur keamanan lainnya yang terkait dengan paket 
seluler Anda.

 

 Langkah-langkah terkait Apple
Pelacakan yang tidak diinginkan

Pertimbangkan untuk mengaktifkan pemberitahuan untuk mendeteksi pelacak yang 
tidak diinginkan (seperti AirTag atau aksesori jaringan Lacak lainnya). Untuk menerima 
peringatan jika salah satu dari pelacak bergerak bersama Anda, nyalakan:

•	 Bluetooth

•	 Layanan Lokasi

•	 Pemberitahuan Pelacakan (buka app Lacak, ketuk Saya, gulir ke Sesuaikan 
Pemberitahuan Pelacakan, lalu nyalakan Izinkan Pemberitahuan)

Lihat “Mendeteksi pelacak yang tidak diinginkan” nanti di petunjuk ini.

 

Rumah dan HomeKit

Jika Anda adalah anggota rumah Apple dan memutuskan untuk keluar sendiri, 
pertimbangkan bahwa orang yang mengelola rumah masih dapat menggunakan aksesori 
HomeKit, seperti kamera, yang dapat memengaruhi keselamatan pribadi Anda.

Lihat “Mengontrol aksesori rumah Anda dengan aman” nanti di petunjuk ini.

 

Dompet Apple

Jika Anda berbagi kartu keuangan atau kunci akses dengan seseorang di Dompet Apple, 
orang yang Anda ajak berbagi mungkin dapat melihat riwayat pembelian Anda atau saat 
Anda membuka kunci pintu.

Detail transaksi keuangan juga dapat dilihat melalui rekening bank bersama dan kartu kredit 
bersama, atau jika orang lain memiliki akses online ke rekening keuangan Anda. Untuk 
meninjau transaksi dan log terkini Anda, buka Dompet Apple. Dengan mempertimbangkan 
potensi dampak terhadap keselamatan dan privasi Anda, Anda mungkin ingin 
mempertimbangkan untuk memperbarui kata sandi yang terkait dengan  
bank dan kartu kredit Anda.
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Keluarga Berbagi

Jika Anda adalah anggota grup Keluarga Berbagi Apple, pengelola Keluarga Berbagi 
mungkin dapat melihat pembelian yang Anda lakukan dan membuat perubahan pada 
pengaturan perangkat anak. Untuk keluar dari grup keluarga, buka Pengaturan, ketuk nama 
Anda, dan buka pengaturan Keluarga Berbagi. Meskipun Anda tidak dapat menghapus akun 
anak dari grup Keluarga Berbagi, Anda dapat memindahkan akun anak tersebut ke grup 
Keluarga Berbagi lain atau cukup menghapus Akun Apple-nya.

Lihat “Meninggalkan atau menghapus anggota dari grup Keluarga Berbagi” nanti di 
petunjuk ini.

Catatan: Untuk melihat apakah Anda bagian dari grup Keluarga Berbagi, buka Pengaturan  > 
[nama Anda] > tab Keluarga Berbagi. Jika Anda melihat nama anggota keluarga, berarti Anda 
berada dalam grup Keluarga Berbagi.
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 Daftar centang untuk perangkat dengan iOS 15 
atau lebih lama

 Daftar Centang 1: Membatasi akses perangkat dan akun
Mengamankan akses ke perangkat dan Akun Apple Anda sangat penting untuk  
keselamatan pribadi terkait teknologi. Daftar centang ini menawarkan jalur terkait yang 
dapat Anda tinjau dan perbarui untuk membantu Anda membatasi berbagi perangkat hanya 
kepada orang-orang yang ingin Anda beri akses.

 PENTING: Jika Anda memiliki iPhone dengan iOS 16 atau lebih baru, Anda dapat 
menggunakan fitur Pemeriksaan Keselamatan.

 PENTING: Jika Anda memiliki iPhone dengan iOS 16 atau lebih baru, Anda dapat 
menggunakan fitur Pemeriksaan Keselamatan, yang ditunjukkan sebelumnya di petunjuk ini.

  Membatasi akses ke perangkat Anda

1.	 Ubah kode sandi di iPhone dan iPad Anda, serta ubah kata sandi masuk di Mac Anda. 
Untuk mempelajari caranya, lihat Mengatur kode sandi atau kata sandi perangkat yang 
unik nanti di petunjuk ini.

2.	 Tinjau perangkat yang masuk ke Akun Apple Anda dengan membuka Pengaturan  > 
[nama Anda] > Perangkat. Untuk menghapus perangkat yang tidak Anda kenali, ketuk 
nama perangkat dan pilih “Hapus dari Akun”. Untuk informasi lainnya, lihat Menjaga agar 
Akun Apple Anda tetap aman nanti di petunjuk ini.

3.	 Periksa perangkat Anda untuk melihat apakah ada tampilan Face ID atau sidik jari 
Touch ID yang tidak terduga. Lihat informasi Face ID dan Touch ID nanti di petunjuk ini.

4.	 Tinjau informasi pribadi dan keamanan Akun Apple Anda dengan masuk ke situs web 
Akun Apple. Untuk informasi lainnya, lihat Menjaga agar Akun Apple Anda tetap aman 
nanti di petunjuk ini.

https://account.apple.com
https://account.apple.com
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5.	 Jika Anda menggunakan autentikasi dua faktor, periksa perangkat tepercaya untuk 
mengetahui perangkat yang tidak Anda kenali. Lihat autentikasi dua faktor nanti di 
petunjuk ini.

6.	 Tinjau app yang diinstal di perangkat Anda untuk mencari app yang tidak Anda kenali 
atau tidak ingat pernah menginstal. Untuk mempelajari caranya, lihat Meninjau dan 
menghapus app nanti di petunjuk ini.

7.	 Tentukan apakah Pencerminan iPhone sudah diatur, lalu cabut akses bila perlu. Untuk 
mempelajari caranya, lihat Mengelola Pencerminan iPhone di iPhone atau Mac Anda 
nanti di petunjuk ini.

8.	 Cari profil konfigurasi manajemen perangkat bergerak (MDM) yang potensial tidak 
diketahui. Profil MDM biasanya diinstal oleh perusahaan, sekolah, atau organisasi resmi 
lainnya. Untuk mempelajari caranya, lihat Meninjau dan menghapus profil konfigurasi 
nanti di petunjuk ini.

9.	 Tinjau dan kelola apa yang Anda bagikan menggunakan daftar centang Daftar Centang 
3: Mengelola konten nanti di petunjuk ini.

 Daftar Centang 2: Mengelola informasi lokasi
Jika Anda menggunakan iPhone dengan iOS 15 atau lebih lama, gunakan daftar centang ini 
untuk membatasi siapa yang dapat melihat lokasi Anda atau untuk berhenti membagikan 
lokasi Anda sepenuhnya. Jika Anda menggunakan iPhone dengan iOS 16 atau lebih baru, 
lihat Pemeriksaan Keselamatan.
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1.	   Jika Anda tidak memiliki versi iOS, iPadOS, atau macOS terbaru dan khawatir 
seseorang memiliki akses fisik ke perangkat Anda, Anda dapat memulihkan 
perangkat ke pengaturan pabrik. Pemulihan pabrik menghapus semua informasi dan 
pengaturan di perangkat Anda. Ini meliputi penghapusan semua app yang diinstal 
tanpa sepengetahuan Anda dan pengaturan ulang pengaturan privasi Anda sehingga 
Anda tidak berbagi lokasi dengan orang atau app mana pun. Pemulihan pabrik juga 
menginstal versi terbaru sistem operasi. Untuk memulihkannya ke pengaturan pabrik, 
lihat Mengembalikan perangkat ke pengaturan pabrik.

2.	 Untuk berhenti membagikan lokasi Anda dengan semua app dan layanan, bahkan untuk 
sementara, buka Pengaturan  > Privasi > Layanan Lokasi dan matikan berbagi lokasi. Ini 
menghentikan semua app di perangkat Anda, bahkan Peta, agar tidak menggunakan lokasi 
Anda. Tidak ada yang diberi tahu jika Anda mematikan Layanan Lokasi, tapi beberapa fitur 
mungkin tidak berfungsi seperti yang diharapkan tanpa akses ke lokasi Anda.

Catatan: Anda juga dapat mematikan Lacak iPhone Saya di tab yang sama jika Anda 
khawatir seseorang mungkin memiliki akses ke akun iCloud Anda. Di daftar app yang 
menggunakan Layanan Lokasi, ketuk Lacak, lalu pilih Jangan Pernah.

3.	 Untuk berhenti berbagi lokasi Anda dengan app dan layanan tertentu, buka  
Pengaturan  > Privasi > Layanan Lokasi, lalu pilih app dan layanan yang tidak ingin Anda 
bagikan lagi. Ketuk nama app, lalu di bawah Izinkan Akses Lokasi, pilih Jangan Pernah.

4.	 Untuk berhenti membagikan lokasi Anda dengan orang tertentu, buka app Lacak  , 
ketuk Orang, pilih orang, lalu ketuk Berhenti Bagikan Lokasi Saya di bagian bawah layar.

Jika Anda telah memulai—lalu berhenti—membagikan lokasi Anda di Lacak, orang 
tersebut tidak diberi tahu dan tidak dapat melihat Anda di daftar temannya. Jika Anda 
mengaktifkan kembali berbagi, mereka mendapatkan pemberitahuan bahwa Anda telah 
mulai membagikan lokasi Anda dengan mereka.

5.	 Untuk berhenti membagikan perkiraan waktu kedatangan (ETA) Anda di Peta, buka Peta, 
pilih Favorit untuk membuka jendela yang berisi semua lokasi yang telah Anda tetapkan 
sebagai Favorit. Ketuk  di samping setiap lokasi yang ingin Anda tinjau pengaturan 
berbagi ETA otomatisnya, lalu gulir ke bawah ke bagian Bagikan ETA dan hapus orang 
yang ingin Anda hentikan berbaginya.

6.	 Untuk memeriksa perangkat dan aksesori mana yang saat ini tersedia melalui Lacak 
untuk setiap orang yang memiliki akses ke Akun Apple Anda, buka Lacak, Perangkat  
dan tinjau daftarnya. Jika ada perangkat yang tidak Anda kenali dan ingin 
menghapusnya, ketuk perangkat tersebut, lalu ketuk Hapus Perangkat Ini.

Catatan: Jika Anda adalah bagian dari Grup Keluarga Berbagi, anggota grup berbagi 
Anda yang telah mengizinkan Anda untuk melihat lokasi perangkat mereka akan 
dicantumkan, dipisahkan menurut nama pemilik.

7.	 Jika foto dan video yang menyertakan metadata lokasi dibagikan, orang yang Anda 
ajak berbagi mungkin dapat mengakses metadata lokasi dan mengetahui lokasi 
pengambilannya. Jika Anda khawatir seseorang memiliki akses ke metadata lokasi yang 
terkait dengan foto atau video Anda, Anda dapat menghapus metadata saat ini dan 
menghentikannya dikumpulkan di masa mendatang.

https://support.apple.com/guide/personal-safety/ips0d7a5df82


34Petunjuk Pengguna Keselamatan Pribadi

 Daftar Centang 3: Mengelola konten
Jika Anda menggunakan iPhone dengan iOS 15 atau lebih lama, gunakan daftar centang 
ini untuk mempelajari cara berhenti berbagi dengan seseorang yang sebelumnya berbagi 
dengan Anda. Jika Anda menggunakan iPhone dengan iOS 16 atau lebih baru, lihat 
“Pemeriksaan Keselamatan untuk iPhone dengan iOS 16 atau lebih baru” sebelumnya di 
petunjuk ini.

1.	   Periksa apakah Anda adalah bagian dari grup Keluarga Berbagi dengan membuka 
Pengaturan  > [nama Anda] dan cari tab Keluarga Berbagi. Jika Anda berada dalam 
grup Keluarga Berbagi, nama anggota keluarga terlihat.

2.	 Jika Anda bagian dari Keluarga dan tidak ingin lagi berbagi informasi, Anda dapat 
menghapus diri Anda (asalkan Anda berumur 13 tahun ke atas). Jika Anda adalah 
yang mengatur Keluarga (kata Pengelola muncul di bawah nama Anda), Anda dapat 
menghapus siapa pun yang berumur 13 tahun ke atas dari sana.

3.	 Di app Lacak  , ketuk tab Orang untuk melihat dengan siapa Anda membagikan lokasi. 
Jika Anda ingin berhenti membagikan lokasi dengan seseorang, pilih orang tersebut, lalu 
ketuk Berhenti Bagikan Lokasi Saya. Untuk berhenti berbagi dengan semua orang, ketuk 
Saya, lalu matikan Bagikan Lokasi.

4.	 Di app Foto , ketuk Album, lalu buka Album Bersama. Pilih album bersama, lalu ketuk 
Orang untuk melihat pemilik album bersama dan orang-orang yang dibagikan album 
tersebut.

•	 Jika Anda adalah pemilik album dan ingin berhenti berbagi, ketuk nama pelanggan 
yang ingin Anda hentikan berbaginya, lalu pilih opsi tersebut.

•	 Jika Anda adalah pelanggan, Anda dapat mengetuk Batal Berlangganan di bagian 
bawah layar. Anda juga dapat menghapus foto apa pun yang Anda bagikan.
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5.	 Di app Kalender , ketuk Kalender. Pilih kalender bersama dan ketuk  untuk melihat 
dengan siapa kalender tersebut dibagikan.

•	 Jika Anda adalah pemilik Kalender dan ingin berhenti berbagi, ketuk nama pelanggan 
yang ingin Anda hentikan berbaginya, lalu pilih opsi tersebut.

•	 Jika Anda adalah pelanggan, Anda dapat memilih Hapus Kalender di bagian  
bawah layar.

6.	 Jika Anda memiliki Apple Watch dan membagikan cincin Aktivitas Anda dengan 
seseorang, Anda dapat memilih untuk berhenti berbagi. Di iPhone, buka app Aktivitas ,  
lalu ketuk Berbagi. Ketuk orang yang Anda bagikan, ketuk namanya, lalu ketuk Hapus 
Teman atau Sembunyikan Aktivitas saya.

7.	 Anda juga dapat memilih untuk membagikan informasi dengan orang lain menggunakan 
app pihak ketiga. Tinjau app yang telah Anda instal di perangkat untuk melihat apakah 
ada yang berbagi informasi. Lihat Mengelola pengaturan berbagi Foto.
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 Membatasi akses akun atau perangkat

 Akses Akun Apple

 Menjaga agar Akun Apple Anda tetap aman
Akun Apple Anda adalah akun pribadi yang Anda gunakan untuk masuk ke perangkat 
Anda dan layanan Apple, seperti App Store, iCloud, Pesan, FaceTime, serta Lacak. Ini juga 
disertai dengan informasi pribadi yang Anda simpan dengan Apple serta bagikan di semua 
perangkat, seperti kontak, info pembayaran, foto, cadangan perangkat, dan lebih banyak 
lagi. Jika orang lain memiliki akses ke Akun Apple Anda, mereka dapat melihat informasi 
yang diselaraskan di semua perangkat, yang dapat menyertakan hal seperti Pesan dan 
lokasi. Pelajari di sini cara mengamankan Akun Apple Anda di iPhone, iPad, dan Mac.

Berikut adalah beberapa hal penting yang dapat Anda lakukan untuk mengamankan 
Akun Apple Anda dan melindungi privasi Anda.
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  Mengamankan Akun Apple Anda

1.	 Jangan bagikan Akun Apple Anda dengan siapa pun, bahkan anggota keluarga, 
pasangan, dan teman dekat. Jika Anda berbagi Akun Apple, Anda memberikan orang 
lain akses ke semua data pribadi dan konten Anda. Jika orang lain mengatur Akun Apple 
dan kata sandi Anda untuk Anda, atau telah memiliki akses ke kata sandi Anda, Anda 
harus mengubah kata sandi Anda.

2.	 Gunakan autentikasi dua faktor untuk Akun Apple Anda. Autentikasi dua faktor dirancang 
untuk memastikan bahwa Anda hanyalah satu-satunya yang dapat mengakses akun 
Anda, meskipun orang lain tahu kata sandi Anda. Dengan autentikasi dua faktor, Anda 
akan perlu menyediakan kata sandi Anda dan kode verifikasi enam digit yang secara 
otomatis muncul di perangkat tepercaya Anda saat Anda ingin masuk ke perangkat baru 
untuk pertama kali.

Untuk mendaftarkan autentikasi dua faktor, Anda harus memverifikasi setidaknya satu 
nomor telepon tepercaya—nomor yang dapat menerima kode verifikasi melalui pesan 
teks atau panggilan telepon yang diautomasi.

3.	 Perhatikan pemberitahuan mengenai Akun Apple Anda. Apple akan memberi tahu Anda 
melalui email, teks, atau pemberitahuan push saat ada perubahan dibuat ke akun Anda, 
seperti saat Anda masuk untuk pertama kali di perangkat baru atau saat kata sandi Anda 
diubah. Oleh karena itu, pastikan Anda selalu memperbarui informasi kontak Anda.

Lihat “Menolak percobaan masuk yang tidak diketahui” di bagian yang lebih awal di 
petunjuk ini.

4.	 Jika Anda menerima pemberitahuan bahwa ada percobaan masuk atau ada perubahan 
yang dibuat ke akun Anda yang tidak Anda sahkan, ini dapat berarti seseorang telah 
mengakses atau mencoba mengakses akun Anda.

  Memeriksa dan memperbarui informasi keamanan Akun Apple

Untuk membantu memastikan bahwa informasi pribadi yang terhubung ke Akun Apple Anda 
adalah milik Anda:

1.	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > [nama Anda].

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, lalu klik nama Anda di bagian 
atas bar samping.

•	 Di browser web di perangkat Mac atau Windows Anda: Buka situs web Akun 
Apple (https://account.apple.com).

https://account.apple.com
https://account.apple.com
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2.	 Di bagian Masuk & Keamanan, perbarui informasi yang salah atau tidak Anda kenali, 
termasuk nama, dan nomor telepon, serta alamat email Anda yang dapat dihubungi.

3.	 Lakukan salah satu hal berikut ini:

•	 Jika Anda telah menyalakan autentikasi dua faktor, tinjau perangkat tepercaya Anda. 
Jika Anda melihat perangkat yang ingin Anda hapus dari akun Anda, ikuti arahan di 
bagian berikutnya.

•	 Jika Anda belum mengatur autentikasi dua faktor, lihat “Menggunakan autentikasi 
dua faktor” nanti di petunjuk ini.

  Mengamankan akun Anda dan menghapus perangkat yang tidak diketahui

Jika terdapat perangkat yang terhubung ke Akun Apple Anda yang tidak Anda kenali atau 
belum Anda sahkan untuk menggunakan akun Anda, Anda dapat mengamankan akun 
Anda dan menghapus perangkat menggunakan langkah di bawah. Menghapus perangkat 
yang tidak diketahui membantu memastikan perangkat tidak dapat lagi menampilkan kode 
verifikasi dan bahwa akses ke iCloud (serta layanan Apple lainnya di perangkat) diblokir 
hingga Anda masuk lagi dengan autentikasi dua faktor.

Anda mungkin juga ingin mengambil tangkapan layar perangkat untuk dokumentasi 
sebelum mengamankan akun Anda.

Ikuti langkah di bawah ini untuk meninjau informasi akun Anda dan melindungi akun.
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1.	 Jika Anda ingin mengubah kata sandi Anda:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > [nama Anda] > Masuk & Keamanan > 
Ubah Kata Sandi. Pilih kata sandi kuat (delapan karakter atau lebih, termasuk huruf 
besar serta kecil, dan setidaknya satu angka).

•	 Di Mac Anda:  Pilih menu Apple  > Pengaturan Sistem, lalu klik nama Anda di bagian 
atas bar samping. Klik Masuk & Keamanan, lalu klik Ubah Kata Sandi.

2.	 Jika Anda ingin mengubah alamat email yang terkait dengan Akun Apple Anda untuk 
keamanan tambahan, buka Safari  dan masuk ke situs web Akun Apple  
(https://account.apple.com). Pilih Akun, dan di bawah Akun Apple Anda saat ini, pilih 
Ubah Akun Apple, lalu masukkan alamat email baru yang ingin Anda gunakan.

3.	 Jika Anda ingin menghapus perangkat yang Anda tidak inginkan untuk terhubung ke 
akun Anda:

•	 Di iPhone atau iPad Anda: Buka Pengaturan > [nama Anda], gulir ke bawah ke daftar 
perangkat, ketuk perangkat yang ingin Anda hapus, lalu ketuk Hapus dari Akun.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, lalu klik nama Anda di bagian 
atas bar samping. Gulir ke bawah ke daftar perangkat, klik perangkat yang ingin 
Anda hapus, lalu klik Hapus dari Akun.

  Mengakses web aman ke data iCloud Anda

iCloud membantu Anda menjaga informasi terpenting—seperti foto, file, dan cadangan—
tetap aman, terbaru, dan tersedia di semua perangkat Anda. iCloud.com menyediakan 
akses ke data iCloud Anda melalui browser web apa pun.

Jika Anda ingin memastikan tidak ada orang lain yang masuk ke Akun Apple Anda di  
iCloud.com, Anda dapat segera keluar dari semua browser. Lakukan hal berikut:

•	 Buka icloud.com/settings, klik Keluar dari Semua Browser, lalu klik Keluar.

Untuk keamanan tambahan dan memberi Anda kontrol lebih besar atas data pribadi Anda, 
Anda juga dapat memilih untuk mematikan akses web ke data iCloud Anda sehingga data 
Anda hanya tersedia di perangkat tepercaya Anda. Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka app Pengaturan, ketuk nama Anda, ketuk iCloud, lalu 
matikan Akses Data iCloud di Web

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik nama Anda, klik iCloud, lalu 
matikan Akses Data iCloud di Web

Untuk detail lainnya, lihat artikel Dukungan Apple Mengelola akses web ke data iCloud Anda.

https://account.apple.com
https://www.icloud.com/settings
https://support.apple.com/102630
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 Menggunakan autentikasi dua faktor
Autentikasi dua faktor adalah lapisan keamanan tambahan untuk Akun Apple Anda yang 
dirancang untuk memastikan bahwa Anda hanyalah satu-satunya yang dapat mengakses 
akun Anda, meskipun seseorang tahu kata sandi Anda. Anda dapat mengatur autentikasi 
dua faktor di iPhone, iPad, dan Mac Anda.

  Mengatur autentikasi dua faktor di iPhone atau iPad Anda

1.	 Buka Pengaturan  > [nama Anda] > Masuk & Keamanan.

2.	 Ketuk “Nyalakan autentikasi dua faktor”, lalu ketuk Lanjutkan.

3.	 Masukkan nomor telepon yang tepercaya, nomor telepon yang Anda gunakan untuk 
menerima kode verifikasi untuk autentikasi dua faktor (nomor juga dapat menggunakan 
nomor untuk iPhone Anda).

Anda dapat memilih untuk menerima kode melalui pesan teks atau panggilan telepon 
otomatis.

4.	 Ketuk Berikutnya.

5.	 Masukkan kode verifikasi yang dikirimkan ke nomor telepon tepercaya Anda.

Untuk mengirim atau mengirim ulang kode verifikasi, ketuk “Tidak menerima kode 
verifikasi?”

Anda tidak akan dimintai kode verifikasi lagi di iPhone Anda kecuali Anda melakukan 
salah satu hal berikut:

•	 Keluar sepenuhnya

•	 Menghapus iPhone Anda

•	 Masuk ke Akun Apple Anda dari halaman web Akun Apple

•	 Perlu mengubah kata sandi Akun Apple Anda untuk alasan keamanan

Setelah Anda menyalakan autentikasi dua faktor, Anda memiliki periode selama dua minggu 
untuk mematikannya. Setelah itu, Anda tidak dapat mematikan autentikasi dua faktor. Untuk 
mematikannya, buka email konfirmasi Anda dan klik tautan untuk kembali ke pengaturan 
keamanan Anda sebelumnya. Perlu diingat bahwa mematikan autentikasi dua faktor akan 
membuat akun Anda kurang aman dan berarti Anda tidak dapat menggunakan fitur yang 
memerlukan tingkat keamanan yang lebih tinggi.



41Petunjuk Pengguna Keselamatan Pribadi

  Mengatur autentikasi dua faktor di Mac Anda

1.	 Pilih menu Apple  > Pengaturan Sistem, klik nama Anda di bagian atas bar samping, 
lalu klik Masuk & Keamanan.

2.	 Klik Atur Autentikasi Dua Faktor, lalu klik Lanjutkan.

3.	 Jawab pertanyaan verifikasi, lalu klik Verifikasi.

4.	 Masukkan nomor telepon Anda untuk verifikasi, pilih metode verifikasi, lalu klik 
Lanjutkan.

5.	 Saat diminta, verifikasi identitas Anda dengan kode verifikasi enam digit yang dikirim ke 
ponsel tepercaya Anda. Anda tidak akan dimintai kode verifikasi lagi di Mac kecuali jika 
Anda benar-benar keluar dari Akun Apple Anda, menghapus Mac, atau perlu mengubah 
kata sandi untuk alasan keamanan.

 Kunci keamanan untuk Akun Apple

Kunci keamanan adalah perangkat eksternal kecil yang terlihat seperti thumb drive 
atau label, dan yang dapat digunakan untuk verifikasi saat masuk ke Akun Apple Anda 
menggunakan autentikasi dua faktor. Kunci Keamanan untuk Akun Apple adalah fitur 
keamanan lanjutan opsional yang dirancang untuk orang yang menginginkan perlindungan 
ekstra dari serangan, seperti penipuan phishing atau rekayasa sosial. Karena Anda 
menggunakan kunci fisik dan bukan kode enam digit, kunci keamanan memperkuat proses 
autentikasi dua faktor dan membantu agar faktor autentikasi kedua Anda tidak dapat 
dicegat atau diminta oleh penyerang.

Untuk mempelajari lebih lanjut mengenai kunci keamanan, lihat artikel Dukungan Apple 
“Mengenai Kunci Keamanan untuk Akun Apple” (https://support.apple.com/102637).

 Membantu mencegah penguncian Akun Apple  
dan perangkat
Kontak pemulihan akun adalah orang tepercaya yang dapat membantu mendapatkan 
kembali akses ke akun Anda jika Anda lupa kata sandi atau kode sandi perangkat, atau 
jika kata sandi atau kode sandi Anda diubah tanpa izin Anda. Kontak pemulihan akun tidak 
memiliki akses ke akun Anda; mereka hanya memiliki kemampuan untuk mengirimi Anda 
kode pemulihan akun jika Anda membutuhkannya. Atur kontak pemulihan akun di iPhone, 
iPad, atau Mac Anda agar Anda dapat memperoleh kembali akses ke data Anda jika Anda 
tidak dapat masuk.

https://support.apple.com/102637


42Petunjuk Pengguna Keselamatan Pribadi

Catatan: Selain kontak pemulihan, Kontak Pewaris adalah cara termudah dan teraman 
untuk memberi orang yang Anda percayai akses ke data yang disimpan di Akun Apple Anda 
setelah Anda meninggal. Lihat artikel Dukungan Apple “Cara menambahkan Kontak Pewaris 
untuk Akun Apple Anda” (https://support.apple.com/102631).

Untuk menjadi kontak pemulihan akun, orang tersebut harus berumur 13 tahun ke atas, 
memiliki perangkat dengan iOS 15, iPadOS 15, macOS 12, atau lebih baru, menyalakan 
autentikasi dua faktor untuk Akun Apple mereka, dan mengatur kode sandi di perangkat 
mereka.

  Mengatur kontak pemulihan akun

Jika Anda khawatir seseorang mungkin mengakses akun Anda untuk mengubah kata sandi 
Anda dan mengunci Anda di luar akun, Anda dapat mengatur kontak pemulihan akun 
tepercaya untuk membantu Anda mendapatkan akses kembali.

1.	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > [nama Anda], lalu ketuk Masuk & 
Keamanan.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik nama Anda di bagian 
atas bar samping, lalu klik Masuk & Keamanan.

2.	 Pilih Pemulihan Akun, tambahkan kontak pemulihan, lalu sahkan dengan Face ID, 
Touch ID, kode sandi, atau kata sandi.

3.	 Jika Anda berada dalam grup Keluarga Berbagi, anggota grup dianjurkan. Atau, Anda 
dapat memilih salah satu kontak Anda.

4.	 Jika Anda memilih anggota keluarga, mereka ditambahkan secara otomatis. Jika Anda 
memilih kontak, mereka harus menerima permintaan.

5.	 Setelah mereka menerima permintaan, Anda melihat pesan bahwa mereka telah 
ditambahkan sebagai kontak pemulihan akun Anda.

https://support.apple.com/102631
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  Melihat dan menghapus kontak pemulihan

Jika Anda ingin melihat atau menghapus kontak pemulihan Anda.

1.	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > [nama Anda], lalu ketuk Masuk & 
Keamanan.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik nama Anda di bagian 
atas bar samping, lalu klik Masuk & Keamanan.

2.	 Di bawah Asisten Pemulihan, Anda melihat daftar kontak pemulihan.

3.	 Pilih Kontak Pemulihan yang ingin Anda hapus, lalu hapus kontak.

 Akses perangkat

 Mengelola sidik jari Touch ID
Gunakan Touch ID untuk membuka iPhone, iPad, atau Mac dengan aman dan nyaman, 
mengesahkan pembelian dan pembayaran, dan masuk ke banyak app pihak ketiga dengan 
menekan tombol Utama menggunakan jari atau jempol Anda.

Untuk menggunakan Touch ID, Anda harus mengatur kode sandi di iPhone, iPad, atau Mac 
Anda terlebih dahulu.

PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan dan privasi Anda.

 Mengamankan perangkat Anda dengan Touch ID
Untuk menggunakan Touch ID, Anda harus mengatur kode sandi di iPhone atau iPad Anda 
terlebih dahulu.
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  Mengatur Touch ID di iPhone atau iPad Anda

1.	 Jika Anda tidak menyalakan pengenalan sidik jari saat pertama kali mengatur iPhone 
atau iPad, buka Pengaturan  > Touch ID & Kode Sandi.

2.	 Nyalakan salah satu pilihan, lalu ikuti instruksi pada layar.

Catatan: Jika Anda tidak dapat menambahkan sidik jari atau membuka iPhone atau iPad 
Anda menggunakan Touch ID, lihat artikel Dukungan Apple “Jika Touch ID tidak berfungsi  
di iPhone atau iPad Anda” (https://support.apple.com/101612).

  Mengatur Touch ID di Mac atau Magic Keyboard Anda

Untuk menggunakan Touch ID, Anda harus mengatur kata sandi di Mac terlebih dahulu.

1.	 Pilih menu Apple  > Pengaturan Sistem, lalu klik Touch ID & Kata Sandi  di bar 
samping.

2.	 Klik Tambah Sidik Jari, masukkan kata sandi Anda, lalu ikuti instruksi pada layar.

Jika Mac atau Magic Keyboard Anda memiliki Touch ID, sensor terletak di kanan atas 
papan ketik Anda. Anda dapat menambahkan hingga tiga sidik jari ke akun pengguna 
Anda (dan Anda dapat menyimpan maksimum lima sidik jari di Mac Anda).

3.	 Klik kotak centang untuk memilih cara Anda ingin menggunakan Touch ID:

•	 Membuka Mac Anda: Gunakan Touch ID untuk membuka Mac ini saat Anda 
membangunkannya dari mode tidur.

•	 Apple Pay: Gunakan Touch ID untuk menyelesaikan pembelian yang Anda lakukan di 
Mac ini menggunakan Apple Pay.

•	 iTunes Store, App Store, & Apple Books: Gunakan Touch ID untuk menyelesaikan 
pembelian yang Anda lakukan di Mac ini dari toko online Apple.

•	 Isi-Auto Kata Sandi: Gunakan Touch ID untuk mengisi nama pengguna serta kata 
sandi secara otomatis dan untuk mengisi informasi kartu kredit secara otomatis saat 
diminta selagi menggunakan Safari serta app lainnya.

•	 Menggunakan sensor Touch ID untuk pengalihan pengguna cepat: Gunakan Touch ID 
untuk beralih akun pengguna Mac.

  Menghapus sidik jari Touch ID yang tidak dikenal dari iPhone atau iPad

Jika ada beberapa sidik jari Touch ID di iPhone atau iPad Anda, Anda dapat menghapusnya 
untuk membantu mengamankan akses ke perangkat Anda.

1.	 Buka Pengaturan  > Touch ID & Kode Sandi.

2.	 Jika ada lebih dari satu sidik jari dan tidak disebutkan namanya, Anda dapat meletakkan 
jari di tombol Utama untuk mengidentifikasi sidik jari Anda. Pertimbangkan untuk 
memberi nama sidik jari Anda untuk membantu Anda mengidentifikasinya nanti.

3.	 Jika perlu, ketuk sidik jari, lalu ketuk Hapus Sidik Jari.

Catatan: Jika Anda tidak dapat menambahkan sidik jari atau membuka iPhone atau iPad 
Anda menggunakan Touch ID, lihat artikel Dukungan Apple Jika Touch ID tidak berfungsi 
di iPhone atau iPad Anda.

https://support.apple.com/101612
https://support.apple.com/101612
https://support.apple.com/101612
https://support.apple.com/101612
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  Menghapus sidik jari Touch ID yang tidak diketahui dari Mac atau Magic Keyboard

Jika ada beberapa sidik jari Touch ID di Mac atau Magic Keyboard Anda, Anda dapat 
menghapusnya untuk membantu mengamankan akses ke perangkat Anda.

1.	 Pilih menu Apple  > Pengaturan Sistem, lalu klik Touch ID & Kata Sandi  di bar 
samping.

2.	 Lakukan salah satu hal berikut:

•	 Menghapus sidik jari: Klik sidik jari, masukkan kata sandi Anda, klik OKE, lalu klik Hapus.

•	 Menambahkan sidik jari: Klik Tambah Sidik Jari untuk menambahkan sidik jari baru, 
lalu pilih opsi mana yang ingin Anda gunakan dengan Touch ID.

 Mengamankan iPhone atau iPad Anda dengan Face ID
Face ID diperuntukkan bagi orang yang ingin menambahkan lapisan keamanan tambahan ke 
iPhone atau iPad mereka. Ini membantu memastikan bahwa tidak ada orang lain yang dapat 
mengakses informasi yang disimpan di perangkat Anda. Untuk menggunakan Face ID, Anda 
harus mengatur kode sandi di iPhone atau iPad Anda terlebih dahulu.

Untuk melihat daftar perangkat yang didukung, lihat artikel Dukungan Apple “Model iPhone 
dan iPad yang mendukung Face ID” (https://support.apple.com/102854).

  Mengamankan iPhone atau iPad Anda dengan Face ID

•	 Jika Anda tidak mengatur Face ID saat pertama kali mengatur iPhone atau iPad, buka 
Pengaturan  > Face ID & Kode Sandi > Atur Face ID, lalu ikuti instruksi pada layar.

Jika Anda memiliki keterbatasan fisik, Anda dapat mengetuk Pilihan Aksesibilitas saat 
Anda mengatur Face ID. Saat Anda melakukan ini, pengaturan pengenalan wajah tidak 
memerlukan rentang gerakan kepala yang penuh. Penggunaan Face ID masih aman, tapi 
fitur tersebut akan mengharuskan Anda untuk melihat ke arah iPhone atau iPad dengan 
cara yang lebih konsisten.

https://support.apple.com/102854
https://support.apple.com/102854
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Face ID juga memiliki fitur aksesibilitas yang dapat digunakan jika Anda merupakan tuna 
netra atau memiliki daya penglihatan rendah. Jika Anda tidak ingin Face ID memerlukan 
Anda untuk melihat ke arah iPhone atau iPad dengan mata yang terbuka, buka Pengaturan > 
Aksesibilitas, lalu matikan Perlukan Perhatian untuk Face ID. Fitur ini akan dimatikan secara 
otomatis jika Anda menyalakan VoiceOver saat pertama kali mengatur iPhone atau iPad.

Lihat “Mengubah pengaturan Face ID dan perhatian di iPhone” (https://support.apple.com/
guide/iphone/iph646624222) di Petunjuk Pengguna iPhone atau “Mengubah pengaturan 
Face ID dan perhatian di iPad” di Petunjuk Pengguna iPad (https://support.apple.com/
guide/ipad/ipad058b4a31).

  Mengatur ulang Face ID untuk menghapus tampilan alternatif

Jika ada tampilan Face ID alternatif yang tidak ingin Anda simpan atau Anda merasa 
seseorang mungkin telah menambahkan tampilan alternatif di perangkat Anda tanpa izin, 
Anda dapat mengatur ulang Face ID, lalu mengaturnya lagi.

1.	 Buka Pengaturan  > Face ID & Kode Sandi, lalu ketuk Atur Ulang Face ID.

2.	 Lihat tugas di atas untuk mengatur Face ID lagi.

https://support.apple.com/guide/iphone/iph646624222
https://support.apple.com/guide/ipad/ipad058b4a31
https://support.apple.com/guide/ipad/ipad058b4a31
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 Menolak percobaan masuk yang tidak diketahui
Saat autentikasi dua faktor dinyalakan dan upaya masuk dilakukan di perangkat baru, Anda 
akan mendapat pemberitahuan di perangkat tepercaya lainnya. Pemberitahuan tersebut 
menyertakan peta yang menunjukkan lokasi perangkat baru. Pemberitahuan ini dapat 
muncul di iPhone, iPad, atau Mac mana pun yang tepercaya.

Lokasi upaya masuk merupakan perkiraan, berdasarkan alamat IP atau jaringan yang 
sedang digunakan perangkat, bukan lokasi persis perangkat.

  Jika Anda melihat pemberitahuan bahwa Akun Apple Anda digunakan untuk masuk ke 
perangkat baru yang tidak Anda kenali, pilih Jangan Izinkan untuk memblokir upaya masuk 
tersebut.

PENTING: Anda mungkin ingin mengambil tangkapan layar pemberitahuan sebelum 
menutupnya. Lihat “Merekam aktivitas mencurigakan” nanti di petunjuk ini.

Jika menurut Anda Akun Apple Anda diretas, lihat “Menjaga keamanan Akun Apple Anda” 
(nanti di petunjuk ini) dan hapus perangkat yang tidak diketahui.

 Perbarui perangkat lunak Apple Anda
Untuk mengamankan perangkat dan mengelola akses ke informasi pribadi, selalu pastikan 
Anda telah memiliki sistem operasi terbaru yang terinstal dengan pembaruan keamanan 
serta privasi terbaru. Setelah perangkat Anda diperbarui, Anda dapat mempelajari cara 
mengelola Akun Apple Anda. Semua perangkat Apple mendapat manfaat dari pembaruan 
perangkat lunak.

Memperbarui perangkat lunak sistem operasi Anda adalah salah satu hal terpenting yang 
dapat Anda lakukan untuk melindungi perangkat dan informasi Anda. Apple mempermudah 
pengunduhan dan penginstalan pembaruan ini.

Untuk melihat daftar pembaruan keamanan untuk perangkat Apple, lihat artikel Dukungan 
Apple “Pembaruan keamanan Apple” (https://support.apple.com/100100).

https://support.apple.com/ht207249
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  Memperbarui iPhone dan iPad secara otomatis

Jika Anda tidak menyalakan pembaruan otomatis saat pertama kali mengatur perangkat, 
Anda dapat melakukannya sekarang.

1.	 Buka Pengaturan  > Umum > Pembaruan Perangkat Lunak > Pembaruan Otomatis.

2.	 Menyalakan ketiga pilihan: Instal Pembaruan [iOS atau iPadOS] Secara Otomatis, 
Respons Keamanan & File Sistem, dan Unduh Pembaruan [iOS atau iPadOS] Secara 
Otomatis.

Saat pembaruan tersedia, perangkat mengunduh dan menginstal pembaruan pada malam 
hari saat dayanya diisi dan terhubung ke Wi-Fi. Anda akan diberi tahu sebelum pembaruan 
diinstal.

Untuk mematikan pembaruan otomatis, buka Pengaturan > Umum > Pembaruan Perangkat 
Lunak > Pembaruan Otomatis, lalu matikan Instal Pembaruan [iOS atau iPadOS] Secara 
Otomatis dan Respons Keamanan & File Sistem.

  Memperbarui iPhone atau iPad secara manual

Anda dapat memeriksa dan menginstal pembaruan perangkat lunak secara manual  
setiap saat.

•	 Buka Pengaturan  > Umum > Pembaruan Perangkat Lunak.

Layar menampilkan versi iOS yang diinstal saat ini dan memperingatkan Anda jika 
pembaruan tersedia.
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  Memperbarui iPhone atau iPad menggunakan komputer Anda

1.	 Pastikan Anda memiliki salah satu hal berikut:

•	 Mac dengan port USB dan OS X 10.9 atau lebih baru

•	 Perangkat Windows dengan port USB dan Windows 7 atau lebih baru

2.	 Lakukan salah satu hal berikut ini:

•	 Sambungkan perangkat Anda ke komputer Anda menggunakan Kabel Lightning ke 
USB yang disertakan. Jika komputer Anda memiliki port USB-C, gunakan Adaptor 
USB-C ke USB atau Kabel USB-C ke Lightning (masing-masing dijual terpisah).

•	 Jika perangkat Anda disertai dengan Kabel USB-C ke Lightning dan komputer Anda 
memiliki port USB, gunakan Kabel Lightning ke USB (dijual terpisah).

•	 Jika iPad Anda disertai dengan Kabel Pengisian Daya USB-C dan komputer Anda 
memiliki port USB, gunakan Adaptor USB-C ke USB dan kabel USB-A (semua dijual 
terpisah).

•	 Jika iPad Anda disertai dengan kabel pengisian daya Thunderbolt 4 / USB-4 dan 
komputer Anda memiliki port USB, gunakan Adaptor USB-C ke USB dan kabel 
USB-A (semua dijual terpisah). Anda dapat menggunakan kabel Thunderbolt atau 
USB dengan perangkat Thunderbolt seperti iPad Pro 12,9 inci (generasi ke-5) dan 
iPad Pro 11 inci (generasi ke-3).

3.	 Setelah Anda berhasil menyambungkan perangkat ke komputer Anda, lakukan salah  
satu hal berikut:

•	 Di bar samping Finder di Mac Anda: Pilih perangkat, lalu klik Umum di bagian atas 
jendela.

Untuk menggunakan Finder untuk memperbarui perangkat Anda ke iOS 15 atau 
iPadOS 15, Anda harus memiliki macOS 10.15 atau lebih baru. Dengan versi macOS 
yang lebih lama, gunakan iTunes untuk memperbarui perangkat Anda. Lihat 
“Memperbarui perangkat lunak di perangkat iOS di iTunes”  
(di https://support.apple.com/guide/itunes/itns3235/12.9/mac/10.14).

•	 Di app iTunes di perangkat Windows Anda: Klik tombol iPhone di dekat kiri atas 
jendela iTunes, lalu klik Ringkasan.

4.	 Klik Periksa Pembaruan.

5.	 Untuk menginstal pembaruan yang tersedia, klik Perbarui.

  Memperbarui Mac Anda secara otomatis

1.	 Pilih menu Apple  > Pengaturan Sistem, klik Umum  di bar samping, lalu klik 
Pembaruan Perangkat Lunak.

2.	 Untuk menginstal pembaruan macOS secara otomatis, pilih “Perbarui Mac saya secara 
otomatis”.

https://support.apple.com/guide/itunes/itns3235/12.9/mac/10.14
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3.	 Untuk mengatur pilihan pembaruan lanjutan, klik Lanjutan, lalu lakukan salah satu hal 
berikut:

•	 Agar Mac Anda memeriksa pembaruan secara otomatis: Pilih “Periksa pembaruan”.

•	 Agar Mac Anda mengunduh pembaruan tanpa bertanya: Pilih “Unduh pembaruan 
baru jika tersedia”.

•	 Agar Mac Anda menginstal pembaruan macOS secara otomatis: Pilih “Instal 
pembaruan macOS”.

•	 Agar Mac Anda menginstal pembaruan app dari App Store secara otomatis: Pilih 
“Instal pembaruan app dari App Store”.

•	 Agar Mac Anda menginstal file sistem dan pembaruan keamanan secara otomatis: 
Pilih “Instal Respons Keamanan dan file sistem”.

4.	 Klik OKE.

Untuk mendapatkan pembaruan terbaru secara otomatis, Anda dianjurkan untuk memilih 
“Periksa pembaruan”, “Unduh pembaruan baru saat tersedia”, dan “Instal file data sistem 
dan pembaruan keamanan”.

Catatan: MacBook, MacBook Pro, dan MacBook Air harus mencolokkan adaptor daya untuk 
mengunduh pembaruan secara otomatis.

  Memperbarui Mac Anda secara manual

Anda dapat secara manual memperbarui sistem operasi Mac Anda dan perangkat lunak 
yang telah Anda dapatkan dari App Store.

•	 Pilih menu Apple  > Pengaturan Sistem, klik Umum , lalu klik Pembaruan  
Perangkat Lunak.

•	 Untuk memperbarui perangkat lunak yang diunduh dari App Store, klik menu Apple. 
Jumlah pembaruan yang tersedia, jika ada, ditampilkan di samping App Store. Pilih 
App Store untuk melanjutkan di app App Store .
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﻿Meninjau dan menghapus profil konfigurasi
Profil konfigurasi perangkat, alat mobile device management (MDM), dan app khusus 
dapat digunakan oleh organisasi Anda (seperti sekolah dan bisnis) untuk mengelola atau 
mengawasi perangkat, dan alat ini dapat mengizinkan akses ke data atau informasi lokasi di 
perangkat.

Profil konfigurasi dapat mengelola berbagai pengaturan untuk akun pengguna, bersama 
dengan fungsionalitas perangkat lainnya. Profil konfigurasi dapat berfungsi di iPhone, iPad, 
Mac, Apple TV, dan Apple Watch.

Jika Anda melihat profil konfigurasi terinstal di perangkat Anda yang tidak seharusnya ada, 
Anda mungkin dapat menghapusnya, tergantung siapa yang menginstalnya. Jika dihapus, 
semua pengaturan, app, dan data terkait akan ikut dihapus dengan profil konfigurasi.

PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan dan privasi Anda.

  Meninjau profil konfigurasi

Penting: Jika perangkat Anda dimiliki oleh sekolah atau bisnis, periksa dengan 
administrator sistem Anda sebelum menghapus app atau profil apa pun.
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  Menghapus profil konfigurasi yang tidak diketahui dari iPhone atau iPad Anda

Saat Anda menghapus profil, semua pengaturan dan informasinya dihapus. Misalnya, jika 
profil memberikan izin untuk jaringan pribadi virtual (VPN) untuk memberikan akses ke 
jaringan sekolah, VPN tidak dapat lagi terhubung ke jaringan tersebut.

1.	 Buka Pengaturan  > Umum > Manajemen VPN & Perangkat.

Jika Anda tidak melihat profil apa pun, tidak ada profil manajemen perangkat yang 
terinstal di perangkat Anda.

2.	 Pilih profil, ketuk Hapus Profil, dan ikuti instruksi pada layar.

3.	 Mulai ulang perangkat Anda.

  Menghapus profil konfigurasi yang tidak diketahui dari Mac Anda

Saat Anda menghapus profil, semua pengaturan dan informasinya dihapus. Misalnya, jika 
profil mengatur akun email Anda, menghapus profil akan menghapus informasi akun email 
dari Mac Anda.

1.	 Lakukan salah satu hal berikut ini:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, klik Umum  di bar samping, lalu klik Manajemen Perangkat.

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi 
Sistem, lalu klik Profil .

Jika Anda tidak melihat panel preferensi Profil, tidak ada profil manajemen perangkat 
yang terinstal di perangkat Anda.

2.	 Pilih profil di daftar Profil, lalu klik .

3.	 Mulai ulang Mac Anda.
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 Mengelola Pencerminan iPhone di iPhone atau Mac Anda
Pencerminan iPhone memungkinkan akses dan kontrol iPhone langsung dari Mac, dan juga 
mengirimkan pemberitahuan iPhone langsung ke Mac.

Pencerminan iPhone hanya berfungsi saat iPhone Anda berada di sekitar dan terkunci. 
Setelah Anda mulai menggunakan iPhone secara langsung, Pencerminan iPhone otomatis 
berhenti.

Anda dapat mencabut akses ke Pencerminan iPhone dari perangkat mana pun, termasuk 
saat Anda mendapat pemberitahuan bahwa Pencerminan iPhone aktif. Mencabut akses 
akan mengatur ulang Pencerminan iPhone, jadi Anda perlu melalui proses pengaturan lagi 
jika ingin menggunakannya.

PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan Anda.

  Melihat dan mencabut akses ke Pencerminan iPhone saat Anda mendapat 
pemberitahuan

Jika Pencerminan iPhone aktif, atau baru saja aktif, Anda akan menerima pemberitahuan 
di iPhone Anda. Anda dapat mengetuk pemberitahuan untuk meninjau riwayat sesi dan 
mencabut akses ke Mac tertentu.

1.	 Di iPhone Anda, ketuk pemberitahuan.

Daftar komputer Mac yang diatur untuk Pencerminan iPhone akan muncul. Informasi 
mengenai sesi terkini, termasuk kapan sesi dimulai dan durasinya, juga terlihat.

2.	 Ketuk Edit di kanan atas, lalu pilih Mac yang ingin Anda hapus.

  Melihat dan mencabut akses ke Pencerminan iPhone di iPhone

 Kiat: Anda juga dapat menggunakan Pemeriksaan Keselamatan untuk melihat informasi 
dan menghapus komputer Mac. Lihat Pemeriksaan Keselamatan untuk iPhone dengan 
iOS 16 atau lebih baru.

1.	 Di iPhone Anda, buka Pengaturan  > Umum.

2.	 Ketuk AirPlay & Berkelanjutan, lalu ketuk Pencerminan iPhone.

Daftar komputer Mac yang diatur untuk Pencerminan iPhone akan muncul. Informasi 
mengenai sesi terkini, termasuk kapan sesi dimulai dan durasinya, juga terlihat.

3.	 Ketuk Edit di kanan atas, lalu pilih Mac yang akan dihapus.
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  Mencabut akses ke Pencerminan iPhone di Mac Anda

1.	 Di Mac Anda, buka app Pencerminan iPhone.

2.	 Pilih Pencerminan iPhone > Pengaturan dari bar menu di bagian atas layar Anda.

3.	 Pilih Cabut Akses ke [nama iPhone Anda].

  Memerlukan Touch ID atau kode sandi untuk Pencerminan iPhone

Pengaturan tertentu untuk Pencerminan iPhone memungkinkan perangkat Anda terhubung 
secara otomatis. Anda dapat memilih untuk memerlukan autentikasi sebagai gantinya, 
seperti Touch ID atau kode sandi perangkat Anda.

1.	 Di Mac Anda, buka app Pencerminan iPhone.

2.	 Pilih Pencerminan iPhone > Pengaturan dari bar menu di bagian atas layar Anda.

3.	 Pilih Selalu Tanya.

  Menghentikan app dari mengirimkan pemberitahuan

Saat Pencerminan iPhone aktif, pemberitahuan iPhone dikirim langsung ke Mac. Anda dapat 
mematikan pilihan ini untuk app tertentu.

1.	 Di iPhone Anda, buka Pengaturan  > Pemberitahuan.

2.	 Pilih app apa saja, lalu matikan Tampilkan di Mac.

 Memperkuat perangkat Anda dengan Mode Kuncitara
Mode Kuncitara adalah perlindungan opsional yang ekstrem untuk iPhone, iPad, dan Mac 
dengan iOS 16, iPadOS 16.1, macOS 13, atau lebih baru yang harus digunakan hanya jika 
Anda yakin bahwa Anda mungkin menjadi sasaran serangan siber yang sangat canggih, 
seperti oleh perusahaan swasta yang mengembangkan spyware sewaan yang  
disponsori negara.

Catatan: Kebanyakan orang tidak pernah menjadi sasaran jenis serangan ini.
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Saat perangkat dalam Mode Kuncitara, perangkat tidak berfungsi seperti biasanya. App, 
situs web, dan fitur sangat dibatasi untuk keamanan, dan beberapa pengalaman tidak 
tersedia. Mode Kuncitara mencakup perlindungan berikut:

•	 Pesan: Sebagian besar jenis lampiran pesan selain gambar diblokir. Beberapa fitur, 
seperti pratinjau tautan, dinonaktifkan.

•	 Penelusuran web: Teknologi web kompleks tertentu, seperti kompilasi JavaScript just-
in-time (JIT), dinonaktifkan kecuali pengguna mengecualikan situs tepercaya dari Mode 
Kuncitara.

•	 Layanan Apple: Undangan masuk dan permintaan layanan, termasuk panggilan 
FaceTime, diblokir jika pengguna belum pernah mengirim panggilan atau permintaan 
kepada pemanggil sebelumnya.

•	 Koneksi tertambat: Koneksi dengan komputer atau aksesori diblokir saat perangkat 
terkunci.

•	 Profil konfigurasi: Profil konfigurasi tidak dapat diinstal, dan perangkat tidak dapat 
mendaftar ke mobile device management (MDM) saat Mode Kuncitara diaktifkan. 
Namun, profil MDM apa pun yang diaktifkan sebelum Mode Kuncitara tetap ada di 
perangkat.

  Menyalakan atau mematikan Mode Kuncitara

Mode Kuncitara harus dinyalakan secara terpisah untuk iPhone, iPad, dan Mac. Saat 
Anda menyalakan Mode Kuncitara di iPhone, Mode Kuncitara otomatis dinyalakan untuk 
Apple Watch yang dipasangkan dengan watchOS 10 atau lebih baru. Anda tidak dapat 
menyalakan atau mematikan Mode Kuncitara secara langsung di Apple Watch.

•	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Privasi & Keamanan > Mode 
Kuncitara, ketuk Nyalakan Mode Kuncitara, ketuk Nyalakan & Mulai Ulang, lalu 
masukkan kode sandi perangkat Anda.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik Privasi & Keamanan   
di bar samping, lalu klik Mode Kuncitara. Klik Nyalakan, lalu masukkan kata sandi 
Anda jika diminta, lalu klik Nyalakan & Mulai Ulang.

 Mengontrol aksesori Rumah Anda dengan aman
Jika saat ini Anda adalah anggota Rumah, Anda dapat melihat dan mengontrol aksesori 
Rumah Anda dengan mudah dan aman menggunakan app Rumah di iPhone, iPad, atau Mac 
Anda, atau menggunakan HomePod.

Catatan: Aksesori Rumah dapat berupa produk Apple atau produk pihak ketiga. Untuk 
melihat daftar aksesori Rumah yang tersedia dan kompatibel dengan app Rumah serta 
perangkat Apple Anda, lihat “Aksesori Rumah” (https://www.apple.com/home-app/
accessories/).

  Berhenti berbagi rumah Anda dengan seseorang

1.	 Pilih app Rumah , lalu pilih Pengaturan Rumah. Jika Anda melihat beberapa rumah, 
pilih rumah yang ingin Anda tinggalkan, lalu pilih Pengaturan Rumah.

2.	 Di bawah Orang, pilih pengguna yang ingin Anda hapus dari rumah Anda, lalu pilih 
Hapus Orang.

https://www.apple.com/home-app/accessories/
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  Meninggalkan rumah tempat Anda diajak berbagi

Jika Anda meninggalkan rumah, Anda tidak dapat lagi melihat aksesori di rumah tersebut.

1.	 Di app Rumah , pilih ikon Rumah, lalu pilih Pengaturan Rumah. Jika Anda melihat 
beberapa rumah, pilih rumah yang ingin Anda tinggalkan, lalu pilih Pengaturan Rumah.

2.	 Gulir ke bawah, dan pilih Tinggalkan Rumah. Pilih Tinggalkan.

  Mengatur ulang rumah

Di iOS 16, iPadOS 16.1, dan macOS 13, atau lebih baru, saat Anda menghapus rumah 
dari app Rumah, semua perangkat HomeKit harus ditambahkan kembali ke rumah baru. 
Sebelum Anda menghapus rumah, pastikan Anda telah memperbarui perangkat lunak pada 
semua aksesori rumah ke versi terbarunya.

Jika Anda belum meningkatkan sistem operasi Anda, pastikan Anda menyelesaikan langkah 
4 di bawah ini.

1.	 Di app Rumah , pilih ikon Rumah, lalu pilih Pengaturan Rumah.

2.	 Di bagian bawah dialog, pilih Hapus Rumah, lalu pilih Hapus.

3.	 Tutup app Rumah.

4.	 Temukan semua aksesori rumah, lalu atur ulang masing-masing ke pengaturan 
pabriknya.

5.	 Buka app Rumah lagi dan buat rumah baru.

6.	 Tambahkan setiap aksesori ke rumah baru.
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 Kata sandi, kunci sandi, kode sandi

 Mengamankan kata sandi perangkat, app, dan situs  
web Anda
Di iPhone atau iPad Anda dengan iOS 17, iPadOS 17, atau lebih lama, Anda dapat mengelola 
kata sandi Anda di Pengaturan, Pencarian Spotlight, atau menggunakan Siri. Anda juga 
dapat menggunakan fitur Rekomendasi Keamanan Kata Sandi untuk mengidentifikasi kata 
sandi yang lemah atau rentan. Kata sandi tersimpan muncul dalam urutan abjad yang diatur 
oleh situs web atau platform tempat kata sandi tersebut disimpan.

Di iPhone atau iPad Anda dengan iOS 18, iPadOS 18, atau lebih baru, Anda dapat mengelola 
kata sandi Anda di app Kata Sandi, tempat Anda dapat menemukan semua kata sandi, kunci 
sandi, dan kode verifikasi di satu tempat. Anda dapat menggunakannya di semua perangkat 
saat Anda masuk ke iCloud dengan Akun Apple yang sama dan menyalakan Kata Sandi & 
Rantai Kunci di pengaturan iCloud. Dan jika Anda menggunakan Isi-Auto untuk masuk ke 
app dan situs web, kata sandi Anda secara otomatis muncul di Kata Sandi.

  Mengelola kata sandi dengan iOS 18, iPadOS 18, atau lebih baru

1.	 Buka app Kata Sandi  di iPhone Anda.

2.	 Ketuk Semua, lalu ketuk akun untuk kata sandi yang ingin Anda kelola.

3.	 Ketuk Edit.

4.	 Ubah atau hapus kata sandi, lalu ketuk untuk mengonfirmasi.
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  Mengelola kata sandi dengan iOS 17, iPadOS 17, atau lebih lama

Anda dapat mengelola kata sandi di Pengaturan, di Pencarian Spotlight, atau  
menggunakan Siri.

1.	 Buka Pengaturan  > Kata Sandi, lalu lakukan salah satu hal berikut:

•	 Untuk menambahkan kata sandi baru secara manual, ketuk Tambah di sudut  
kanan atas.

•	 Untuk mengedit atau menghapus kata sandi, ketuk Edit di sudut kanan atas, ketuk 
“Pilih kata sandi yang disimpan”, lalu ketuk Edit atau Hapus.

Penting: Setelah Anda menghapus kata sandi, Anda tidak dapat memulihkannya lagi.

2.	 Jika Anda menambahkan kata sandi baru, tes untuk memastikan Anda memasukkannya 
dengan benar.

  Menggunakan Rekomendasi Keamanan Kata Sandi dengan iOS 17, iPadOS 17, atau 
lebih lama

Jika Anda membuat dan menyimpan kata sandi Anda sendiri untuk situs web dan app, Anda 
dapat menggunakan fitur Rekomendasi Keamanan Kata Sandi untuk mengidentifikasi kata 
sandi yang lemah atau rentan (misalnya, jika mudah ditebak atau digunakan beberapa kali). 
Anda juga dapat menggunakan fitur ini untuk memantau kata sandi Anda dengan aman 
dan untuk memperingatkan Anda jika ada yang telah diretas melalui kebocoran data yang 
diketahui.

1.	 Buka Pengaturan  > Kata Sandi > Rekomendasi Keamanan.

2.	 Nyalakan Deteksi Kata Sandi yang Diretas untuk memungkinkan iPhone memantau kata 
sandi Anda dengan aman dan untuk memperingatkan Anda jika ada kata sandi yang 
muncul dalam kebocoran data yang diketahui.

3.	 Tinjau rekomendasi ini untuk kata sandi yang Anda buat:

•	 Kata sandi yang ditandai sebagai digunakan kembali telah digunakan di berbagai 
domain. Menggunakan kata sandi yang sama untuk lebih dari satu layanan dapat 
membuat akun rentan terhadap penyerang yang telah menemukan info  
pengesahan Anda.

•	 Kata sandi yang ditandai sebagai lemah mudah ditebak oleh penyerang.

•	 Kata sandi ditandai sebagai bocor jika fitur Pemantauan Kata Sandi telah 
mengidentifikasi kata sandi tersebut dalam kebocoran data yang diketahui.

4.	 Untuk memperbarui kata sandi yang digunakan kembali, lemah, atau bocor, ketuk item 
dan ikuti instruksi pada layar.



59Petunjuk Pengguna Keselamatan Pribadi

  Menghapus kode verifikasi sekali pakai secara otomatis

Di iOS 17, iPadOS 17, macOS 14, atau lebih baru, kode verifikasi sekali pakai diisikan secara 
otomatis, sehingga Anda tidak perlu meninggalkan app atau situs web tempat Anda sedang 
masuk. Anda dapat memilih untuk menghapus kode verifikasi secara otomatis setelah 
memasukkannya dengan Isi-Auto, atau menyimpannya.

•	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda dengan iOS 18 atau iPadOS 18, atau lebih baru: Buka 
Pengaturan  > Umum > Isi-Auto & Kata Sandi. Di bawah Kode Verifikasi, ketuk 
Hapus Setelah Penggunaan, lalu nyalakan.

•	 Di iPhone atau iPad Anda dengan iOS 17 atau iPadOS 17, atau lebih lama: Buka 
Pengaturan  > Kata Sandi, ketuk Pilihan Kata Sandi, lalu nyalakan Bersihkan  
Secara Otomatis.

•	 Di Mac Anda dengan macOS 15: Pilih menu Apple  > Pengaturan Sistem, klik  
Umum  di bar samping, lalu klik Isi-Auto & Kata Sandi. Di bawah Kode Verifikasi, 
nyalakan Hapus Setelah Penggunaan.

•	 Di Mac Anda dengan macOS 14 atau macOS 13: Pilih menu Apple  > Pengaturan 
Sistem, klik Kata Sandi  di bar samping, klik Pilihan Kata Sandi, lalu nyalakan 
Bersihkan Secara Otomatis.

 Mengatur kode sandi atau kata sandi perangkat yang unik
Untuk mencegah agar tidak ada yang menggunakan perangkat dan mengakses informasi 
Anda, atur kode sandi atau kata sandi unik yang hanya diketahui Anda. Jika Anda berbagi 
perangkat, atau jika orang lain mengetahui kode sandi atau kata sandi Anda, mereka akan 
dapat melihat dan membuat perubahan pada informasi di perangkat Anda dan Akun Apple 
terkait. Jika Anda merasa seseorang mengetahui kode sandi atau kata sandi perangkat 
Anda dan Anda ingin mengatur kata sandi yang hanya diketahui Anda, Anda dapat 
mengaturnya ulang di Pengaturan atau Preferensi Sistem, tergantung pada perangkatnya 
(lihat instruksi di bawah).
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  Mengatur kode sandi di iPhone atau iPad Anda

Untuk keamanan yang lebih baik, atur kode sandi yang harus dimasukkan untuk membuka 
iPhone atau iPad saat Anda menyalakan atau membangunkannya. Mengatur kode sandi juga 
menyalakan perlindungan data, yang mengenkripsi data iPhone atau iPad Anda sehingga 
hanya orang yang mengetahui kode sandi yang dapat mengaksesnya.

Catatan: Kode sandi perangkat Anda bukan merupakan kata sandi Akun Apple, yang 
menyediakan akses ke iTunes Store, App Store, Apple Books, iCloud, atau layanan Apple 
lainnya.

•	 Buka Pengaturan , lalu lakukan salah satu hal berikut:

•	 Di iPhone atau iPad dengan Face ID: Ketuk Face ID & Kode Sandi, lalu ketuk Nyalakan 
Kode Sandi atau Ubah Kode Sandi.

•	 Di iPhone atau iPad dengan tombol Utama: Ketuk Touch ID & Kode Sandi, lalu ketuk 
Nyalakan Kode Sandi atau Ubah Kode Sandi.

Untuk melihat pilihan untuk membuat kata sandi, ketuk Pilihan Kode Sandi. Kode sandi 
menggunakan enam digit secara default, tapi pilihan mencakup dari empat digit yang 
kurang aman hingga paling aman (alfanumerik).

  Mengubah kode sandi dan menonaktifkan kode sandi sebelumnya di iPhone  
atau iPad

Jika Anda khawatir seseorang memiliki akses ke kode sandi Anda dan Anda ingin 
mengamankan iPhone Anda, Anda dapat mengubah kode sandi untuk melindungi privasi 
dan menonaktifkan kode sandi sebelumnya. Untuk mengubah kode sandi Anda, ikuti 
langkah berikut.

1.	 Buka Pengaturan , lalu lakukan salah satu hal berikut:

•	 Di iPhone atau iPad dengan Face ID: Ketuk Face ID & Kode Sandi, lalu masukkan 
kode sandi Anda.

•	 Di iPhone atau iPad dengan tombol Utama: Ketuk Touch ID & Kode Sandi, lalu 
masukkan kode sandi Anda.

2.	 Ketuk Ubah Kode Sandi, masukkan kode sandi Anda saat ini.

3.	 Jika Anda menginginkan keamanan tambahan, ketuk Pilihan Kode Sandi untuk memilih 
format bagi kode sandi mendatang Anda.

Format yang tersedia meliputi kode numerik empat digit, kode numerik enam digit, kode 
alfanumerik khusus, atau kode numerik khusus.

4.	 Masukkan kode sandi baru Anda dua kali.

5.	 Ketuk Tinjau Akses (jika tersedia) untuk meninjau pengaturan yang dapat mengizinkan 
akses berkelanjutan ke data Anda bahkan setelah kode sandi diubah. Lihat Pemeriksaan 
Keselamatan untuk iPhone dengan iOS 16 atau lebih baru nanti di petunjuk ini.

PENTING: Setelah mengubah kode sandi Anda di iOS 17 atau iPadOS 17, Anda dapat 
menggunakan kode sandi lama Anda untuk mengatur ulang kode sandi Anda selama 
72 jam. Ini dimaksudkan untuk melindungi Anda jika Anda tidak sengaja melupakan 
kode sandi baru. Jika Anda ingin menonaktifkan sepenuhnya kode sandi lama setelah 
mengubahnya, buka Pengaturan > Face ID & Kode Sandi (atau Touch ID & Kode Sandi), 
lalu ketuk Akhiri Masa Berlaku Kode Sandi Sebelumnya.
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  Mengubah kata sandi masuk di Mac Anda

Jika Anda khawatir seseorang memiliki akses ke kata sandi Anda dan Anda ingin 
mengamankan Mac Anda, Anda dapat mengubah kata sandi pengguna untuk melindungi 
privasi.

Catatan: Kata sandi masuk Anda adalah kata sandi yang Anda masukkan untuk membuka 
Mac Anda saat Anda menyalakannya atau membangunkannya dari mode tidur. Karena 
Anda membuatnya, kata sandi ini mungkin sama dengan kata sandi Akun Apple Anda, yang 
menyediakan akses ke iTunes Store, App Store, Apple Books, iCloud, atau layanan Apple 
lainnya.

1.	 Lakukan salah satu hal berikut ini:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, klik Pengguna & Grup  di bar samping, lalu klik .

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi 
Sistem, lalu klik Pengguna & Grup  di bar samping.

2.	 Klik Ubah Kata Sandi.

3.	 Masukkan kata sandi Anda saat ini di bidang Kata Sandi Lama.

4.	 Masukkan kata sandi baru Anda di bidang Kata Sandi Baru, lalu masukkan lagi di bidang 
Verifikasi.

Untuk membantu memilih kata sandi yang aman, klik  di samping bidang Kata Sandi Baru.

5.	 Masukkan petunjuk untuk membantu Anda mengingat kata sandi.

Petunjuk muncul jika Anda salah memasukkan kata sandi tiga kali atau jika Anda 
mengeklik tanda tanya di bidang kata sandi di jendela masuk.

6.	 Klik Ubah Kata Sandi.

  Mengunci perangkat Anda secara otomatis

Untuk meningkatkan privasi pribadi lebih jauh, Anda dapat mengatur perangkat Anda agar 
terkunci secara otomatis dalam kondisi tertentu.

•	 iPhone, iPad: Buka Pengaturan > Tampilan & Kecerahan > Kunci-Otomatis, lalu atur 
durasi waktu.

•	 Mac: Pilih menu Apple  > Pengaturan Sistem, klik Layar Terkunci  di bar samping, 
lalu atur durasinya.

Untuk informasi lebih lanjut, lihat “Mengubah pengaturan Layar Terkunci di Mac” di 
Petunjuk Pengguna Mac. (https://support.apple.com/guide/mac-help/mh11784)

•	 Apple Watch: Buka app Pengaturan, ketuk Kode Sandi, lalu nyalakan atau matikan 
Deteksi Pergelangan Tangan.

Untuk informasi lebih lanjut, lihat “Mengunci secara otomatis” di Petunjuk Pengguna 
Apple Watch. https://support.apple.com/guide/watch/apd0e1e73b6f#apd6771615db)

https://support.apple.com/guide/mac-help/mh11784
https://support.apple.com/guide/watch/apd0e1e73b6f#apd6771615db
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 Mengelola kata sandi dan kunci sandi bersama
Di iOS 17, iPadOS 17, macOS 14, atau lebih baru, Anda dapat membuat atau bergabung 
dengan grup kontak tepercaya yang berbagi kata sandi dan kunci sandi di semua 
perangkat. Ada dua peran pengguna yang berbeda di grup Kata Sandi Bersama: Pemilik 
Grup dan Anggota Grup. Setiap peran pengguna menentukan jenis tugas yang dapat Anda 
jalankan.

•	 Pemilik Grup: Pemilik Grup adalah anggota grup yang membuat grup. Pemilik adalah 
satu-satunya orang yang dapat menambah atau menghapus anggota lainnya.

•	 Anggota Grup: Setiap orang yang telah mendapatkan dan menerima undangan dari 
pemilik adalah anggota grup. Semua anggota grup dapat menambahkan, melihat, 
mengedit, atau menghapus kata sandi kapan pun. Anggota grup dapat meninggalkan 
grup kapan pun mereka ingin.

Catatan: Jika Anda menghapus kata sandi atau kunci sandi yang Anda bagikan dengan 
suatu grup, Anda punya waktu 30 hari untuk memulihkannya. Jika Anda menghapus kata 
sandi atau kunci sandi yang dibagikan orang lain dengan grup tersebut, ia akan menerima 
pemberitahuan untuk memulihkannya dalam waktu 30 hari. Lihat “Memulihkan kata 
sandi atau kunci sandi yang baru saja dihapus di Mac” (https://support.apple.com/guide/
passwords/mchlee73013a/mac) di Petunjuk Pengguna Kata Sandi untuk Mac.

  Menentukan peran Anda di grup kata sandi bersama

•	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda dengan iOS 18, iPadOS 18, atau lebih baru: Buka app Kata 
Sandi, ketuk nama grup, lalu lihat apakah Anda pemilik atau anggota grup

•	 Di iPhone atau iPad Anda dengan iOS 17, iPadOS 17, atau lebih lama: Buka 
Pengaturan  > Kata Sandi, cari grup kata sandi bersama , pilih grup, lalu lihat 
apakah Anda pemilik atau anggota grup.

•	 Di Mac Anda dengan macOS 15 atau lebih baru: Buka app Kata Sandi, klik grup 
bersama di bar samping, klik Kelola, lalu lihat apakah Anda adalah pemilik grup atau 
anggota.

•	 Di Mac Anda dengan macOS 14 atau lebih lama: Pilih menu Apple  > Pengaturan 
Sistem, lalu klik Kata Sandi  di bar samping. Cari grup kata sandi bersama , pilih 
grup, klik Kelola, lalu lihat apakah Anda adalah pemilik grup atau anggota.

https://support.apple.com/guide/mac-help/mchlee73013a
https://support.apple.com/guide/mac-help/mchlee73013a
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  Menghapus seseorang dari grup kata sandi bersama yang Anda miliki

Jika Anda menghapus orang lain dari grup kata sandi bersama, orang tersebut mungkin 
masih memiliki akses ke akun dan kata sandi yang Anda bagikan saat mereka berada dalam 
grup. Setelah menghapus seseorang, Anda juga harus mengubah kata sandi untuk akun 
yang Anda miliki agar ia tidak dapat mengaksesnya.

•	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda dengan iOS 18, iPadOS 18, atau lebih baru: Buka app Kata 
Sandi, ketuk nama grup, lalu hapus anggota

•	 Di iPhone atau iPad Anda dengan iOS 17, iPadOS 17, atau lebih lama: Buka 
Pengaturan  > Kata Sandi, cari grup kata sandi bersama , pilih grup, lalu hapus 
anggota.

•	 Di Mac Anda dengan macOS 15 atau lebih baru: Buka app Kata Sandi, klik grup 
bersama di bar samping, klik Kelola, lalu hapus anggota.

•	 Di Mac Anda dengan macOS 14 atau lebih lama: Pilih menu Apple  > Pengaturan 
Sistem, lalu klik Kata Sandi  di bar samping. Cari grup kata sandi bersama , pilih 
grup, klik Kelola, lalu hapus anggota.

  Meninggalkan grup kata sandi bersama tempat Anda menjadi anggota

Jika Anda menghapus diri sendiri dari grup kata sandi bersama, anggota grup sebelumnya 
mungkin masih memiliki akses ke akun dan kata sandi atau kunci sandi yang Anda bagikan 
saat Anda berada dalam grup. Setelah meninggalkan grup, Anda juga harus mengubah 
kata sandi atau kunci sandi untuk akun yang Anda miliki agar anggota grup tidak dapat 
mengaksesnya.

•	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda dengan iOS 18, iPadOS 18, atau lebih baru: Buka app Kata 
Sandi, ketuk nama grup, lalu hapus diri Anda.

•	 Di iPhone atau iPad Anda dengan iOS 17, iPadOS 17, atau lebih lama: Buka 
Pengaturan  > Kata Sandi, cari grup kata sandi bersama , pilih grup, lalu hapus 
diri Anda dari grup tersebut.

•	 Di Mac Anda dengan macOS 15 atau lebih baru: Buka app Kata Sandi, klik grup 
bersama di bar samping, klik Kelola, lalu hapus diri Anda dari grup tersebut.

•	 Di Mac Anda dengan macOS 14 atau lebih lama: Pilih menu Apple  > Pengaturan 
Sistem, lalu klik Kata Sandi  di bar samping. Cari grup kata sandi bersama , pilih 
grup, klik Kelola, lalu hapus diri Anda dari grup tersebut.
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  Menghapus kata sandi atau kunci sandi dari grup kata sandi bersama

Jika Anda memutuskan untuk menghapus kata sandi atau kunci sandi dari grup kata 
sandi bersama, anggota grup mungkin masih memiliki akses ke akun dan kata sandi atau 
kunci sandi yang Anda bagikan. Setelah menghapusnya, Anda juga harus mengubah 
kata sandi atau kunci sandi untuk akun yang Anda miliki agar anggota grup tidak dapat 
mengaksesnya.

Catatan: Jika Anda menghapus kata sandi atau kunci sandi yang Anda bagikan dengan 
suatu grup, Anda punya waktu 30 hari untuk memulihkannya. Jika Anda menghapus kata 
sandi atau kunci sandi yang dibagikan orang lain dengan grup tersebut, ia akan menerima 
pemberitahuan untuk memulihkannya dalam waktu 30 hari. Lihat “Memulihkan kata sandi 
atau kunci sandi yang baru saja dihapus di Mac” di Petunjuk Pengguna Kata Sandi untuk 
Mac (https://support.apple.com/guide/passwords/mchlee73013a/mac).

•	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda dengan iOS 18, iPadOS 18, atau lebih baru: Buka app Kata 
Sandi, ketuk nama grup, lalu ketuk akun dengan kata sandi atau kunci sandi yang 
ingin Anda hapus. Ketuk Edit, ketuk Hapus, lalu ketuk Hapus Kata Sandi atau Hapus 
Kunci Sandi lagi untuk mengonfirmasi.

•	 Di iPhone atau iPad Anda dengan iOS 17, iPadOS 17, atau lebih lama: Buka 
Pengaturan  > Kata Sandi, cari grup kata sandi bersama , pilih grup, lalu ketuk 
Hapus Kata Sandi atau Hapus Kunci Sandi.

•	 Di Mac Anda dengan macOS 15 atau lebih baru: Buka app Kata Sandi, klik grup 
bersama di bar samping, lalu klik akun dengan kata sandi atau kunci sandi yang ingin 
Anda hapus. Klik Edit, klik Hapus Kata Sandi atau Hapus Kunci Sandi, lalu klik Hapus 
Kata Sandi atau Hapus Kunci Sandi (lagi).

•	 Di Mac Anda dengan macOS 14 atau lebih lama: Pilih menu Apple  > Pengaturan 
Sistem, klik Kata Sandi  di bar samping, lalu klik  di samping akun dengan kata 
sandi atau kunci sandi yang ingin Anda hapus. Klik Hapus Kata Sandi atau Hapus 
Kunci Sandi, lalu klik Hapus Kata Sandi atau Hapus Kunci Sandi (lagi).

https://support.apple.com/guide/passwords/mchlee73013a/mac
https://support.apple.com/guide/passwords/mchlee73013a/mac
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 Mengelola informasi lokasi

 Menggunakan Periksa untuk Pesan
Anda dapat menggunakan Periksa di iPhone untuk secara otomatis memberi tahu teman 
bahwa iPhone Anda telah tiba, dan memilih detail yang dapat mereka lihat jika Anda tidak 
berhasil menyelesaikan Periksa.

Demikian pula, jika seorang teman mengirimi Anda Periksa, tapi iPhone mereka belum tiba 
seperti yang diharapkan, Anda dapat melihat lokasinya, persentase baterai, sinyal seluler, 
dan banyak lagi.

Catatan: Periksa memerlukan iOS 17 atau lebih baru untuk pengirim dan penerima. Berbagi 
lokasi tidak didukung di Korea Selatan dan mungkin tidak tersedia di wilayah lain karena 
hukum setempat.

Saat Anda memulai Periksa berbasis perjalanan, kontak Anda diberi tahu mengenai:

•	 Tujuan Anda dan perkiraan waktu kedatangan

•	 Hal yang dapat mereka harapkan jika Anda tidak merespons perintah, jika Anda 
melakukan panggilan Darurat SOS saat Periksa, atau jika telepon Anda tidak sampai di 
tujuan seperti yang diharapkan

Saat Anda memulai Periksa berbasis timer, kontak Anda diberi tahu mengenai:

•	 Jam berapa Anda memulai timer

•	 Jam berapa timer berakhir

•	 Hal yang dapat mereka harapkan jika Anda tidak merespons perintah terkait timer atau 
jika Anda melakukan panggilan Darurat SOS saat Periksa
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 Informasi apa yang dibagikan, dan kapan?
Saat mengatur Periksa, Anda dapat memilih jumlah informasi yang ingin Anda bagikan 
dengan kontak Anda ketika Periksa tidak berakhir seperti yang diharapkan. Setelah 
mengatur Periksa, Anda dapat mengubah jenis data yang Anda kirim di Pengaturan >  
Pesan > Periksa > Data.

Pilihan level informasi Anda adalah:

•	 Data terbatas: Termasuk lokasi Anda saat ini dan detail mengenai baterai dan sinyal 
jaringan Anda untuk iPhone dan Apple Watch.

•	 Data penuh: Termasuk semua data dari Terbatas ditambah rute perjalanan Anda dan 
lokasi membuka iPhone terakhir Anda dan penghapusan Apple Watch.

Kontak Anda secara otomatis dikirimi tautan untuk melihat informasi yang Anda pilih untuk 
dibagikan kepada mereka dalam keadaan berikut:

•	 Telepon Anda tidak sampai di tujuan.

•	 Anda sangat tertunda selama perjalanan dan tidak merespons permintaan untuk 
menambahkan waktu.

•	 Anda melakukan panggilan Darurat SOS dan tidak merespons perintah Periksa lanjutan.

•	 Anda tidak merespons perintah di akhir Periksa berbasis timer.

Penting: Jika telepon Anda hilang saat Periksa sedang berjalan, kontak Anda akan 
menerima pemberitahuan seolah-olah Anda tidak merespons.

 Saat Periksa sedang berjalan
Saat Periksa berbasis perjalanan sedang berjalan, pesan berikut muncul di Layar Terkunci 
Anda: “Periksa Buka untuk melihat detailnya.” Jika Anda mengetuk pesan ini dan membuka 
perangkat, Anda akan melihat tujuan yang Anda tetapkan, ETA Anda saat ini yang 
diperbarui secara otomatis berdasarkan kondisi lalu lintas dan berkendara, serta jenis data 
yang dibagikan dengan kontak Anda jika Periksa tidak berhasil diselesaikan (Terbatas atau 
Penuh). Anda juga memiliki kemampuan untuk membatalkan Periksa.

  Memulai Periksa berbasis timer

Jika Anda merasa tidak aman di lokasi Anda saat ini dan ingin kontak tepercaya mendukung 
Anda menggunakan Periksa, Anda dapat memulai Periksa berbasis timer. Periksa berbasis 
timer memberi tahu kontak tepercaya Anda jika Anda tidak merespons perintah di akhir timer.

Saat Periksa berbasis timer sedang berjalan, pesan berikut muncul di Layar Terkunci Anda: 
“Periksa: Buka untuk melihat detailnya.” Jika Anda mengetuk pesan ini dan membuka 
perangkat, Anda dapat melihat hal berikut:

•	 Waktu yang tersisa di Periksa Anda

•	 Kontak yang Anda pilih untuk menerima Periksa Anda

•	 Jenis data yang dibagikan dengan kontak Anda:

•	 Terbatas atau Penuh
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Untuk memulai Periksa berbasis timer:

1.	 Buka Pesan , lalu pilih orang yang ingin Anda beri tahu.

2.	 Ketuk Pesan Baru di bagian atas layar dan tambahkan penerima, atau pilih percakapan 
yang ada.

3.	 Ketuk , ketuk Periksa, lalu ketuk Edit.

Anda mungkin perlu mengetuk Lainnya untuk menemukan Periksa.

4.	 Pilih “Setelah timer.”

5.	 Pilih jumlah waktu yang ingin Anda masukkan ke timer.

Saat Periksa berbasis timer berakhir, Anda menerima perintah untuk mengetuk Akhiri 
Periksa atau Tambahkan Waktu Lagi. Saat mengakhiri Periksa, kontak Anda diberi tahu 
bahwa Periksa telah berhasil diakhiri. Anda juga dapat memilih Tambahkan Waktu, yang 
memungkinkan Anda menambahkan 15, 30, atau 60 menit lagi ke Periksa Anda. Kontak 
Anda menerima waktu berakhir yang diperbarui.

  Memulai Periksa berbasis perjalanan

Jika Anda bepergian dengan mobil, transit, atau berjalan kaki, Anda dapat memulai Periksa 
untuk memberi tahu teman secara otomatis setelah Anda tiba di tujuan Anda.

Saat Periksa berbasis perjalanan sedang berjalan, pesan berikut muncul di Layar Terkunci 
Anda: “Periksa Buka untuk melihat detailnya.” Jika Anda mengetuk pesan ini dan membuka 
perangkat, Anda akan melihat tujuan yang Anda tetapkan, ETA Anda saat ini (yang 
diperbarui secara otomatis berdasarkan kondisi lalu lintas dan berkendara), serta jenis 
data yang dibagikan dengan kontak Anda jika Periksa tidak berhasil diselesaikan. Anda juga 
memiliki kemampuan untuk membatalkan Periksa.

1.	 Buka Pesan , lalu pilih orang yang ingin Anda beri tahu.

2.	 Ketuk Pesan Baru di bagian atas layar dan tambahkan penerima, atau pilih percakapan 
yang ada.

3.	 Ketuk , ketuk Periksa, lalu ketuk Edit.

Anda mungkin perlu mengetuk Lainnya untuk menemukan Periksa.

4.	 Pilih “Saat saya tiba.”

5.	 Ketuk Ubah, lalu masukkan lokasi yang Anda inginkan di bidang pencarian.

6.	 Untuk mengatur radius kedatangan lokasi Anda, ketuk Kecil, Sedang, atau Besar di 
bagian bawah layar. Teman Anda menerima pemberitahuan Kedatangan setelah Anda 
memasuki radius tersebut.

7.	 Ketuk Selesai.

8.	 Ketuk Berkendara, Transit, atau Berjalan Kaki, lalu ketuk Tambahkan Waktu jika 
diperlukan.

Jika perangkat Anda tidak bergerak menuju tujuan Anda, Anda akan menerima perintah 
dan memiliki waktu 15 menit untuk merespons. Jika tidak ada respons, orang yang Anda 
sayangi akan diberi tahu secara otomatis.

Saat iPhone Anda tiba di tujuan yang ditetapkan untuk Periksa berbasis perjalanan, Periksa 
berakhir dan kontak Anda menerima peringatan yang menunjukkan bahwa Anda telah tiba.



68Petunjuk Pengguna Keselamatan Pribadi

 Mengelola AirTag dan item lainnya

 Mendeteksi pelacak yang tidak diinginkan
Apple merancang AirTag dan jaringan Lacak untuk membantu pengguna terus melacak 
barang dan—di saat yang sama—mencegah pelacakan yang tidak diinginkan. Untuk lebih 
membantu mengamankan agar tidak ada perangkat yang melacak pengguna tanpa disadari, 
Apple dan Google menciptakan standar industri. Dengan standar tersebut, pengguna 
(iPhone, iPad, dan Android) dapat diberi tahu jika mereka sedang dilacak.

Jika Anda merasa keselamatan Anda terancam, hubungi pihak berwajib. Jika barang 
merupakan produk Apple, pihak berwajib dapat bekerja dengan Apple untuk meminta 
informasi terkait barang tersebut. Lihat Panduan Proses Hukum untuk di dalam Amerika 
Serikat (https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf) dan  
di luar Amerika Serikat (https://www.apple.com/legal/privacy/ 
law-enforcement-guidelines-outside-us.pdf). Anda mungkin perlu menyediakan  
AirTag, AirPods, aksesori jaringan Lacak, dan nomor seri perangkat.

  Pemberitahuan pelacakan yang tidak diinginkan

Ketersediaan perangkat lunak pemberitahuan pelacakan yang tidak diinginkan:

•	 Pemberitahuan pelacakan yang tidak diinginkan untuk AirTag dan aksesori Lacak lainnya 
tersedia di iPhone atau iPad dengan iOS 14.5, iPadOS 14.5, atau lebih baru.

•	 Pemberitahuan pelacakan yang tidak diinginkan untuk perangkat pelacakan Bluetooth 
yang tidak diketahui yang kompatibel dengan spesifikasi industri Mendeteksi Pelacakan 
Lokasi yang Tidak Diinginkan tersedia di iPhone dengan iOS 17.5 atau lebih baru.

•	 Google menyediakan deteksi pelacakan yang tidak diinginkan di perangkat dengan 
Android 6.0 atau lebih baru. Mereka yang menggunakan sistem operasi yang lebih lama 
dapat memperbarui atau menggunakan app Deteksi Pelacak.

https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
https://www.apple.com/legal/privacy/law-enforcement-guidelines-outside-us.pdf
https://datatracker.ietf.org/doc/draft-detecting-unwanted-location-trackers/01/
https://datatracker.ietf.org/doc/draft-detecting-unwanted-location-trackers/01/
https://support.google.com/android/answer/13658562?visit_id=638525910154486952-839086324&
https://play.google.com/store/apps/details?id=com.apple.trackerdetect&pli=1
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  Menyalakan pemberitahuan pelacakan yang tidak diinginkan

Untuk menerima pemberitahuan pelacakan yang tidak diinginkan pada iPhone atau iPad 
dengan iOS 14.5, iPadOS 14.5, atau lebih baru, pastikan Anda:

•	 Buka Pengaturan > Privasi & Keamanan > Layanan Lokasi, lalu nyalakan Layanan Lokasi.

•	 Buka Pengaturan > Privasi & Keamanan > Layanan Lokasi > Layanan Sistem, lalu 
nyalakan Lacak iPhone.

•	 Buka Pengaturan > Bluetooth, lalu nyalakan Bluetooth.

•	 Buka Pengaturan > Pemberitahuan > gulir ke bawah ke Pemberitahuan Pelacakan, lalu 
nyalakan Izinkan Pemberitahuan.

•	 Matikan mode pesawat. Jika perangkat Anda dalam mode pesawat, Anda tidak akan 
menerima pemberitahuan pelacakan.

  Jika Anda mendapatkan pemberitahuan pelacakan yang tidak diinginkan

Ikuti langkah-langkah ini untuk menemukan barang:

1.	 Ketuk pemberitahuan.

2.	 Ketuk lanjutkan, lalu ketuk Putar Bunyi, atau, jika bisa, ketuk Temukan Di Sekitar untuk 
menggunakan Pencarian Presisi untuk membantu Anda menemukan barang yang tidak 
diketahui.

Jika pilihan untuk memutar bunyi tidak tersedia atau jika Anda tidak dapat menemukan 
barang dengan Pencarian Presisi, barang mungkin tidak berada di sekitar Anda lagi. 
Jika Anda yakin bahwa barang masih berada di sekitar Anda, periksa barang Anda untuk 
mencoba menemukannya. Periksa barang pribadi Anda, atau barang apa pun yang Anda 
miliki yang mungkin berisi perangkat tersebut. Mungkin ada di barang yang jarang Anda 
periksa, seperti saku jaket, bagian luar tas, atau kendaraan Anda. Jika Anda tidak dapat 
menemukan perangkat dan jika Anda merasa keselamatan Anda terancam, pergi ke lokasi 
publik yang aman dan hubungi pihak berwajib.
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 Jika sebelumnya Anda menerima pemberitahuan pelacakan yang tidak diinginkan 
dan ingin meninjau informasi tersebut lagi, lakukan salah satu hal berikut:

•	 Di iPhone atau iPad Anda: Buka app Lacak  , lalu ketuk Barang, lalu ketuk Barang  
yang Terdeteksi Dengan Anda.

•	 Di Mac Anda: Buka app Lacak  , klik Barang, lalu klik Barang yang Terdeteksi  
Dengan Anda.

  Jika Anda menemukan AirTag, aksesori Lacak, atau perangkat pelacakan 
Bluetooth yang kompatibel

Ikuti langkah-langkah ini untuk mendapatkan informasinya:

1.	 Tahan bagian atas iPhone Anda di dekat barang hingga pemberitahuan muncul.

2.	 Ketuk pemberitahuan. Tindakan ini membuka situs web yang menyediakan informasi 
mengenai barang, termasuk:

•	 Nomor seri atau ID perangkat

•	 Empat digit terakhir nomor telepon atau alamat email yang disamarkan dari orang 
yang mendaftarkannya. Hal ini dapat membantu Anda mengidentifikasi pemilik, jika 
Anda mengenalnya.

3.	 Jika pemilik menandai barang sebagai hilang, Anda dapat melihat pesan dengan 
informasi mengenai cara menghubungi pemilik.
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  Jika Anda khawatir bahwa barang mungkin digunakan untuk melacak Anda

PENTING: Sebelum melakukan perubahan, pertimbangkan potensi dampak keselamatan 
dan privasi Anda. Jika Anda merasa keselamatan Anda terancam, hubungi pihak berwajib. 
Jika barang merupakan produk Apple, pihak berwajib dapat bekerja dengan Apple untuk 
meminta informasi terkait barang tersebut (https://www.apple.com/legal/privacy/ 
law-enforcement-guidelines-us.pdf). Anda mungkin perlu menyediakan AirTag, AirPods, 
aksesori jaringan Lacak, dan nomor seri perangkat.

1.	 Ambil tangkapan layar dari barang dan informasi pemilik untuk catatan Anda.

2.	 Nonaktifkan perangkat dan berhenti membagikan lokasinya dengan mengetuk Instruksi 
untuk Menonaktifkan dan ikuti langkah-langkah di layar.

3.	 Jika Anda merasa keselamatan Anda terancam, hubungi pihak berwajib. Jika barang 
merupakan produk Apple, pihak berwajib dapat bekerja dengan Apple untuk meminta 
informasi terkait barang tersebut. Anda mungkin perlu menyediakan AirTag, AirPods, 
aksesori jaringan Lacak, dan nomor seri perangkat.

Lihat Panduan Proses Hukum untuk di dalam Amerika Serikat (https://www.apple.com/
legal/privacy/law-enforcement-guidelines-us.pdf) dan di luar Amerika Serikat (https://
www.apple.com/legal/privacy/law-enforcement-guidelines-outside-us.pdf).

Setelah barang dinonaktifkan, pemilik tidak bisa lagi mendapatkan pembaruan tentang 
lokasinya saat ini. Anda juga tidak akan lagi menerima pemberitahuan pelacakan yang tidak 
diinginkan untuk barang ini.

  Memeriksa AirTag atau aksesori Lacak menggunakan perangkat Android

Lihat “halaman dukungan Mencari Pelacak yang Tidak Diketahui” untuk informasi lebih 
lanjut mengenai cara memeriksa pelacakan yang tidak diinginkan di perangkat Android. 
(https://support.google.com/android/answer/ 
13658562?visit_id=638525910154486952-839086324&)

https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
https://support.apple.com/102616
https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
https://www.apple.com/legal/privacy/law-enforcement-guidelines-outside-us.pdf
https://support.google.com/android/answer/13658562?visit_id=638525910154486952-839086324&
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  Jika Anda mendengar AirTag mengeluarkan bunyi

Saat dipindahkan, AirTag yang terpisah untuk beberapa waktu dari pemiliknya akan 
mengeluarkan bunyi untuk memberi tahu orang di sekitar. Jika Anda menemukan AirTag 
setelah mendengar bunyinya, Anda dapat menggunakan perangkat apa pun yang memiliki 
teknologi Komunikasi Medan Dekat (NFC), seperti iPhone atau ponsel Android, untuk 
melihat apakah pemiliknya menandainya sebagai hilang dan membantu menemukannya.

PENTING: Jika Anda merasa terancam, Anda dapat menghubungi pihak berwajib,  
yang dapat bekerja sama dengan Apple (https://www.apple.com/legal/transparency/ 
government-information.html). Anda mungkin harus menyediakan AirTag atau nomor 
serinya.

  Perangkat yang terhubung ke Akun Apple lain

Jika Anda mencoba mengatur AirPods, AirTag, atau aksesori jaringan Lacak lainnya dan 
melihat pesan yang menyatakan bahwa aksesori tersebut telah dipasangkan dengan 
Akun Apple lain, perangkat atau barang tersebut harus dihapus dari Akun Apple terlebih 
dulu. Untuk mempelajari lebih lanjut mengenai cara menghapus atau melepaskan barang 
atau perangkat Anda, atau untuk mengaturnya dengan Akun Apple lain, lihat artikel 
Dukungan Apple “Jika suatu item atau perangkat terhubung ke Akun Apple”  
(https://support.apple.com/102620).

 Berhenti berbagi AirTag
Pemilik AirTag—atau item pihak ketiga yang kompatibel dengan Lacak—dapat 
membagikannya dengan hingga lima orang lain sekaligus. Saat pemilik membagikan AirTag, 
mereka membuat grup yang dikenal sebagai grup berbagi. Anggota grup berbagi dapat:

•	 Melihat lokasi AirTag di app Lacak di perangkat mereka

•	 Menggunakan Pencarian Presisi untuk menemukan AirTag

•	 Memutar bunyi untuk menemukan AirTag yang hilang

•	 Diberi peringatan saat orang baru bergabung dengan grup berbagi

•	 Melihat Akun Apple setiap anggota grup berbagi (atau informasi kontak jika anggota lain 
disimpan ke kontak mereka)

Catatan: Hanya pemilik yang dapat melihat anggota grup berbagi mana yang memiliki AirTag.

Karena setiap orang di grup berbagi dapat melihat lokasi AirTag, pemberitahuan pelacakan 
yang tidak diinginkan untuk AirTag tersebut disembunyikan untuk semua anggota grup 
berbagi. Saat seseorang keluar dari grup berbagi atau saat pemilik menghapusnya dari 
grup, mereka tidak dapat melihat lokasi AirTag, pemberitahuan pelacakan yang tidak 
diinginkan dilanjutkan.

https://www.apple.com/legal/transparency/government-information.html
https://support.apple.com/102620
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Untuk mempelajari lebih lanjut, lihat Membagikan AirTag atau barang lain di Lacak di 
Petunjuk Pengguna iPhone. (https://support.apple.com/guide/iphone/iph419cc5f28/ios)

  Berhenti berbagi AirTag menggunakan Lacak di iPhone atau iPad

1.	 Buka app Lacak  di iPhone atau iPad Anda.

2.	 Ketuk Barang, lalu ketuk nama barang.

3.	 Lakukan salah satu hal berikut ini:

•	 Menghapus diri Anda sendiri: Ketuk Hapus, lalu ketuk Hapus lagi untuk 
mengonfirmasi.

Setelah Anda menghapus diri Anda, Anda tidak dapat melihat lokasi AirTag dan 
pemberitahuan pelacakan yang tidak diinginkan dilanjutkan. Anda mungkin ingin 
melihat apakah AirTag berada di dekat Anda sebelum menghapus diri Anda dari  
grup berbagi.

•	 Menghapus orang lain (jika Anda adalah pemilik): Ketuk nama orang, ketuk Hapus, 
lalu ketuk Berhenti Berbagi.

  Berhenti berbagi AirTag menggunakan Lacak di Mac

1.	 Buka app Lacak  di Mac Anda.

2.	 Klik Barang, pilih barang yang ingin Anda hentikan berbaginya, lalu klik  di peta.

3.	 Lakukan salah satu hal berikut ini:

•	 Menghapus diri Anda sendiri: Klik Hapus, lalu klik Hapus lagi untuk mengonfirmasi.

Setelah Anda menghapus diri Anda, Anda tidak dapat melihat lokasi AirTag dan 
pemberitahuan pelacakan yang tidak diinginkan dilanjutkan. Anda mungkin ingin 
melihat apakah AirTag berada di dekat Anda sebelum menghapus diri Anda dari  
grup berbagi

•	 Menghapus orang lain (jika Anda adalah pemilik): Klik nama orang, klik Hapus, lalu 
klik Berhenti Berbagi.

https://support.apple.com/guide/iphone/iph419cc5f28/ios
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  Berhenti berbagi AirTag menggunakan Pemeriksaan Keselamatan di iPhone

Anda dapat menghapus diri Anda sendiri dari grup berbagi menggunakan Pemeriksaan 
Keselamatan. Sebagai pemilik, Anda juga dapat menghapus orang lain.

1.	 Buka Pengaturan  > Privasi & Keamanan > Pemeriksaan Keselamatan.

2.	 Ketuk Kelola Berbagi & Akses, lalu ketuk Lanjutkan.

3.	 Ketuk Informasi, ketuk Barang, lalu ketuk Berhenti Berbagi.

Catatan: Menemukan barang dan membagikan lokasi barang tidak tersedia di semua negara 
atau wilayah.

 Berhenti membagikan lokasi AirTag yang hilang
Di Lacak, pemilik AirTag yang hilang—atau item pihak ketiga yang kompatibel dengan 
Lacak—dapat membagikan lokasinya melalui halaman web sementara. Misalnya, mereka 
dapat berbagi halaman web dengan maskapai penerbangan untuk membantu mereka 
melacak kesalahan penanganan barang bawaan mereka.

Saat seseorang membuka tautan tersebut, mereka diharuskan melakukan pengesahan 
melalui Akun Apple atau alamat email mitra (untuk perusahaan yang bermitra dengan 
Apple untuk menyediakan layanan ini kepada pelanggan, seperti maskapai penerbangan). 
Halaman web mencakup:

•	 Lokasi AirTag di peta, jika tersedia

•	 Nomor telepon pemilik terdaftar

•	 Nomor seri AirTag

Untuk mempelajari lebih lanjut, lihat Membagikan lokasi barang yang hilang di Lacak di 
Petunjuk Pengguna iPhone. (https://support.apple.com/guide/iphone/iph3bedf2cc5/ios)

  Berhenti berbagi pembaruan lokasi di iPhone atau iPad

Berbagi berhenti saat Anda sudah menemukan AirTag, setelah 7 hari, atau saat Anda 
mengakhirinya secara manual di app Lacak, mana saja yang lebih dulu.

https://support.apple.com/guide/iphone/iph3bedf2cc5/ios
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Untuk mengakhirinya secara manual di App Lacak:

1.	 Buka app Lacak  di iPhone atau iPad Anda.

2.	 Ketuk Barang, ketuk barang dengan halaman web yang dibagikan, lalu ketuk Bagikan 
Lokasi Barang.

3.	 Ketuk Berhenti Berbagi Lokasi Barang.

  Berhenti berbagi pembaruan lokasi di Mac

Berbagi berhenti saat Anda sudah menemukan AirTag, setelah 7 hari, atau saat Anda 
mengakhirinya secara manual di app Lacak, mana saja yang lebih dulu.

Untuk mengakhirinya secara manual di App Lacak:

1.	 Buka app Lacak  di Mac Anda.

2.	 Klik Barang, pilih barang dengan halaman web yang dibagikan, lalu klik  di peta.

3.	 Di bawah [barang] yang Hilang, klik Bagikan Lokasi Barang.

4.	 Klik Berhenti Berbagi Lokasi Barang.

Catatan: Menemukan barang dan membagikan lokasi barang tidak tersedia di semua negara 
atau wilayah.

 Lacak dan berbagi lokasi
App Lacak untuk iPhone, iPad, Mac, dan Apple Watch membantu Anda melacak perangkat 
Anda serta memungkinkan Anda dan orang lain membagikan lokasi satu sama lain.

Jika Anda mengatur Keluarga Berbagi dan menggunakan Berbagi Lokasi, anggota keluarga 
Anda secara otomatis muncul di tab Orang, tapi mereka masih harus membagikan lokasinya 
dengan Anda. Lihat “Meninggalkan atau menghapus anggota dari grup Keluarga Berbagi” 
nanti di petunjuk ini.
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  Detail berbagi lokasi dan lokasi yang dapat dilihat

Saat Anda membagikan lokasi Anda dengan orang lain melalui Lacak, mereka dapat 
melihatnya di app yang tercantum di tabel berikut.

Jika Anda dan orang yang Anda ajak berbagi lokasi memiliki iPhone dengan iOS 15 
atau lebih baru, Anda juga dapat membagikan Lokasi Langsung Anda di semua app 
yang tercantum di bawah. Jika Anda sedang bepergian, mereka dapat mengetahui arah 
perjalanan dan kecepatan Anda.
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App Deskripsi

App Lacak

Di app Lacak, orang lain dapat membuka tab Orang dan 
mengetuk nama Anda untuk melihat lokasi Anda.

App Lacak

Jika Anda dan orang lain sama-sama berbagi lokasi, 
keduanya memiliki i Phone 15 dan saling berdekatan, 
Anda dapat menggunakan Pencarian Tepat untuk 
menemukan lokasi persis masing-masing. Saat Anda 
berada di dekat orang ini, Pencarian Tepat membantu 
mereka menemukan Anda hingga mereka berada dalam 
jarak beberapa meter dari lokasi Anda. Jika seseorang 
mencoba menemukan Anda dengan Pencarian Tepat, 
Anda menerima pemberitahuan bahwa mereka mencoba 
menemukan Anda.

Untuk mempelajari lebih lanjut, lihat Menggunakan 
Pencarian Tepat di i Phone untuk bertemu dengan 
teman di Petunjuk Pengguna i Phone.  
(https://support.apple.com/guide/iphone/iph3effd0ed6)

App Lacak

Jika Anda mengatur Keluarga Berbagi dan 
menggunakan Berbagi Lokasi, anggota keluarga Anda 
secara otomatis muncul di tab Orang, tapi berbagi 
lokasi tidak dimulai sampai Anda saling membagikan 
lokasi. Lihat Meninggalkan atau menghapus anggota 
dari grup Keluarga Berbagi nanti di petunjuk ini.

App Pesan

Di Pesan, saat orang lain yang Anda bagikan lokasi 
Anda mengetuk ikon kontak Anda, mereka akan 
diarahkan ke tampilan Detail yang menunjukkan lokasi 
Anda saat ini yang dibagikan melalui Lacak.

App Pesan

Di Pesan di iOS 17 dan iPadOS 17 atau lebih baru, orang 
lain yang telah Anda bagikan lokasi Anda juga dapat 
melihat perkiraan lokasi Anda di bagian atas topik 
Pesan.

App Peta

Di Peta, saat orang lain yang Anda ajak berbagi lokasi 
mencari nama Anda, mereka akan melihat lokasi Anda 
saat ini dibagikan melalui Lacak di peta mereka.

  Pemberitahuan perubahan lokasi

Anda dapat menggunakan app Lacak untuk memberi tahu teman saat lokasi Anda berubah 
(https://support.apple.com/guide/iphone/iph9bfec93b1). Orang yang Anda bagikan lokasi 
juga dapat mengatur pemberitahuan untuk melihat saat lokasi Anda berubah.

Anda dapat mematikan pemberitahuan perubahan lokasi apa pun mengenai Anda. Ini 
termasuk pemberitahuan yang Anda atur dan pemberitahuan yang dibuat oleh teman Anda.

1.	 Untuk melihat semua pemberitahuan mengenai Anda, lakukan salah satu hal berikut:

•	 Di iPhone atau iPad Anda: Buka app Lacak , lalu ketuk Saya.

•	 Di Mac Anda: Buka app Lacak  , klik Saya, lalu klik .

https://support.apple.com/guide/iphone/iph3effd0ed6
https://support.apple.com/guide/iphone/iph3effd0ed6
https://support.apple.com/guide/iphone/iph3effd0ed6
https://support.apple.com/guide/iphone/iph9bfec93b1
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2.	 Cari bagian Pemberitahuan Mengenai Anda.

•	 Jika Anda melihat bagian Pemberitahuan Mengenai Anda, pilih nama untuk melihat 
detail lainnya.

•	 Jika Anda tidak melihat bagian Pemberitahuan Mengenai Anda, teman Anda tidak 
diberi tahu saat lokasi Anda berubah.

3.	 Jika Anda melihat pemberitahuan yang ingin Anda hapus, pilih nama, lalu pilih 
pemberitahuan.

4.	 Hapus pemberitahuan, lalu konfirmasi bahwa Anda ingin menghapusnya.

  Berhenti berbagi lokasi Anda di Lacak di iPhone atau iPad

Jika Anda berhenti berbagi melalui salah satu metode yang tercantum di bawah ini, lokasi 
Anda akan hilang dari app Lacak, Peta, Kontak, dan Pesan milik orang lain.

PENTING: Saat Anda berhenti berbagi lokasi, orang-orang yang sebelumnya Anda beri 
tahu mungkin menyadari bahwa Anda telah menghentikannya. Pada sistem operasi yang 
lebih lama, mereka mungkin menerima pemberitahuan di Pesan bahwa Anda berhenti 
berbagi.

1.	 Buka app Lacak .

2.	 Lakukan salah satu hal berikut ini:

•	 Untuk berhenti berbagi dengan satu orang: Pilih tab Orang, temukan orang yang 
ingin Anda hentikan berbaginya dan ketuk namanya, lalu gulir ke bawah dan ketuk 
Berhenti Berbagi Lokasi Saya.

•	 Untuk berhenti berbagi dengan setiap orang: Pilih tab Saya, lalu matikan Bagikan 
Lokasi Saya.

Catatan: Jika app Lacak telah dihapus dari perangkat Anda, Anda dapat mematikan 
Layanan Lokasi (buka Pengaturan  > Privasi & Keamanan > Layanan Lokasi) untuk 
membantu memastikan bahwa lokasi Anda tidak dibagikan. Kemudian unduh lagi app 
Lacak dari App Store.

  Berhenti berbagi lokasi Anda di Pesan di iPhone atau iPad

Saat Anda berhenti berbagi melalui salah satu metode yang tercantum di bawah, lokasi 
Anda akan hilang dari app Pesan orang lain di perangkat mereka.

1.	 Buka app Pesan .

2.	 Lakukan salah satu hal berikut ini:

•	 Untuk berhenti berbagi pesan dalam percakapan: Pilih percakapan dengan orang 
yang ingin Anda hentikan berbaginya, ketuk nama orang tersebut di bagian atas 
percakapan, lalu ketuk Berhenti Berbagi.

•	 Untuk berhenti berbagi dengan menghapus percakapan: Di daftar percakapan Pesan, 
gesek ke kiri di percakapan, ketuk , lalu ketuk Ya untuk mengonfirmasi bahwa Anda 
ingin berhenti membagikan lokasi Anda dengan peserta percakapan ini.
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  Berhenti berbagi lokasi Anda di Kontak di iPhone atau iPad

Saat Anda berhenti berbagi melalui salah satu metode yang tercantum di bawah, lokasi 
Anda akan hilang dari app Kontak orang lain di perangkat mereka.

1.	 Buka app Kontak .

2.	 Ketuk nama orang.

3.	 Ketuk Berhenti Berbagi Lokasi Saya.

  Waktu untuk menonaktifkan Lacak iPhone untuk perangkat yang hilang atau dicuri

Lacak iPhone (di Pengaturan  > Lacak) membantu Anda menemukan telepon Anda jika 
hilang atau dicuri.

Saat Lacak iPhone dinyalakan, perangkat Anda mungkin ditemukan melalui jaringan Lacak 
selama 24 jam setelah dimatikan atau terputus dari internet. Lokasi perangkat Anda 
terlihat melalui Lacak di tab Perangkat di perangkat Anda lainnya, dan bagi setiap orang di 
Keluarga Berbagi yang dengannya Anda membagikan lokasi.

Jika Anda perlu pergi ke lokasi aman dan Anda ingin mematikan perangkat, tapi Anda 
khawatir bahwa orang lain mungkin menggunakan fitur ini untuk menemukan lokasi Anda, 
Anda dapat mematikan Jaringan Lacak untuk sementara saat Anda mematikan perangkat 
dengan mengetuk iPhone Dapat Dicari Setelah Dimatikan (di bawah Geser-Matikan) dan 
mengikuti instruksi pada layar. Gunakan tugas di bawah jika Anda ingin menonaktifkan fitur 
ini.

HATI-HATI:  Saat Anda mematikan Lacak [perangkat] dan jaringan Lacak, Anda tidak dapat 
menemukan, mengunci, atau menghapus perangkat Anda jika hilang atau dicuri.

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > [nama Anda] > Lacak > Cari iPhone > 
jaringan Lacak.

Jika fitur ini dinonaktifkan, Anda tidak dapat menggunakannya jika perangkat Anda 
hilang atau dicuri dan dimatikan.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik nama Anda di bagian atas 
bar samping, lalu klik iCloud. Klik Tampilkan App Lainnya, lalu klik Lacak Mac.
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 Mengelola pengaturan Layanan Lokasi
Layanan Lokasi memungkinkan Anda memilih app (seperti Peta, Kamera, Cuaca, dan 
lainnya) dan situs web yang ingin Anda bagikan lokasi Anda. Saat dinyalakan, Layanan 
Lokasi menggunakan informasi dari berbagai jenis jaringan untuk menentukan perkiraan 
atau lokasi persis Anda. Anda dapat menemukan Layanan Lokasi di iPhone, iPad, Mac, dan 
Apple Watch.

Saat app menggunakan Layanan Lokasi, ikon Layanan Lokasi  muncul di iPhone dan iPad 
(di bar status di bagian atas layar) dan di Mac (di bar menu).

Meskipun Anda menonaktifkan Layanan Lokasi, app dan situs web pihak ketiga mungkin 
masih menggunakan cara lain untuk menentukan lokasi Anda. Demi keselamatan, informasi 
lokasi perangkat Anda dapat digunakan untuk panggilan darurat untuk membantu upaya 
respons terlepas dari apakah Anda mengaktifkan Layanan Lokasi atau tidak.

  Menyalakan atau mematikan Layanan Lokasi

Saat Anda mengatur perangkat, Anda ditanyakan apakah ingin menyalakan Layanan Lokasi. 
Setelah selesai mengatur, Anda dapat menyalakan atau mematikan Layanan Lokasi kapan pun.

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Privasi & Keamanan > Layanan Lokasi 
nyalakan atau matikan berbagi lokasi.

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, klik Privasi & Keamanan  di bar samping, lalu klik Layanan Lokasi. Nyalakan 
atau matikan Layanan Lokasi, masukkan kata sandi Anda jika diminta, lalu klik Buka.

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi Sistem, 
klik Keamanan & Privasi  di bar samping, klik Privasi, lalu klik Layanan Lokasi. Jika 
gembok di kiri bawah terkunci , klik untuk membuka panel preferensi. Nyalakan atau 
matikan Layanan Lokasi.

•	 Di Apple Watch Anda: Buka Pengaturan  > Privasi & Keamanan > Layanan Lokasi.
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  Menentukan app mana yang dapat menggunakan Layanan Lokasi di iPhone  
atau iPad

Sebagian app mungkin tidak bekerja kecuali jika Anda menyalakan Layanan Lokasi. 
Saat pertama kali app memerlukan akses ke informasi Layanan Lokasi Anda, Anda akan 
menerima pemberitahuan yang meminta izin. Pilih salah satu dari opsi ini:

•	 Izinkan Sekali

•	 Izinkan Saat Menggunakan App

•	 Jangan Izinkan

Anda juga dapat meninjau atau mengubah akses masing-masing app ke lokasi Anda dan 
menandakan seberapa sering app tersebut dapat menggunakan lokasi Anda. Berikut ini 
instruksi untuk iPhone atau iPad.

1.	 Buka Pengaturan  > Privasi & Keamanan > Layanan Lokasi, lalu tinjau atau ubah 
pengaturan akses untuk app.

Untuk melihat penjelasannya untuk meminta Layanan Lokasi, ketuk app.

2.	 Tentukan seberapa dekat Anda ingin app mengetahui lokasi Anda.

•	 Untuk mengizinkan app menggunakan lokasi tepat Anda, biarkan Lokasi Tepat 
menyala.

•	 Untuk membagikan hanya perkiraan lokasi Anda—yang mungkin cukup untuk app 
yang tidak memerlukan lokasi tepat Anda—Anda dapat mematikan Lokasi Tepat.

Catatan: Jika Anda mengatur akses untuk app ke Minta Lain Kali, Anda diminta untuk 
menyalakan Layanan Lokasi lagi kali berikutnya app mencoba menggunakannya.

  Menentukan app mana yang dapat menggunakan Layanan Lokasi di Mac

1.	 Lakukan salah satu hal berikut ini:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, klik Privasi & Keamanan  di bar samping, lalu klik Layanan Lokasi. Matikan 
Layanan Lokasi, masukkan kata sandi Anda, lalu klik Buka.

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi 
Sistem, klik Keamanan & Privasi  di bar samping, klik Layanan Lokasi, lalu batal 
pilih Aktifkan Layanan Lokasi. Anda mungkin harus membuka Preferensi Sistem 
terlebih dahulu untuk membuat perubahan. Untuk melakukan ini, klik  di pojok kiri 
bawah, lalu masukkan kata sandi Anda.
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2.	 Pilih kotak centang di samping app agar diizinkan untuk menggunakan Layanan Lokasi. 
Batal pilih kotak centang untuk mematikan Layanan Lokasi untuk app tersebut.

Jika Anda mematikan Layanan Lokasi untuk suatu app, Anda diminta untuk 
menyalakannya lagi lain kali app tersebut mencoba untuk menggunakan data lokasi Anda.

3.	 Gulir ke bagian bawah daftar app untuk memperlihatkan Layanan Sistem, lalu klik tombol 
Detail untuk melihat layanan sistem tertentu yang menggunakan lokasi Anda.

Untuk mengizinkan lokasi Mac Anda agar dapat digunakan oleh Saran Siri dan Saran 
Safari, pilih Saran Berbasis Lokasi.

Untuk mengizinkan Mac Anda untuk mengidentifikasi tempat penting bagi Anda serta 
menyediakan informasi terkait berguna di Peta, Kalender, Pengingat, dan lainnya, pilih 
Lokasi Penting. Lokasi penting dilindungi menggunakan enkripsi dan tidak dapat dibaca 
oleh Apple. Klik Detail untuk melihat daftar lokasi yang telah diidentifikasi. Untuk 
menghapus lokasi dari daftar, pilih lokasi tersebut dan klik . Untuk menghapus semua 
lokasi, klik , lalu klik Bersihkan Riwayat.

 Mengelola berbagi ETA otomatis di Peta
Di Peta di iPhone dan iPad (model Wi-Fi + Cellular), Anda dapat secara otomatis 
membagikan perkiraan waktu kedatangan (ETA) ke lokasi Favorit dengan siapa pun di 
Kontak Anda. Setelah Anda mengatur ini, setiap kali Anda menavigasi ke lokasi Favorit, 
ETA Anda dibagikan dengan kontak. Setelah Anda berada di rute Anda, bagian bawah layar 
menunjukkan bahwa Anda berbagi ETA dengan orang lain.
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  Mengelola berbagi ETA di iPhone atau iPad Anda

1.	 Di app Peta  di iPhone atau iPad Anda (model Wi-Fi + Cellular), ketuk ikon profil Anda 
di sebelah kanan bidang pencarian.

2.	 Pilih Favorit untuk membuka jendela yang berisi semua lokasi yang telah Anda tetapkan 
sebagai Favorit.

3.	 Ketuk  di samping tempat menarik Favorit.

4.	 Gulir ke bawah ke bagian Bagikan ETA untuk meninjau nama-nama orang yang secara 
otomatis Anda bagikan ETA Anda.

5.	 Untuk menghapus seseorang, ketuk Berhenti Berbagi ETA di samping nama orang yang 
ingin Anda hapus.

6.	 Untuk menambahkan seseorang, ketuk Tambah Orang, lalu di app Kontak, pilih orang 
yang ingin Anda bagikan ETA secara otomatis untuk tempat menarik ini.

7.	 Ulangi langkah 3–6 untuk semua tempat menarik tambahan di Favorit Anda.

  Berhenti berbagi ETA otomatis setelah navigasi dimulai

Anda dapat menghentikan berbagi ETA otomatis bahkan setelah Anda mulai menavigasi 
ke lokasi Favorit. Jika Anda berhenti berbagi ETA Anda menggunakan metode ini, orang 
tersebut telah menerima pemberitahuan di perangkat mereka yang memberi tahu mereka 
bahwa Anda sedang menavigasi ke lokasi Favorit yang Anda pilih; namun, mereka tidak lagi 
dapat mengakses ETA atau informasi rute Anda.

 PENTING: Metode ini tidak secara permanen menghapus berbagi otomatis dengan 
orang tersebut. Lain kali Anda menavigasi ke lokasi Favorit yang sama, berbagi ETA 
otomatis dimulai lagi. Untuk mencegah hal ini, Anda harus menghapus kontak dari Bagikan 
ETA di lokasi Favorit.

1.	 Di app Peta  di iPhone atau iPad (model Wi-Fi + Cellular), ketuk “Berbagi dengan 
[Nama Kontak]” di bagian bawah layar.

2.	 Identifikasi orang dalam daftar yang tidak lagi ingin Anda bagikan ETA Anda.

3.	 Pilih “Ketuk untuk berhenti”, yang terletak di bawah nama orang tersebut.
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 Mengelola metadata lokasi di Foto
Saat Layanan Lokasi dinyalakan untuk app Kamera, layanan tersebut menggunakan 
informasi yang disebut metadata yang dikumpulkan dari jaringan seluler, Wi-Fi, GPS, dan 
Bluetooth untuk menentukan koordinat lokasi pengambilan foto atau video. Koordinat 
ini disematkan ke setiap foto dan video agar Anda dapat mencarinya nanti di app Foto 
berdasarkan lokasi pengambilannya, atau melihat koleksi berdasarkan lokasi di album 
Tempat.

Jika foto dan video yang menyertakan metadata lokasi dibagikan, orang yang Anda 
ajak berbagi mungkin dapat mengakses metadata lokasi dan mengetahui lokasi 
pengambilannya. Jika Anda khawatir seseorang memiliki akses ke metadata lokasi yang 
terkait dengan foto atau video Anda, Anda dapat menghapus metadata saat ini dan 
menghentikannya dikumpulkan di masa mendatang.

  Meninjau foto yang berisi metadata lokasi di iPhone atau iPad
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Anda dapat menggunakan album Tempat di Foto untuk meninjau foto dengan mudah di 
perpustakaan Anda yang disemati metadata lokasi.

1.	 Buka app Foto , lalu pilih Album.

2.	 Ketuk album Tempat, lalu lakukan salah satu hal berikut:

•	 Jika Anda ingin meninjau foto dari periode waktu tertentu, ketuk Grid untuk melihat 
dalam urutan kronologis.

•	 Jika Anda ingin meninjau lokasi pengambilan, ketuk Peta untuk melihat menurut lokasi.

  Meninjau foto yang berisi metadata lokasi di Mac

Anda dapat menggunakan album Tempat di Foto untuk meninjau foto dengan mudah di 
perpustakaan Anda yang disemati metadata lokasi.

1.	 Di app Foto  di Mac Anda, pilih foto yang ingin Anda tinjau.

2.	 Klik , lalu tinjau informasi lokasi.

  Menghapus metadata lokasi di Foto di iPhone atau iPad

Untuk menghapus metadata lokasi yang terkait dengan foto tertentu:

1.	 Buka app Foto , lalu pilih Album.

2.	 Ketuk album Tempat, lalu lakukan salah satu hal berikut:

•	 Jika Anda ingin meninjau foto dari periode waktu tertentu, ketuk Grid untuk melihat 
dalam urutan kronologis.

•	 Jika Anda ingin meninjau lokasi pengambilan, ketuk Peta untuk melihat menurut lokasi.

3.	 Buka foto tempat yang metadata lokasinya ingin Anda hapus, lalu ketuk  atau gesek  
ke atas.

Anda melihat gambar di app Peta yang menampilkan tempat foto diambil.

4.	 Untuk menghapus metadata lokasi, ketuk Sesuaikan, lalu ketuk Hapus Lokasi.

  Menghapus metadata lokasi di Foto di Mac

Untuk menghapus metadata lokasi yang terkait dengan foto:

1.	 Di app Foto  di Mac Anda, pilih foto yang ingin Anda ubah.

2.	 Pilih Gambar > Lokasi, lalu pilih Sembunyikan Lokasi atau Kembalikan ke Lokasi Asli.
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  Menghentikan pengumpulan metadata lokasi di Kamera di iPhone atau iPad

Metadata lokasi di foto dan video hanya dapat dikumpulkan jika app Kamera Anda memiliki 
akses ke Layanan Lokasi.

•	 Buka Pengaturan , ketuk Privasi & Keamanan > Layanan Lokasi > Kamera, lalu ketuk 
Jangan Pernah.

Jika Anda tidak ingin sepenuhnya berhenti mengumpulkan metadata lokasi, Anda dapat 
mematikan Lokasi Tepat alih-alih memilih Jangan Pernah. Ini memungkinkan app Kamera 
untuk mengumpulkan data mengenai perkiraan lokasi alih-alih lokasi spesifik Anda.

  Jangan bagikan metadata lokasi saat Anda membagikan foto di Foto di iPhone 
atau iPad

Anda dapat berbagi foto dengan orang lain tanpa berbagi lokasi pengambilan foto.

1.	 Lakukan salah satu hal berikut:

•	 Buka app Kamera , pilih rol kamera, lalu pilih satu atau beberapa foto yang ingin 
Anda bagikan.

•	 Buka app Foto , lalu pilih satu atau beberapa foto yang ingin Anda bagikan.

2.	 Ketuk , lalu ketuk Pilihan.

3.	 Matikan Lokasi, lalu ketuk Selesai.

4.	 Bagikan foto menggunakan salah satu metode yang ditampilkan di Lembar Berbagi.
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 Mengelola konten

 Umum

 Fitur privasi app di produk Apple
Apple menyediakan pengaturan, fitur, dan kontrol untuk membantu Anda meninjau dan 
mengelola data yang Anda bagikan dengan app.
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  Meninjau dan memperbarui pengaturan privasi app di perangkat Apple

Pengaturan privasi di perangkat Anda telah dirancang dengan hati-hati untuk membantu 
Anda mengontrol data Anda. Misalnya, Anda dapat mengizinkan app jejaring sosial untuk 
menggunakan kamera Anda sehingga Anda dapat mengambil dan mengunggah gambar 
ke app tersebut. Salah satu alasan untuk meninjau pengaturan ini adalah jika orang lain 
mengatur perangkat Anda atau telah memiliki akses ke perangkat dan mengetahui kode 
sandi Anda. Anda ingin memastikan mereka tidak mengubah pengaturan Anda.

1.	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Privasi & Keamanan .

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, lalu klik Privasi & Keamanan  
di bar samping.

2.	 Tinjau daftar jenis data (misalnya, Kalender, Kontak, Foto, Pengingat, dan seterusnya).

3.	 Pilih jenis data dari daftar untuk melihat app mana di perangkat Anda yang memiliki 
akses ke jenis data tersebut.

App tidak muncul di daftar hingga app meminta izin, dan Anda dapat memberikan 
atau menghapus izin dari app apa pun yang telah meminta izin. Untuk foto Anda juga 
dapat mengubah akses yang diberikan ke app. App dapat menggunakan jenis data di 
pengaturan hanya jika Anda telah memberikan izin ke app.

Catatan: Mengubah pengaturan privasi di perangkat Apple Anda hanya mengubah 
bagaimana app tersebut dapat mengakses data Anda. Jika Anda ingin mengubah 
pengaturan Privasi & Keamanan untuk app pihak ketiga (app yang dibuat oleh 
perusahaan selain Apple), Anda harus masuk ke akun pihak ketiga (melalui app-nya atau 
melalui browser) dan memperbarui pengaturan dari sana.
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  Menggunakan Transparansi Pelacakan App

Transparansi Pelacakan App memungkinkan Anda untuk menentukan apakah app dapat 
melacak aktivitas Anda di semua app serta situs web perusahaan lainnya. Anda dapat 
menarik izin untuk melacak aktivitas Anda kapan pun. Jika Anda mematikan “Izinkan 
App untuk Meminta Izin Melacak”, Anda tidak mendapatkan permintaan dari app yang 
ingin melacak aktivitas Anda. Setiap app yang meminta izin melacak saat pengaturan ini 
dimatikan diperlakukan seakan-akan Anda memilih Minta App untuk Tidak Melacak.

•	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Privasi & Keamanan > Pelacakan, 
lalu matikan Izinkan App untuk Meminta Izin Melacak.

•	 Di Apple TV Anda: Buka Pengaturan > Umum > Privasi & Keamanan > Pelacakan, lalu 
matikan Izinkan App untuk Meminta Izin Melacak.

  Melihat bagaimana app mengakses data Anda dengan Laporan Privasi App

Jika Anda khawatir seseorang yang dekat dengan Anda menginstal app di iPhone atau iPad 
Anda tanpa izin—atau mereka mengubah pengaturan app yang Anda instal—Anda dapat 
menyalakan Laporan Privasi App.

Anda akan menemukan detail mengenai seberapa sering setiap app mengakses data Anda 
(misalnya, lokasi, kamera, dan mikrofon Anda).

1.	 Buka Pengaturan  > Privasi & Keamanan.

2.	 Gulir ke bawah dan ketuk Laporan Privasi App.

3.	 Nyalakan Laporan Privasi App.

Anda dapat matikan Laporan Privasi App kapan pun dengan membuka Pengaturan > 
Privasi & Keamanan > Laporan Privasi App. Melakukan ini juga akan membersihkan data 
laporan dari perangkat Anda.

Catatan: Laporan Privasi App mulai mengumpulkan informasi hanya setelah Anda 
menyalakannya, sehingga mungkin membutuhkan beberapa waktu agar detail muncul. 
Anda akan melihat info lainnya saat Anda terus menggunakan app di perangkat Anda. 
Data di Laporan Privasi App dienkripsi dan hanya disimpan di perangkat Anda. Laporan 
menampilkan berapa kali—dan kapan—app mengakses data sensitif privasi atau sensor 
perangkat selama 7 hari terakhir. Anda dapat mengetuk setiap app dan jenis data untuk 
mempelajari lebih lanjut.

 Meninjau dan menghapus app
Jika Anda khawatir seseorang mungkin telah menginstal app di perangkat Anda tanpa izin, 
Anda dapat meninjau daftar app untuk memastikan Anda tidak memiliki sesuatu yang tidak 
Anda inginkan (instruksi dimulai di bagian berikutnya di bawah ini).

Jika Anda tidak yakin dengan fungsi app tersebut, Anda dapat melihatnya di App Store.

Anda dapat meninjau dan mengubah jenis data yang diizinkan diakses oleh setiap app 
(seperti lokasi, foto, dll.) Anda dapat melakukan ini melalui fitur Pemeriksaan Keselamatan 
di iOS 16 atau lebih baru.

Anda mungkin juga ingin meninjau Pengaturan app pihak ketiga yang hanya tersedia di app 
yang tidak dapat dikelola melalui Apple.
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PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan dan privasi Anda.

  Untuk menghapus app dari Perpustakaan App di iPhone atau iPad

1.	 Buka Layar Utama, lalu gesek ke kiri melewati semua halaman Layar Utama Anda untuk 
menuju ke Perpustakaan App.

2.	 Ketuk di bidang pencarian. Daftar semua app di perangkat menurut alfabet muncul.

3.	 Jika Anda melihat app yang ingin dihapus, sentuh dan tahan ikon app hingga menu 
muncul.

4.	 Ketuk Hapus App untuk menghapusnya.

Untuk mempelajari lebih lanjut, lihat Membuang atau menghapus app dari iPhone di 
Petunjuk Pengguna iPhone.

(https://support.apple.com/guide/iphone/iph248b543ca)

http://help.apple.com/finalcutpro/
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  Untuk menghapus app dari Layar Utama

1.	 Sentuh dan tahan app di Layar Utama.

2.	 Ketuk Hapus App, lalu ketuk Hapus App untuk menghapusnya.

Untuk mempelajari lebih lanjut, lihat Membuang atau menghapus app dari iPhone di 
Petunjuk Pengguna iPhone.

(https://support.apple.com/guide/iphone/iph248b543ca)

  Menghapus app dari Mac

Anda dapat menghapus app yang mungkin telah diunduh dan diinstal dari internet atau dari 
perangkat eksternal, seperti perangkat USB.

1.	 Klik ikon Finder  di Dock, lalu klik Aplikasi di bar samping Finder.

2.	 Lakukan salah satu hal berikut ini:

•	 Jika app berada di folder: Buka folder app untuk mencari Pencopot. Jika ditampilkan, 
klik dua kali Copot [App] atau Pencopot [App], lalu ikuti instruksi pada layar.

•	 Jika app tidak berada di folder atau tidak memiliki Pencopot: Jika app tidak berada di 
folder atau tidak memiliki Pencopot: Seret app dari folder Aplikasi ke Tong Sampah 
(di akhir Dock).

PERINGATAN: App dihapus secara permanen dari Mac Anda lain kali Anda atau 
Finder mengosongkan Tong Sampah. Jika Anda memiliki file yang Anda buat dengan 
app, Anda mungkin tidak dapat membukanya lagi. Jika Anda memutuskan ingin 
menyimpan app, kembalikan dari Tong Sampah sebelum dikosongkan. Pilih app di 
Tong Sampah, lalu pilih File > Letakkan Kembali.

Untuk mencopot app yang diunduh dari App Store, gunakan Launchpad.

 Mengunci atau menyembunyikan app di iPhone Anda
Jika Anda ingin menunjukkan sesuatu kepada seseorang di iPhone Anda, tapi ingin merasa 
tenang karena mereka tidak dapat mengakses app tertentu, Anda dapat mengunci atau 
menyembunyikan app.

•	 Mengunci app: App memerlukan Face ID, Touch ID, atau kode sandi Anda untuk 
membukanya. Informasi di dalam app terkunci tidak akan muncul di beberapa lokasi di 
iPhone Anda—misalnya, di pratinjau pemberitahuan, pencarian, saran Siri, atau riwayat 
panggilan Anda.

•	 Menyembunyikan app: App dikunci seperti dijelaskan di atas; app juga menghilang dari 
Layar Utama dan dipindahkan ke folder Tersembunyi di bagian bawah Perpustakaan 
App. App masih terlihat di tempat lain di iPhone Anda.

PENTING: Saat Anda mengunci atau menyembunyikan app di perangkat Anda, app 
tersebut hanya akan dikunci atau disembunyikan di perangkat tersebut. Status dikunci atau 
disembunyikan dari app tidak diselaraskan dengan iCloud.

https://support.apple.com/guide/iphone/iph248b543ca
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Catatan: Anak-anak berumur 13 tahun ke bawah dalam grup Keluarga Berbagi tidak dapat 
mengunci atau menyembunyikan app. Siapa pun yang berumur 13 hingga 17 tahun dalam 
grup Keluarga Berbagi dapat mengunci atau menyembunyikan app, tapi orang tua atau 
wali dalam grup keluarga dapat melihat bahwa app tersebut diunduh dan berapa lama app 
tersebut digunakan, serta membatasi akses ke app tersebut menggunakan Durasi Layar. 
(Umur ini bervariasi menurut negara atau wilayah.)

  Mengunci app

Catatan: Beberapa app yang disertakan dengan iPhone tidak dapat dikunci—termasuk 
Kalkulator, Kamera, Jam, Kontak, Lacak, Peta, Pintasan, dan Pengaturan.

1.	 Buka Layar Utama di iPhone Anda, lalu cari app yang ingin Anda kunci.

2.	 Sentuh dan tahan ikon app hingga menu tindakan cepat terbuka.

3.	 Ketuk Perlukan Face ID (atau Touch ID atau Kode Sandi).

4.	 Ketuk Perlukan Face ID (atau Touch ID atau Kode Sandi) lagi, lalu sahkan menggunakan 
Face ID (atau Touch ID atau kode sandi).

  Menyembunyikan app

Catatan: App yang diinstal bersama iOS 18 atau lebih baru tidak dapat disembunyikan—
hanya app yang Anda unduh secara terpisah yang dapat disembunyikan.

1.	 Buka Layar Utama di iPhone Anda, lalu cari app yang ingin Anda sembunyikan.

2.	 Sentuh dan tahan ikon app hingga menu tindakan cepat terbuka.

3.	 Ketuk Perlukan Face ID (atau Touch ID atau Kode Sandi).

4.	 Ketuk Sembunyikan dan Perlukan Face ID (atau Touch ID atau Kode Sandi) lagi, sahkan 
menggunakan Face ID (atau Touch ID atau kode sandi), lalu ketuk Sembunyikan App.
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  Di mana app tersembunyi terlihat?

Untuk menggunakan app tersembunyi, buka Layar Utama, gesek ke kiri melewati semua 
halaman Layar Utama untuk membuka Perpustakaan App, ketuk folder Tersembunyi, lalu 
sahkan menggunakan Face ID, Touch ID, atau kode sandi.

Ada beberapa tempat lain Anda mungkin dapat melihat nama app tersembunyi:

•	 Pengaturan  > App > App Tersembunyi (memerlukan pengesahan menggunakan 
Face ID, Touch ID, atau kode sandi)

•	 Pengaturan  > Durasi Layar

•	 Pengaturan  > Baterai > Kesehatan & Pengisian Daya Baterai

•	 Riwayat pembelian App Store. Lihat artikel Dukungan Apple Menyembunyikan pembelian 
dari App Store (https://support.apple.com/108091).

  Menampilkan app

Anda dapat berhenti menyembunyikan app sehingga Anda dapat melihatnya lagi di Layar 
Utama.

1.	 Buka Layar Utama di iPhone Anda.

2.	 Gesek ke kiri melewati semua halaman Layar Utama untuk membuka Perpustakaan App.

3.	 Ketuk folder Tersembunyi di bagian bawah Perpustakaan App, lalu sahkan menggunakan 
Face ID (atau Touch ID atau kode sandi).

4.	 Untuk memindahkan app keluar dari folder Tersembunyi, sentuh dan tahan app, ketuk 
Jangan Perlukan Face ID (atau Touch ID atau Kode Sandi), lalu sahkan menggunakan 
Face ID (atau Touch ID atau kode sandi).

App muncul di Layar Utama dan di dekat bagian atas Perpustakaan App.

 Pengaturan app pihak ketiga

 Pengantar app pihak ketiga
Di ekosistem Apple, ada dua jenis app yang tersedia:

•	 App pihak pertama: Dikembangkan oleh Apple, seperti Pesan, Kalender, Safari, atau 
FaceTime.

•	 App pihak ketiga: Dikembangkan oleh perusahaan dan organisasi selain Apple, seperti 
Instagram, YouTube, Threads, atau Google.

App pihak ketiga tersedia di App Store atau toko app alternatif. Pengaturan dan kontrol 
akun mereka mungkin berbeda dari app yang dikembangkan oleh Apple, dan beberapa 
kontrolnya mungkin hanya dapat diakses di dalam app atau melalui situs web pengembang 
app pihak ketiga. Pembedaan ini penting, karena app pihak ketiga umumnya memerlukan 
langkah tambahan untuk mengelola pengaturan berbagi dan privasi.

https://support.apple.com/108091
https://support.apple.com/108091
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 Pengaturan Apple untuk app pihak ketiga
Beberapa pengaturan untuk app pihak ketiga dapat dikelola di app Pengaturan. Pengaturan 
ini mencakup fungsionalitas perangkat Apple yang dapat diakses dan digunakan app 
tersebut. Beberapa contoh termasuk akses ke Lokasi, Kontak, Foto, atau kemampuan untuk 
mengirim pemberitahuan.

Untuk mengelola pengaturan ini, buka Pengaturan , gulir ke bawah, lalu ketuk app yang 
ingin Anda kelola.

 Pengaturan pihak ketiga hanya tersedia di app
Beberapa pengaturan app pihak ketiga tidak dapat dikelola melalui Apple, dan sebagai 
gantinya hanya dapat dikelola langsung di app. Untuk mengelola bagaimana app pihak 
ketiga berbagi informasi dengan orang lain, buka app dan navigasi ke pengaturan akun. 
Pengaturan ini mungkin berada di bawah nama lain seperti “Preferensi”, dan beberapa 
pengaturan mungkin berada di bagian lain dari pengaturan akun. Area penting yang perlu 
ditinjau adalah pengaturan keselamatan, keamanan, privasi, berbagi data, dan kemampuan 
ditemukan. Untuk beberapa app, mencari artikel dukungan atau FAQ app tersebut akan 
diperlukan untuk menemukan semua pengaturan yang tersedia untuk dikelola.

Catatan: Di beberapa pengaturan, pengaturan tertentu, seperti menghapus akun Anda 
atau meminta salinan data Anda, mungkin hanya tersedia untuk dikelola melalui situs web 
pengembang app pihak ketiga. Jika Anda ingin mengubah pengaturan akun, Anda harus 
masuk ke situs web app pihak ketiga dan memperbarui pengaturan dari sana.

Memblokir, membisukan, dan membatalkan pertemanan

Mengelola hubungan dalam ekosistem Apple tidak berlaku untuk individu dan komunikasi 
dalam app pihak ketiga. Misalnya, memblokir seseorang di Pesan, Telepon, atau FaceTime 
tidak berarti akan memblokir mereka di Instagram. Hubungan tersebut harus dikelola 
dari dalam app pihak ketiga itu sendiri. Periksa situs dukungan app pihak ketiga untuk 
informasi lebih lanjut mengenai memblokir sementara atau permanen, membisukan, atau 
membatalkan pertemanan pengguna.
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 Meninjau pengaturan penerusan
Anda dapat meninjau dan mengelola cara Anda meneruskan konten dan kepada siapa Anda 
meneruskannya.

PENTING: Sebelum melakukan perubahan atau menghapus informasi, pertimbangkan 
potensi dampak keselamatan dan privasi Anda.

  Mengelola penerusan Mail iCloud

Anda dapat melihat apakah pesan Anda di Mail iCloud diteruskan secara otomatis ke  
alamat email lain dan menonaktifkan penerusan dengan mudah.

1.	 Masuk ke iCloud di https://www.icloud.com dengan nama pengguna dan kata sandi 
Akun Apple Anda. Jika perlu, masukkan kode autentikasi dua faktor.

2.	 Klik Mail, lalu klik  di bagian atas daftar Kotak Mail, lalu pilih Preferensi.

3.	 Di tab Umum, lihat apakah “Teruskan email saya ke” dipilih dan ke alamat mana email 
tersebut diteruskan. Jika perlu, hapus alamat penerusan dan hentikan penerusan  
pesan mail.

4.	 Di tab Aturan, tinjau aturan apa pun tempat pilihan “Lalu” diatur ke “Teruskan ke” atau 
“Teruskan ke Alamat Email dan Tandai sebagai Dibaca”, dan jika perlu, ubah aturan  
yang sesuai.

5.	 Keluar dari iCloud.

  Mengelola penerusan pesan teks di iPhone

Saat Anda mengirim pesan ke seseorang yang menggunakan telepon selain iPhone, pesan 
Anda dikirim sebagai pesan teks. Anda dapat mengatur iPhone Anda sehingga saat Anda 
mengirim atau menerima pesan teks, pesan tersebut muncul di perangkat lain tempat Anda 
masuk ke Akun Apple Anda. Perangkat tersebut juga dapat mengirim pesan teks baru. 
Jika Anda khawatir bahwa pesan Anda sedang diteruskan ke perangkat lain, Anda dapat 
meninjau daftar perangkat dan menonaktifkan penerusan pesan teks.

1.	 Di iPhone Anda, buka Pengaturan  > App > Pesan.

2.	 Ketuk Penerusan Pesan Teks untuk melihat perangkat mana yang dapat mengirim dan 
menerima pesan teks dari perangkat Anda.

3.	 Matikan perangkat apa pun yang tidak ingin Anda gunakan untuk menerima atau 
mengirim pesan teks.

https://www.icloud.com
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  Mengelola penerusan panggilan dan panggilan di perangkat lain di iPhone

Tergantung pada operator seluler Anda, iPhone Anda mungkin dapat meneruskan panggilan 
yang Anda terima ke nomor telepon lain. Anda dapat memeriksa untuk melihat apakah 
panggilan yang Anda terima sedang diteruskan ke nomor telepon lain dan mematikan fitur ini.

1.	 Di iPhone Anda, buka Pengaturan  > App > Telepon > Penerusan Panggilan.

Jika bar penggeser berwarna hijau, artinya penerusan panggilan dinyalakan dan Anda 
dapat melihat nomor telepon yang menjadi tujuan penerusan panggilan Anda.

Catatan: Jika Anda tidak melihat pilihan ini, penerusan panggilan tidak tersedia di 
iPhone Anda. Hubungi operator seluler Anda untuk informasi lebih lanjut.

2.	 Jika perlu, matikan penerusan panggilan.

Mematikan penerusan panggilan tidak akan memberi tahu nomor telepon yang 
menerima panggilan yang diteruskan.

 Menyembunyikan foto dan video di perangkat Apple
Di Foto di iPhone, iPad, atau Mac Anda, Anda dapat menyembunyikan foto yang tidak ingin 
ditampilkan. Foto yang disembunyikan tetap ada di perpustakaan Anda, dan Anda dapat 
menampilkannya nanti jika Anda mau.

  Menyembunyikan foto untuk sementara di iPhone atau iPad

1.	 Buka app Foto  di iPhone atau iPad Anda.

2.	 Sentuh dan tahan foto yang ingin Anda sembunyikan.

3.	 Ketuk Sembunyikan, lalu konfirmasikan bahwa Anda ingin menyembunyikan foto 
tersebut.

Foto yang dipilih akan hilang dari tampilan, tapi tidak dihapus.

  Menyembunyikan foto untuk sementara di Mac

1.	 Buka app Foto  di Mac Anda.

2.	 Klik Perpustakaan di bar samping, lalu pilih foto yang ingin Anda sembunyikan.

3.	 Pilih Gambar > Sembunyikan [angka] Foto, lalu klik Sembunyikan.

Foto yang dipilih akan hilang dari tampilan, tapi tidak dihapus.
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  Menampilkan foto yang telah Anda sembunyikan di iPhone atau iPad

1.	 Buka app Foto  di iPhone atau iPad Anda.

2.	 Gulir ke bawah dan ketuk Tersembunyi (di bawah Utilitas).

 Kiat: Di iPad, Anda mungkin perlu mengetuk ikon bar samping di pojok kiri atas 
terlebih dahulu untuk melihat album Anda.

3.	 Ketuk Lihat Album, lalu gunakan Face ID atau Touch ID untuk membuka album 
Tersembunyi Anda.

4.	 Sentuh dan tahan foto atau video yang ingin Anda tampilkan kembali, lalu ketuk 
Tunjukkan.

  Menampilkan foto yang telah Anda sembunyikan di Mac

1.	 Buka app Foto  di Mac Anda.

2.	 Klik Perpustakaan di bar samping, lalu pilih Lihat > Tampilkan Album Foto Tersembunyi.

Album Tersembunyi muncul di bar samping, di Utilitas. Jika album Tersembunyi 
terkunci, gunakan Touch ID atau masukkan kata sandi Anda untuk membukanya. 
Untuk menyembunyikan Album Tersembunyi, pilih Lihat > Sembunyikan Album Foto 
Tersembunyi.

3.	 Pilih foto yang ingin Anda tampilkan, lalu pilih Gambar > Tampilkan [jumlah] Foto.

  Menampilkan atau menyembunyikan koleksi Tersembunyi di iPhone atau iPad

Secara default, album Tersembunyi terlihat dalam koleksi Utilitas. Anda dapat 
menyembunyikannya dari tampilan kapan saja.

1.	 Di iPhone atau iPad Anda, buka Pengaturan > App > Foto.

2.	 Gulir ke bawah, lalu lakukan salah satu hal berikut:

•	 Menampilkan Album Tersembunyi di Utilitas: Nyalakan Tampilkan Album 
Tersembunyi.

•	 Menyembunyikan Album Tersembunyi: Matikan Tampilkan Album Tersembunyi.

Album Tersembunyi memerlukan Face ID, Touch ID, atau kode sandi untuk membukanya. 
Untuk mengubah pengaturan tersebut, lihat pengaturan Foto.

  Menampilkan atau menyembunyikan koleksi Tersembunyi di Mac

Secara default, album Tersembunyi dikunci dan disembunyikan dari tampilan. Anda dapat 
mengizinkannya terlihat dalam koleksi Utilitas, dan menyembunyikannya dari tampilan 
kapan saja.

1.	 Buka app Foto  di Mac Anda.

2.	 Klik Perpustakaan di bar samping, lalu lakukan salah satu hal berikut:

•	 Menampilkan Album Tersembunyi di Utilitas: Pilih Lihat > Tampilkan Album Foto 
Tersembunyi.

•	 Menyembunyikan Album Tersembunyi: Pilih Lihat > Sembunyikan Album Foto 
Tersembunyi.

Album Tersembunyi memerlukan kata sandi atau Touch ID untuk membukanya. Untuk 
mengubah pengaturan tersebut, lihat Pengaturan Foto.
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 Peringatan gambar dan video sensitif
Peringatan Konten Sensitif membantu pengguna dewasa menghindari melihat gambar 
dan video telanjang yang tidak diinginkan saat menerimanya di Pesan, di AirDrop, di 
pesan video FaceTime, dan di app Telepon saat menerima Poster Kontak—semuanya 
menggunakan teknologi yang mempertahankan privasi dalam inti Keamanan Komunikasi. 
Fitur tersebut bersifat opsional dan dapat nyalakan oleh pengguna di pengaturan Privasi & 
Keamanan.

  Mengatur Peringatan Konten Sensitif di iPhone, iPad, atau Mac

1.	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Privasi & Keamanan , lalu ketuk 
Peringatan Konten Sensitif.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik Privasi & Keamanan   
di bar samping, lalu klik Peringatan Konten Sensitif.
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2.	 Nyalakan Peringatan Konten Sensitif.

Jika Peringatan Konten Sensitif menentukan bahwa Anda telah menerima foto atau video 
yang tampaknya berisi ketelanjangan, peringatan tersebut akan mengaburkan gambar, 
menampilkan peringatan bahwa konten tersebut tampaknya sensitif, dan menawarkan 
cara untuk mendapatkan bantuan.

 Mendapatkan bukti yang terkait dengan Akun Apple lain
Apple berkomitmen untuk melindungi keamanan dan privasi pengguna kami. Jika Anda 
mengalami penyalahgunaan, penguntitan, atau pelecehan menggunakan teknologi dan 
ingin meminta bukti terkait akun orang lain, Anda harus bermitra dengan penegak hukum 
atau pengadilan setempat untuk mengirimkan permintaan tersebut. Dalam mengenali 
kebutuhan bukti digital yang sedang berlangsung dari lembaga penegak hukum, kami 
memiliki tim profesional yang berdedikasi dalam departemen hukum kami yang mengelola 
dan merespons semua permintaan hukum yang diterima dari lembaga penegak hukum 
secara global.

Semua permintaan informasi lainnya mengenai pelanggan Apple, termasuk pertanyaan 
pelanggan tentang pengungkapan informasi, harus ditujukan ke https://www.apple.com/
privacy/contact/.

 Panduan Apple untuk permintaan penegakan hukum
Lihat panduan berikut untuk permintaan penegakan hukum, untuk di dalam dan di luar 
Amerika Serikat:

•	 Di dalam Amerika Serikat: Panduan Proses Hukum

(https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf)

•	 Di luar Amerika Serikat: Panduan Proses Hukum

(https://www.apple.com/legal/privacy/law-enforcement-guidelines-outside-us.pdf)

https://www.apple.com/privacy/contact/
https://www.apple.com/privacy/contact/
https://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
https://www.apple.com/legal/privacy/law-enforcement-guidelines-outside-us.pdf
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 Merekam aktivitas mencurigakan
Jika Anda mengalami pelecehan atau khawatir mengenai aktivitas mencurigakan di akun 
atau perangkat Anda, Anda dapat mengambil tangkapan layar atau rekaman layar dari 
konten terkait. Tangkapan layar adalah gambar yang muncul di layar perangkat Anda. 
Rekaman layar adalah video yang berisi apa yang muncul di layar perangkat Anda, dan 
mencakup audio terkait yang diputar melalui perangkat saat perekaman. Anda dapat 
menyimpannya sebagai file gambar atau video di iPhone, iPad, atau Mac Anda.

Jika Anda ingin meminta informasi dari Apple mengenai akun orang lain yang terkait 
dengan kasus penguntitan atau pelecehan, lihat Mendapatkan bukti yang terkait dengan 
Akun Apple lain nanti dalam petunjuk ini.

  Mengambil tangkapan layar atau rekaman layar di iPhone atau iPad Anda

1.	 Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad dengan Face ID: Tekan lalu lepas tombol samping dan tombol 
volume naik secara bersamaan.

•	 Di iPhone atau iPad dengan tombol Utama: Tekan lalu lepaskan tombol Utama 
dan tombol samping atau tombol Tidur/Bangun (tergantung model Anda) secara 
bersamaan.

2.	 Ketuk tangkapan layar di pojok kiri bawah, lalu ketuk Selesai.

3.	 Pilih Simpan ke Foto, Simpan ke File, atau Hapus Tangkapan Layar.

Jika Anda memilih Simpan ke Foto, Anda dapat melihatnya di album Tangkapan Layar di 
app Foto, atau di album Semua Foto jika Foto iCloud dinyalakan di Pengaturan > Foto.

  Mengambil gambar atau rekaman layar di Mac Anda

1.	 Tekan Shift-Command-5 (atau gunakan Launchpad) untuk membuka app Tangkapan 
Layar dan menampilkan layar.

2.	 Klik alat untuk digunakan untuk memilih apa yang ingin Anda ambil atau rekam.

Untuk sebagian layar, seret bingkai untuk memosisikannya ulang atau seret tepinya 
untuk menyesuaikan ukuran area yang ingin Anda ambil atau rekam.
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Tindakan Alat

Mengambil seluruh layar

Mengambil jendela

Mengambil sebagian layar

Merekam seluruh layar

Merekam sebagian layar

3.	 Pilih opsi yang Anda inginkan.

Pilihan yang tersedia beragam berdasarkan apakah Anda mengambil tangkapan layar 
atau rekaman layar. Misalnya, Anda dapat memilih untuk mengatur penundaan yang 
diberi waktu atau menampilkan penunjuk atau klik tetikus, dan menetapkan lokasi 
penyimpanan file.

Pilihan Tampilkan Gambar Mini yang Mengapung membantu Anda bekerja lebih mudah 
dengan jepretan atau rekaman penuh. Gambar mini mengapung di pojok kanan bawah 
layar selama beberapa detik sehingga Anda memiliki waktu untuk menyeretnya ke 
dokumen, memarkahinya, atau membagikannya sebelum disimpan ke lokasi yang Anda 
tetapkan.

4.	 Memulai tangkapan layar atau rekaman layar:

•	 Untuk seluruh atau sebagian layar: Klik Ambil.

•	 Untuk jendela: Pindahkan penunjuk ke jendela, lalu klik jendela.

•	 Untuk rekaman: Klik Rekam. Untuk berhenti merekam, klik  di bar menu.

Saat pilihan Tampilkan Gambar Mini yang Mengapung diatur, Anda dapat melakukan 
salah satu hal berikut saat gambar mini ditampilkan untuk sementara di pojok kanan 
bawah layar:

•	 Menggesek ke kanan untuk segera menyimpan file dan menghilangkannya.

•	 Menyeret gambar mini ke dokumen, email, catatan, atau jendela Finder.

•	 Mengeklik gambar mini untuk membuka jendela. Di sana, Anda dapat memarkahi 
tangkapan layar—atau memangkas rekaman—dan membagikan hasilnya.

Tergantung lokasi penyimpanan tangkapan layar atau rekaman pilihan Anda, app 
mungkin dibuka.



102Petunjuk Pengguna Keselamatan Pribadi

 Mengembalikan perangkat ke pengaturan pabrik
Jika Anda khawatir seseorang mungkin telah memiliki akses fisik ke perangkat Anda, 
merusak keamanan internalnya, dan menginstal perangkat lunak berbahaya seperti 
stalkerware, Anda dapat mengembalikan perangkat ke pengaturan pabriknya. Ini  
membantu memastikan bahwa perangkat Anda hanya dapat diakses oleh Anda.

PENTING:

•	 Mengatur ulang pabrik akan menghapus semua konten dan pengaturan. Sebelum 
memulihkan perangkat ke pengaturan pabrik, jalankan Kelola Berbagi &amp; Akses (opsi 
dua) pada Pemeriksaan Keselamatan. Masalah yang Anda khawatirkan mungkin terkait 
dengan pengaturan berbagi atau akses app yang tidak Anda sadari keberadaannya.

•	 Jika Anda menghapus semua konten dan pengaturan karena khawatir perangkat Anda 
telah dirusak dan terinstal perangkat lunak berbahaya, jangan pulihkan dari cadangan. 
Memulihkan dari cadangan dapat menginstal ulang perangkat lunak berbahaya yang 
ingin Anda hapus.

Pemulihan pabrik:

•	 Menghapus semua data yang disimpan di perangkat, termasuk data Face ID dan 
Touch ID, kode sandi dan kata sandi, pesan, email, foto, file, media, dan lainnya

•	 Menghapus semua app, termasuk yang diinstal tanpa sepengetahuan Anda

•	 Mengatur ulang pengaturan privasi Anda, sehingga Anda tidak berbagi lokasi dengan 
orang atau app mana pun

•	 Menginstal versi terbaru dari perangkat lunak sistem operasi (terlepas dari versi yang 
diinstal sebelumnya)

Persyaratan:

•	 Akses internet

•	 Kode sandi atau kata sandi perangkat

•	 Kata sandi Akun Apple

•	 Waktu
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Jika Anda ingin menggunakan Hapus Semua Konten dan Pengaturan di Mac Anda, Anda 
harus memiliki macOS 12.0.1 atau lebih baru. Selain itu, Anda dapat menghapus Mac Anda. 
Lihat artikel Dukungan Apple “Menggunakan Utilitas Disk untuk menghapus Mac dengan 
Apple silicon” (https://support.apple.com/102506) dan “Menggunakan Utilitas Disk untuk 
menghapus Mac berbasis Intel” (https://support.apple.com/102639).

  Untuk iPhone dan iPad

•	 “Mengembalikan iPhone atau iPad Anda ke pengaturan pabrik menggunakan komputer” 
(https://support.apple.com/108931) — artikel Dukungan Apple

https://support.apple.com/102506
https://support.apple.com/102506
https://support.apple.com/102639
https://support.apple.com/102639
https://support.apple.com/118107
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  Menghapus semua konten dan pengaturan di Mac

•	 Hapus Mac Anda (macOS 12.0.1 atau lebih baru)—Hapus konten, pengaturan, dan app 
apa pun yang Anda instal tanpa menginstal ulang macOS untuk mengembalikannya ke 
pengaturan pabrik.

•	 “Menghapus Mac Anda” untuk menghapus konten (app, data) dan pengaturan Anda 
(misalnya, sebelum Anda menjual, memperdagangkan, atau memberikannya)  
(https://support.apple.com/guide/mac-help/mchl7676b710).

•	 “Menghapus dan menginstal ulang macOS” untuk Mac dengan Apple silicon atau 
Mac berbasis Intel. (https://support.apple.com/guide/mac-help/mh27903)

•	 “Menggunakan Utilitas Disk untuk menghapus Mac dengan Apple silicon” — artikel 
Dukungan Apple (https://support.apple.com/102506)

•	 “Menggunakan Utilitas Disk untuk menghapus Mac berbasis Intel” — artikel Dukungan 
Apple (https://support.apple.com/102639)

 App dan fitur spesifik

 Melakukan panggilan darurat atau teks darurat di iPhone 
atau Apple Watch
Dalam kondisi darurat, Anda dapat menggunakan iPhone atau Apple Watch untuk meminta 
bantuan dengan cepat melalui panggilan atau teks.

Jika Anda memilih untuk membagikan ID Medis Anda, iPhone dapat mengirimkan informasi 
medis Anda ke layanan darurat saat Anda melakukan panggilan atau mengirimkan teks ke 
911 atau menggunakan Darurat SOS (hanya A.S.). Untuk mempelajari lebih lanjut mengenai 
ID Medis, lihat “Mengatur dan melihat ID Medis Anda” di Petunjuk Pengguna iPhone 
(https://support.apple.com/guide/iphone/iph08022b192/).

https://support.apple.com/guide/mac-help/mchl7676b710
https://support.apple.com/guide/mac-help/mh27903
https://support.apple.com/102506
https://support.apple.com/102639
https://support.apple.com/guide/iphone/iph08022b192/
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Catatan: Untuk bantuan darurat di beberapa area, Anda juga dapat mengirimkan pesan teks 
ke 911. Di tempat hal ini tidak tersedia, Anda mungkin menerima pesan “memantul” yang 
menandakan pesan teks tidak terkirim. Lihat artikel Dukungan Apple “Mengirim teks 911 di 
iPhone atau Apple Watch” (https://support.apple.com/101996).

Dengan Darurat SOS, Anda dapat meminta bantuan dan memperingatkan kontak darurat 
Anda dengan cepat dan mudah. Karena itu, penting untuk memastikan bahwa orang yang 
Anda tetapkan sebagai kontak darurat adalah orang yang Anda percayai.

  Mengubah pengaturan Darurat SOS Anda di iPhone

1.	 Buka Pengaturan  > Darurat SOS.

2.	 Lakukan salah satu hal berikut:

•	 Menyalakan atau mematikan Panggil dengan Tahan: Tekan dan tahan tombol samping 
dan volume untuk memulai hitungan mundur untuk memanggil layanan darurat.

•	 Menyalakan atau mematikan Panggil dengan 5 kali tekan: Tekan tombol samping lima 
kali dengan cepat untuk memulai hitungan mundur untuk memanggil layanan darurat.

•	 Mengelola kontak darurat Anda: Di Kesehatan, ketuk Atur Kontak Darurat atau Edit 
Kontak Darurat. Lihat “Mengatur dan melihat ID Medis Anda” di Petunjuk Pengguna 
iPhone (https://support.apple.com/guide/iphone/iph08022b192).

  Mengatur atau mengubah kontak darurat di iPhone

Kontak darurat dapat diatur agar jika Anda memanggil nomor darurat, iPhone mengirimi 
kontak tersebut pemberitahuan bahwa Anda telah memanggil bantuan, membagikan 
lokasi Anda dengan kontak tersebut, dan memberi tahu mereka jika lokasi Anda berubah. 
Jika Anda sebelumnya menambahkan seseorang sebagai kontak darurat dan ingin 
menghapusnya, Anda dapat melakukannya.

Untuk menambah atau menghapus kontak darurat:

1.	 Buka app Kesehatan , lalu ketuk gambar profil Anda.

2.	 Ketuk ID Medis.

3.	 Gulir ke Kontak Darurat, lalu ketuk Edit.

4.	 Tambahkan atau hapus kontak.

•	 Menambah kontak: Ketuk  untuk menambahkan kontak darurat (Anda tidak  
dapat mengatur layanan darurat sebagai kontak SOS).

•	 Menghapus kontak: Ketuk  di samping kontak yang ingin Anda hapus, lalu  
ketuk Hapus.

5.	 Ketuk Selesai untuk menyimpan perubahan Anda.

  Melakukan panggilan Darurat saat iPhone terkunci

1.	 Di layar Kode Sandi, ketuk Darurat.

2.	 Tekan nomor darurat (misalnya, 911 di A.S.), lalu ketuk .

https://support.apple.com/101996
https://support.apple.com/101996
https://support.apple.com/guide/iphone/iph08022b192
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﻿Menggunakan Darurat SOS dengan iPhone (semua negara atau wilayah  
kecuali India)

Dalam kondisi darurat, gunakan iPhone Anda untuk dengan cepat dan mudah memanggil 
bantuan serta memperingatkan kontak darurat Anda (jika layanan seluler tersedia). 
Setelah panggilan darurat berakhir, iPhone Anda akan memperingatkan kontak darurat 
Anda dengan pesan teks, kecuali jika Anda memilih untuk membatalkan. iPhone Anda 
mengirimkan lokasi Anda saat ini (jika tersedia) dan—untuk jangka waktu tertentu setelah 
Anda memasuki mode SOS—kontak darurat Anda menerima pembaruan saat lokasi Anda 
berubah.

Catatan: Jika Anda memiliki iPhone 14 atau lebih baru (model mana pun), Anda mungkin 
dapat menghubungi layanan darurat melalui satelit jika layanan sel tidak tersedia. Lihat 
“Menggunakan Darurat SOS melalui satelit di iPhone Anda” nanti di petunjuk ini.

•	 Tekan dan tahan tombol samping dan salah satu tombol volume secara bersamaan 
hingga penggeser muncul dan hitung mundur di Darurat SOS berakhir, lalu lepaskan 
tombol.

Atau Anda dapat mengaktifkan iPhone untuk memulai Darurat SOS saat Anda menekan 
tombol samping lima kali dengan cepat. Buka Pengaturan  > Darurat SOS, lalu 
nyalakan Panggil dengan 5 Kali Tekan.

  Menggunakan Darurat SOS iPhone (India)

•	 Tekan tombol samping tiga kali dengan cepat hingga penggeser muncul dan hitung 
mundur di Darurat SOS berakhir.

•	 Jika Anda telah menyalakan Pintasan Aksesibilitas, tekan dan tahan tombol samping 
dan salah satu tombol volume secara bersamaan hingga penggeser muncul dan hitung 
mundur di Darurat SOS berakhir, lalu lepaskan tombol.

Secara default, iPhone memutar bunyi peringatan, memulai hitungan mundur, lalu 
memanggil layanan darurat.

Setelah panggilan darurat berakhir, iPhone Anda akan memperingatkan kontak darurat 
Anda dengan pesan teks, kecuali jika Anda memilih untuk membatalkan. iPhone Anda 
mengirimkan lokasi Anda saat ini (jika tersedia) dan—untuk jangka waktu tertentu setelah 
Anda memasuki mode SOS—kontak darurat Anda menerima pembaruan saat lokasi Anda 
berubah.
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  Hubungi layanan darurat dengan Apple Watch

Lakukan salah satu hal berikut ini:

•	 Tekan dan tahan tombol samping hingga penggeser muncul, lalu seret penggeser 
Panggilan Darurat ke kanan.

Apple Watch Anda memanggil layanan darurat di wilayah Anda—misalnya, 911. (Di 
sebagian wilayah, Anda mungkin diharuskan untuk menekan nomor keypad untuk 
menyelesaikan panggilan.)

•	 Tekan dan terus tahan tombol samping hingga Apple Watch Anda mengeluarkan bunyi 
peringatan dan memulai hitung mundur. Saat hitungan mundur berakhir, Apple Watch 
menelepon layanan darurat. Apple Watch membuat bunyi peringatan bahkan saat dalam 
mode hening, sehingga jika Anda dalam situasi darurat dan Anda tidak ingin membuat 
keberisikan, gunakan penggeser Panggilan Darurat untuk memanggil layanan darurat 
tanpa hitung mundur.

Jika Anda tidak ingin Apple Watch Anda memulai hitung mundur darurat saat Anda 
menekan dan menahan tombol samping, matikan Panggilan Otomatis. Buka app 
Pengaturan di Apple Watch Anda, ketuk SOS, ketuk Tahan Tombol Samping, lalu matikan 
Tahan Tombol Samping. (Atau buka app Apple Watch di iPhone, ketuk Apple Watch 
Saya, ketuk Darurat SOS, lalu matikan Tahan Tombol Samping untuk Memanggil.) Anda 
masih dapat melakukan panggilan darurat dengan penggeser Panggilan Darurat.

•	 Ucapkan “Hey Siri, call 911.”

  Mengirimkan Teks ke Layanan Darurat dari iPhone Anda (tidak tersedia di semua 
negara atau wilayah)

1.	 Buka app Pesan , lalu ketik 911 atau nomor layanan darurat setempat Anda di  
bidang Ke.

2.	 Di bidang Pesan Teks, ketik situasi darurat Anda.

3.	 Ketuk .

Penting: Setelah Anda mengirimkan teks ke 911, iPhone Anda akan mengaktifkan mode 
darurat selama 30 menit. Untuk menonaktifkan mode darurat, mulai ulang iPhone Anda.

  Mengirimkan Teks ke Layanan Darurat dari Apple Watch Anda (tidak tersedia di 
semua negara atau wilayah)

1.	 Buka app Pesan , lalu pilih Pesan Baru.

2.	 Ketuk Tambah Kontak.

3.	 Ketuk , ketik 911, lalu ketuk OKE.

4.	 Ketuk Buat Pesan, lalu ketuk SMS.

5.	 Tulis pesan dengan jari Anda, ketuk  untuk mendiktekan pesan atau ketik pesan 
dengan papan ketik.

6.	 Ketuk Selesai, lalu ketuk Kirim.

Penting: Setelah Anda mengirimkan teks ke 911, Apple Watch Anda akan mengaktifkan 
mode darurat selama 30 menit. Untuk menonaktifkan mode darurat, mulai ulang 
Apple Watch Anda.
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  Menggunakan Darurat SOS melalui satelit di iPhone Anda

Di iPhone 14 dan lebih baru (model mana pun) dengan iOS 16.1 atau lebih baru, Anda dapat 
menggunakan Darurat SOS melalui satelit untuk mengirim layanan darurat pesan teks 
saat Anda berada di luar jangkauan seluler dan Wi-Fi. Untuk mempelajari lebih lanjut, lihat 
artikel Dukungan Apple “Menggunakan Darurat SOS melalui satelit di iPhone Anda”  
(https://support.apple.com/101573).

Anda juga dapat menggunakan app Lacak untuk berbagi lokasi Anda dengan orang-orang 
melalui satelit. Lihat “Mengirim lokasi Anda melalui satelit di Lacak di iPhone” di Petunjuk 
Pengguna iPhone (https://support.apple.com/guide/iphone/iph2aac8ae20).

Untuk informasi lebih lanjut, lihat Informasi penting mengenai panggilan darurat di iPhone 
di Petunjuk Pengguna iPhone.

  Membagikan video langsung atau foto yang ada dengan layanan darurat (tidak 
tersedia di semua negara atau wilayah)

Jika diminta oleh layanan darurat, Video Langsung Darurat SOS memungkinkan Anda 
melakukan streaming video langsung atau mengunggah foto dan video yang ada.

Catatan: Layanan darurat dapat menyimpan salinan video langsung yang Anda streaming 
dan menyimpan video atau foto yang Anda bagikan.

Jika Anda mendapat permintaan untuk berbagi video atau foto saat melakukan panggilan 
layanan darurat, lakukan salah satu hal berikut:

•	 Membagikan video langsung: Ketuk Bagikan saat diminta untuk mulai streaming video 
langsung ke layanan darurat. Anda dapat menjeda atau memulai kembali berbagi kapan 
saja dengan mengetuk tombol Kamera. Anda dapat berhenti berbagi kapan saja dengan 
mengetuk , lalu ketuk Berhenti Berbagi Kamera atau Akhiri Panggilan.

Catatan: Video langsung tidak disimpan ke perangkat Anda, tapi dapat disimpan oleh 
layanan darurat.

•	 Membagikan foto atau video yang ada: Ketuk Pilih saat diminta, lalu pilih foto atau video 
yang ingin Anda kirim ke layanan darurat.

•	 Menolak: Ketuk Nanti saat diminta jika Anda tidak ingin berbagi video atau foto dengan 
layanan darurat.

Catatan: Video Langsung Darurat SOS tersedia di iPhone 14 atau lebih baru, tergantung 
pada keterbatasan perangkat, dan mungkin tidak tersedia dalam semua situasi.

https://support.apple.com/101573
https://support.apple.com/guide/iphone/iph2aac8ae20
https://support.apple.com/guide/iphone/iph3c99374c#iphbf048c884
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 Mengelola Berbagi Layar dan Kontrol Layar di FaceTime
Selama panggilan video atau audio FaceTime satu lawan satu, Anda dapat berbagi layar 
dengan orang lain, atau mereka dapat meminta untuk melihat layar Anda. Setelah Anda 
membagikan layar, mereka dapat meminta atau Anda dapat mengizinkan mereka untuk 
mengontrol layar Anda dari jarak jauh.

  Bagaimana cara mengetahui apakah berbagi layar atau kontrol layar menyala?

•	 Berbagi layar: Di iPhone atau iPad,  muncul di bagian atas layar. Anda juga dapat 
mengetuk layar untuk menampilkan kontrol FaceTime, lalu mencentang “Melihat Layar 
Saya” di bawah nama atau informasi kontak seseorang.

Di Mac,  muncul di bar menu.

•	 Kontrol layar: Di iPhone atau iPad, “Kontrol Jarak Jauh Aktif” muncul di bagian bawah layar.

Di Mac,  muncul di bar menu.

  Apa yang dapat dilakukan orang lain saat berbagi layar?

Orang yang Anda ajak berbagi layar dapat:

•	 Melihat sebagian besar konten di layar Anda.

•	 Mengetuk, menggambar, atau menulis di layar Anda (lingkaran, gambar, atau tulisan 
menghilang setelah beberapa detik).

•	 Meminta kontrol jarak jauh atas perangkat Anda (Anda dapat menerima atau menolak).

Orang yang Anda ajak berbagi layar tidak dapat:

•	 Melihat pemberitahuan apa pun yang Anda terima.

•	 Melihat keypad saat Anda memasukkan kode sandi. (Secara default, kode sandi dan 
kata sandi muncul sebagai titik.)

•	 Melihat konten yang memerlukan langganan, uji coba gratis, atau pembelian atau 
penyewaan untuk melihatnya.
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  Apa yang dapat dilakukan orang lain selama kontrol layar?

Orang yang mengontrol layar Anda dari jarak jauh dapat:

•	 Membuka dan menutup app, jendela, atau file.

•	 Mengubah pengaturan.

•	 Menghapus item.

•	 Mengirim pesan.

•	 Mematikan perangkat Anda atau memulai ulang Mac Anda (ini mengakhiri panggilan 
FaceTime dan kontrol layar).

Orang yang mengontrol layar Anda dari jarak jauh tidak dapat:

•	 Mengubah pengaturan Akun Apple atau Face ID Anda.

•	 Menggunakan Apple Pay. (Mereka mungkin dapat melakukan pembayaran dengan app 
pihak ketiga; lihat Pengantar app pihak ketiga.)

•	 Menghapus perangkat Anda.

Face ID Anda dinonaktifkan selama sesi kontrol jarak jauh. Anda masih dapat menavigasi 
perangkat Anda selagi layar dikontrol dari jarak jauh—tindakan Anda diprioritaskan daripada 
tindakan jarak jauh.

  Berhenti berbagi layar

•	 iPhone atau iPad: Ketuk .

•	 Mac: Klik  di bar menu, lalu klik Berhenti Berbagi.

Mengakhiri panggilan FaceTime juga mengakhiri berbagi layar.

  Menolak permintaan kontrol jarak jauh

Jika Anda menerima permintaan kontrol jarak jauh yang ingin Anda tolak, ketuk atau klik 
Jangan Izinkan. Berbagi layar dilanjutkan. Orang lain tidak menerima pemberitahuan bahwa 
Anda menolaknya.

  Menghentikan kontrol jarak jauh

•	 iPhone atau iPad: Ketuk Berhenti di bagian bawah jendela berbagi layar.

•	 Mac: Klik  di bar menu, lalu klik Izinkan Kontrol. (Tombol diredupkan.)

Mengakhiri panggilan FaceTime juga mengakhiri kontrol jarak jauh.
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 Mengelola berbagi Aktivitas di Apple Watch
Jika Anda memiliki Apple Watch dan sebelumnya telah berbagi cincin Aktivitas dengan 
seseorang, mereka dapat melihat informasi mengenai level aktivitas dan olahraga Anda. Ini 
tidak memberi mereka info mengenai lokasi Anda.

  Menggunakan Apple Watch Anda untuk berhenti berbagi

Anda dapat menyembunyikan kemajuan Anda, atau berhenti membagikan aktivitas Anda 
dengan orang tertentu sepenuhnya, dari tab Berbagi di app Aktivitas.

Untuk berhenti berbagi cincin Aktivitas dengan seseorang yang menggunakan  
Apple Watch Anda.

1.	 Buka app Aktivitas  di Apple Watch Anda.

2.	 Gesek ke kiri, lalu putar Digital Crown untuk menggulir ke bagian bawah layar.

3.	 Untuk menghapus seseorang yang Anda ajak berbagi, ketuk namanya, lalu ketuk Hapus.

Untuk mempelajari lebih lanjut, lihat:

•	 “Membagikan aktivitas Anda dari Apple Watch” di Petunjuk Pengguna Apple Watch

(https://support.apple.com/guide/watch/apd68a69f5c7)

https://support.apple.com/guide/watch/apd68a69f5c7
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  Menggunakan iPhone Anda untuk berhenti berbagi

Anda dapat berhenti berbagi cincin Aktivitas dengan seseorang menggunakan iPhone Anda.

1.	 Buka app Kebugaran  di iPhone Anda, lalu ketuk Berbagi.

2.	 Ketuk orang yang Anda ajak berbagi.

3.	 Ketuk tombol Bagikan di pojok kanan atas layar.

4.	 Ketuk Hapus Teman atau Sembunyikan Aktivitas saya.

Untuk mempelajari lebih lanjut, lihat:

•	 “Membagikan aktivitas Anda dari Apple Watch” di Petunjuk Pengguna Apple Watch

(https://support.apple.com/guide/watch/apd68a69f5c7)

 Mengamankan AirDrop

 Apa itu AirDrop?
AirDrop  adalah cara yang mudah untuk berbagi gambar, dokumen, atau file lainnya di 
antara perangkat Apple yang berada di dekat satu sama lain. Anda dapat mengaktifkan 
perangkat Anda untuk berbagi dengan semua orang di sekitar Anda, membatasi berbagi 
hanya ke kontak Anda, atau tidak berbagi dengan siapa pun.

https://support.apple.com/guide/watch/apd68a69f5c7
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Catatan: Pilihan Hanya Kontak tersedia di perangkat dengan iOS 10, iPadOS 13.1, dan 
macOS 10.12, atau lebih baru. Jika perangkat Anda menggunakan versi perangkat lunak 
yang lebih lama dan Anda ingin membatasi siapa yang dapat mengirimi Anda file melalui 
AirDrop, Anda dapat menyalakannya saat diperlukan lalu menonaktifkannya saat tidak 
digunakan.

  iPhone atau iPad

•	 Di iPhone atau iPad, buka Pengaturan  > Umum, ketuk AirDrop, lalu pilih opsi yang 
paling sesuai untuk Anda.

Untuk mempelajari lebih lanjut, lihat:

•	 “Menggunakan AirDrop di iPhone untuk mengirimkan item ke perangkat di sekitar” di 
Petunjuk Pengguna iPhone

(https://support.apple.com/guide/iphone/iphcd8b9f0af)

•	 “Menggunakan AirDrop di iPad untuk mengirim item ke perangkat Apple di sekitar” di 
Petunjuk Pengguna iPad

(https://support.apple.com/guide/ipad/ipad46a13d74)

https://support.apple.com/guide/iphone/iphcd8b9f0af
https://support.apple.com/guide/ipad/ipad46a13d74/
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  Di Mac menggunakan Finder

1.	 Klik ikon Finder  di Dock untuk membuka jendela Finder.

2.	 Di bar samping Finder, klik AirDrop.

3.	 Di jendela AirDrop, klik menu pop-up “Izinkan saya ditemukan oleh”, lalu pilih opsi yang 
terbaik bagi Anda.

Untuk mempelajari lebih lanjut, lihat:

•	 Menggunakan AirDrop di Mac Anda untuk mengirim item ke perangkat Apple di 
sekitar di Petunjuk Pengguna Mac

(https://support.apple.com/guide/mac-help/mh35868)

  Di Mac menggunakan Pusat Kontrol

1.	 Di Mac, klik  di bar menu, lalu klik . Jika warnanya biru, berarti nyala.

2.	 Klik  di samping AirDrop, lalu pilih opsi yang paling sesuai untuk Anda.

Untuk mempelajari lebih lanjut, lihat:

•	 Menggunakan AirDrop di Mac Anda untuk mengirim item ke perangkat Apple di 
sekitar di Petunjuk Pengguna Mac

(https://support.apple.com/guide/mac-help/mh35868)

https://www.dolby.com/us/en/technologies/dolby-vision/dolby-vision-for-creative-professionals.html
https://www.dolby.com/us/en/technologies/dolby-vision/dolby-vision-for-creative-professionals.html
https://support.apple.com/guide/mac-help/mh35868
https://support.apple.com/guide/mac-help/mh35868
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 Mengelola pengaturan berbagi Kalender di perangkat Apple
Jika sebelumnya Anda mengundang seseorang untuk berbagi kalender, Anda dapat 
mengelola kemampuan orang tersebut untuk mengedit kalender, atau Anda dapat berhenti 
berbagi kalender dengan orang tersebut.

PENTING: Saat Anda menghapus atau berhenti berbagi kalender, peserta lain mungkin 
diberi tahu mengenai perubahan tersebut.

  Mengelola pengaturan berbagi kalender di iPhone atau iPad

1.	 Ketuk Kalender  di iPhone atau iPad Anda, lalu ketuk  di samping kalender bersama 
yang ingin Anda edit.

2.	 Ketuk seseorang, lalu lakukan salah satu hal berikut:

•	 Nyalakan atau matikan Izinkan Pengeditan.

•	 Ketuk Berhenti Berbagi.

  Menghapus kalender di Mac

Beberapa kalender tidak dapat dihapus.

•	 Anda tidak dapat menghapus kalender yang didelegasikan, tetapi Anda dapat berhenti 
menampilkannya di jendela Kalender utama. Lihat Membatalkan publikasi kalender di Mac.

•	 Jika Anda tidak dapat menghapus kalender untuk akun kalender tertentu, coba hapus 
kalender di situs web penyedia akun. Misalnya, untuk menghapus kalender Google, buka 
google.com.

•	 Jika akun kalender hanya memiliki satu kalender (tidak termasuk kalender orang lain 
yang Anda bagikan), Anda tidak dapat menghapus kalender terakhir tersebut.

1.	 Buka app Kalender  di Mac Anda, lalu klik nama kalender di daftar kalender.

Jika Anda tidak melihat daftar kalender di sebelah kiri, pilih Lihat > Tampilkan Daftar 
Kalender.

2.	 Pilih Edit > Hapus.

Untuk mempelajari lebih lanjut, lihat:

•	 “Menambahkan atau menghapus kalender di Mac” di Petunjuk Pengguna Kalender

(https://support.apple.com/guide/calendar/icl1005)

http://images.apple.com/final-cut-pro/docs/iTunes_Store_Package.pdf
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  Berhenti berlangganan kalender di Mac

Jika Anda ingin berhenti berlangganan kalender orang lain, Anda dapat berhenti 
berlangganan.

•	 Buka app Kalender  di Mac Anda, control-klik kalender di daftar kalender, lalu pilih 
Berhenti Berlangganan.

Jika Anda tidak melihat daftar kalender di sebelah kiri, pilih Lihat > Tampilkan Daftar 
Kalender.

Catatan: Saat berhenti berlangganan kalender, Anda juga dapat melaporkannya sebagai 
junk. Melaporkan junk membantu Kalender mengidentifikasi langganan junk dengan 
lebih baik.

Untuk mempelajari lebih lanjut, lihat:

•	 “Berlangganan kalender di Mac” di Petunjuk Pengguna Kalender

(https://support.apple.com/guide/calendar/icl1022)

  Membatalkan publikasi kalender di Mac

Jika daftar kalender Anda memiliki bagian Di Mac Saya, Anda dapat menerbitkan 
kalender di bagian tersebut di server WebDAV yang dapat Anda akses. Orang lain dapat 
berlangganan kalender yang Anda terbitkan atau melihatnya di browser web. Anda dapat 
berhenti menerbitkan kalender kapan saja tanpa menghapusnya dari Mac Anda.

Catatan: Kalender yang tidak dipublikasikan tidak dihapus dari Mac Anda.

1.	 Buka app Kalender  di Mac Anda, lalu klik nama kalender atau grup kalender di daftar 
kalender.

Jika Anda tidak melihat daftar kalender di sebelah kiri, pilih Lihat > Tampilkan Daftar 
Kalender. Kalender yang dipublikasikan memiliki  di samping namanya.

2.	 Pilih Edit > Hentikan Publikasi.

Setelah Anda membatalkan publikasi kalender, pengguna baru tidak dapat berlangganan 
kalender tersebut. Pengguna yang sudah berlangganan akan melihat salinan terakhir 
yang dipublikasikan hingga mereka menghapusnya.

Untuk mempelajari lebih lanjut, lihat:

•	 “Menerbitkan atau membatalkan penerbitan kalender di Mac” di Petunjuk Pengguna 
Kalender

(https://support.apple.com/guide/calendar/icl1017)

https://support.apple.com/guide/calendar/icl1022
https://support.apple.com/guide/calendar/icl1017
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  Berhenti berbagi kalender iCloud di Mac

Jika Anda mengatur iCloud di Mac Anda, Anda dapat menggunakan Kalender untuk 
mengelola kalender iCloud bersama Anda. Jika Anda berbagi kalender iCloud atau 
bergabung dengan kalender iCloud bersama milik orang lain, Anda mungkin menerima 
email setiap kali kalender bersama tersebut diperbarui. Anda dapat berhenti menerima 
email ini dengan mengubah pengaturan di pengaturan Kalender di iCloud.com.

Jika Anda menerima undangan untuk bergabung dengan kalender bersama iCloud, Anda 
dapat menerima undangan tersebut di iPhone, iPad, atau Mac tempat Anda masuk ke 
Akun Apple yang sama, atau di Kalender iCloud, atau di iCloud.com.

1.	 Buka app Kalender  di Mac Anda.

Jika Anda tidak melihat daftar kalender di sebelah kiri, pilih Lihat > Tampilkan Daftar 
Kalender.

2.	 Lakukan salah satu hal berikut:

•	 Berhenti berbagi kalender Anda dengan orang tertentu: Tempatkan penunjuk di atas 
nama kalender di daftar kalender, lalu klik . Klik nama seseorang, lalu tekan Hapus.

•	 Berhenti berbagi kalender Anda dengan semua orang: Control-klik kalender di daftar 
kalender, lalu pilih Berhenti Berbagi.

•	 Berhenti berlangganan kalender orang lain: Control-klik kalender di daftar kalender, 
lalu pilih Berhenti Berlangganan.

Saat berhenti berlangganan kalender, Anda juga dapat melaporkannya sebagai junk. 
Melaporkan junk membantu Kalender mengidentifikasi langganan junk dengan lebih 
baik.

Untuk mempelajari lebih lanjut, lihat:

•	 “Menerima pembaruan kalender di iCloud.com” di Petunjuk Pengguna Kalender

(https://support.apple.com/guide/icloud/mm8074582205)

https://support.apple.com/guide/mac-help/mh36834
https://support.apple.com/guide/icloud/mm8074582205
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 Meninggalkan atau menghapus anggota dari grup Keluarga 
Berbagi
Keluarga Berbagi dapat digunakan oleh maksimum lima anggota keluarga untuk berbagi 
langganan, pembelian, foto, album foto, kalender, dan lainnya, tanpa perlu berbagi 
Akun Apple satu sama lain. Jika Anda berbagi paket penyimpanan iCloud, file dan dokumen 
masing-masing orang tetap pribadi, sedangkan jumlah ruang penyimpanan yang digunakan 
masing-masing orang terlihat ke semua anggota.

Untuk melihat apakah Anda bagian dari grup Keluarga Berbagi, buka Pengaturan  > [nama 
Anda] > Keluarga. Jika Anda melihat Atur Keluarga Berbagi, Anda tidak menggunakan 
Keluarga Berbagi dengan Akun Apple ini. Jika Anda melihat ikon dengan Keluarga Berbagi, 
Anda dapat mengetuk ikon untuk melihat anggota keluarga dan peran.

 Siapa yang dapat meninggalkan grup Keluarga Berbagi?
Kemampuan untuk mengubah atau meninggalkan grup Keluarga Berbagi berbeda-beda.

•	 Pengelola dapat meninggalkan grup Keluarga Berbagi dengan mematikan Keluarga 
Berbagi. Saat Keluarga Berbagi dimatikan, semua anggota keluarga dihapus dari grup 
keluarga sekaligus. Jika terdapat anak berumur 13 tahun ke bawah di grup keluarga, 
pengelola harus memindahkan mereka ke grup Keluarga Berbagi lainnya. Anggota 
keluarga tidak dapat lagi berbagi akses ke langganan, pembelian, dan layanan lain yang 
diaktifkan melalui Berbagi Keluarga.

•	 Setiap anggota keluarga yang berumur 13 tahun ke atas dapat menghapus dirinya 
sendiri dari grup keluarga kapan pun. Cukup pilih nama Anda lalu pilih Tinggalkan 
Keluarga. Anda juga dapat masuk ke situs web Akun Apple dan memilih Hapus Akun di 
bagian Keluarga Berbagi.

•	 Demi alasan keamanan, akun anak (di bawah 13 tahun) tidak dapat dihapus dari keluarga 
dan tidak dapat berhenti berbagi detail seperti Durasi Layar tanpa kode sandi Durasi 
Layar. Pengelola memiliki akses ke konten keluarga bersama di perangkat Anda, seperti 
album foto bersama serta kalender bersama, dan dapat melihat aktivitas Durasi Layar.
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 Jenis anggota Keluarga Berbagi
Anggota grup Keluarga Berbagi dapat memiliki peran berbeda tergantung umurnya.

Catatan: Umur seseorang yang dianggap dewasa atau anak berbeda menurut negara atau 
wilayah.

Untuk mengubah status Keluarga Berbagi Anda, ada baiknya untuk mengetahui fungsi 
berbagai peran dalam grup Keluarga Berbagi.

•	 Pengelola: Orang dewasa yang mengatur grup Keluarga Berbagi. Pengelola dapat 
mengundang anggota keluarga, menghapus anggota keluarga, dan membubarkan grup.

•	 Orang Dewasa: Anggota grup Keluarga Berbagi yang berumur 18 tahun ke atas.

•	 Orang Tua/Wali: Anggota orang dewasa grup Keluarga Berbagi yang dapat membantu 
mengelola pengawasan orang tua untuk anak di grup. Saat pengelola menambahkan 
orang dewasa ke grup Keluarga Berbagi, mereka dapat menetapkannya sebagai orang 
tua atau wali jika ada anggota anak-anak atau remaja dalam grup tersebut.

•	 Anak atau remaja: Anggota grup Keluarga Berbagi yang berumur 18 tahun ke bawah. 
Pengelola, orang tua, atau wali dapat membuat Akun Apple untuk anak yang terlalu 
muda untuk membuatnya sendiri.

Di rumah Anda satu orang dewasa, pengelola keluarga, memilih fitur yang dibagikan 
oleh keluarga dan mengundang hingga lima anggota lainnya untuk bergabung. Setelah 
undangan diterima, Keluarga Berbagi diatur di perangkat semua orang secara otomatis—
termasuk kalender bersama dan album foto bersama. Pengelola keluarga dapat 
menambahkan siapa pun yang memiliki Akun Apple ke keluarganya dan menghapus 
seseorang yang berumur 13 tahun ke atas dari grup keluarga.
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 Apa yang terjadi ketika Anda meninggalkan grup Keluarga Berbagi
Jika anggota dihapus atau meninggalkan grup Keluarga Berbagi, mereka menyimpan 
pembelian yang dibayar menggunakan kartu kredit bersama tapi mereka segera kehilangan 
akses ke hal lain yang dibagikan oleh anggota keluarga:

•	 Lokasi perangkat anggota keluarga sebelumnya tidak muncul di app Lacak di iCloud.
com atau di Mac, iPhone, atau iPad.

•	 Item anggota keluarga sebelumnya tidak lagi muncul di bagian Dibeli pada iTunes Store, 
App Store, dan Apple Books.

•	 Musik, film, acara TV, buku, dan app yang diunduh sebelumnya tidak lagi dapat 
digunakan jika orang lain yang pada awalnya membelinya. Anggota keluarga sebelumnya 
tidak lagi dapat menggunakan konten yang diunduh dari koleksi Anda.

•	 Pembelian in-app menjadi tidak tersedia jika dibeli menggunakan app yang pada 
awalnya dibeli orang lain. Anda dapat mendapatkan kembali akses ke pembelian in-app 
dengan membeli app.

  Meninggalkan grup Keluarga Berbagi di iPhone atau iPad Anda dengan iOS 18, 
iPadOS 18, atau lebih baru

Jika Anda berumur 13 tahun ke atas dan merupakan anggota grup Keluarga Berbagi:

1.	 Buka Pengaturan  > Keluarga (di bawah nama Anda).

2.	 Ketuk nama Anda, lalu ketuk Berhenti Menggunakan Keluarga Berbagi.

  Meninggalkan grup Keluarga Berbagi di iPhone atau iPad Anda dengan iOS 17, 
iPadOS 17, atau lebih lama

Jika Anda berumur 13 tahun ke atas dan merupakan anggota grup Keluarga Berbagi:

1.	 Buka Pengaturan  > [nama Anda] > Keluarga Berbagi.

2.	 Ketuk nama Anda, lalu ketuk Berhenti Menggunakan Keluarga Berbagi.

  Meninggalkan grup Keluarga Berbagi di Mac Anda

Jika Anda berumur 13 tahun ke atas dan merupakan anggota grup keluarga berbagi:

1.	 Lakukan salah satu hal berikut ini:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, lalu klik Keluarga di bar samping (di bawah nama Anda).

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi 
Sistem, klik Keluarga Berbagi , lalu klik Keluarga Berbagi.

2.	 Di daftar anggota keluarga, klik nama Anda atau Detail di samping nama Anda, klik 
Berhenti Menggunakan Keluarga Berbagi, lalu ikuti instruksi pada layar.

3.	 Klik Selesai.
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  Mematikan Keluarga Berbagi di iPhone atau iPad Anda dengan iOS 18, iPadOS 18, 
atau lebih baru

Jika Anda adalah pengelola keluarga:

1.	 Buka Pengaturan  > Keluarga (di bawah nama Anda).

2.	 Ketuk nama Anda, lalu ketuk Berhenti Menggunakan Keluarga Berbagi.

  Mematikan Keluarga Berbagi di iPhone atau iPad Anda dengan iOS 17, iPadOS 17, 
atau lebih lama

Jika Anda adalah pengelola keluarga:

1.	 Buka Pengaturan  > [nama Anda] > Keluarga Berbagi.

2.	 Ketuk nama Anda, lalu ketuk Berhenti Menggunakan Keluarga Berbagi.

  Mematikan Keluarga Berbagi di Mac Anda

Jika Anda adalah pengelola keluarga:

1.	 Lakukan salah satu hal berikut ini:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, lalu klik Keluarga di bar samping (di bawah nama Anda).

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi 
Sistem, klik Keluarga Berbagi , lalu klik Keluarga Berbagi.

2.	 Klik  di samping nama Anda, lalu klik Hentikan Keluarga Berbagi.

  Menghapus anggota dari grup Keluarga Berbagi di iPhone atau iPad Anda dengan 
iOS 18, iPadOS 18, atau lebih baru

Jika Anda adalah pengelola keluarga:

1.	 Buka Pengaturan  > Keluarga (di bawah nama Anda).

2.	 Ketuk [nama anggota], ketuk Hapus [nama anggota] dari Keluarga, lalu ketuk Hapus 
[nama anggota] lagi.

Catatan: Jika Anda adalah pengelola keluarga, Anda tidak dapat menghapus diri Anda dari 
grup Keluarga Berbagi.

  Menghapus anggota dari grup Keluarga Berbagi di iPhone atau iPad Anda dengan 
iOS 17, iPadOS 17, atau lebih lama

Jika Anda adalah pengelola keluarga:

1.	 Buka Pengaturan  > [nama Anda] > Keluarga Berbagi.

2.	 Ketuk [nama anggota], lalu ketuk Hapus [nama anggota] dari Keluarga.

Catatan: Jika Anda adalah pengelola keluarga, Anda tidak dapat menghapus diri Anda dari 
grup Keluarga Berbagi.
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  Menghapus anggota dari grup Keluarga Berbagi di Mac Anda

Jika Anda adalah pengelola keluarga:

1.	 Membuka Grup Keluarga Berbagi:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, lalu klik Keluarga di bar samping (di bawah nama Anda).

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi 
Sistem, klik Keluarga Berbagi , lalu klik Keluarga Berbagi.

2.	 Memilih dan menghapus anggota:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih anggota dalam daftar, klik 
Hapus [nama anggota] dari Grup Berbagi, lalu klik Hapus [nama anggota] lagi.

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih anggota dalam daftar, klik , 
lalu klik untuk mengonfirmasi bahwa Anda ingin menghapus mereka.

 Menyimpan data Anda dengan aman di iCloud
iCloud menyimpan foto, video, dokumen, musik, app, cadangan perangkat, dan lainnya 
dengan aman—serta menjaganya agar tetap terbaru di semua perangkat Anda. iCloud 
juga memungkinkan Anda untuk berbagi foto, kalender, lokasi, dan lainnya dengan teman 
dan keluarga. Anda dapat masuk ke iCloud di perangkat Anda atau melalui web dengan 
Akun Apple Anda.

Lihat Petunjuk Pengguna iCloud untuk detail informasi lainnya mengenai apa yang disimpan 
di iCloud (https://support.apple.com/guide/icloud/).

https://www.dolby.com/us/en/technologies/dolby-vision/dolby-vision-for-creative-professionals.html
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 Pilihan keamanan iCloud
Apple menawarkan dua pilihan kepada pengguna untuk mengenkripsi dan melindungi data 
yang disimpan di iCloud:

•	 Perlindungan data standar (pengaturan default): Data iCloud Anda dienkripsi, kunci 
enkripsi diamankan di pusat data Apple, dan Apple dapat membantu Anda dengan 
pemulihan data dan akun. Hanya data iCloud tertentu—14 kategori data, termasuk data 
Kesehatan dan kata sandi di Rantai Kunci iCloud—yang dienkripsi secara menyeluruh.

•	 Perlindungan Data Lanjutan untuk iCloud: Pengaturan opsional yang menawari Anda 
tingkat keamanan data cloud tertinggi Apple. Jika Anda memilih untuk menyalakan 
Perlindungan Data Lanjutan, perangkat tepercaya Anda mempertahankan akses tunggal 
ke kunci enkripsi untuk sebagian besar data iCloud Anda, melindunginya menggunakan 
enkripsi secara menyeluruh. Dan dengan Perlindungan Data Lanjutan, jumlah kategori 
data yang menggunakan enkripsi secara menyeluruh naik menjadi 23 dan menyertakan 
Cadangan iCloud, Foto, Catatan, dan lainnya.

Untuk informasi lebih lanjut, lihat artikel Dukungan Apple “Cara menyalakan Perlindungan 
Data Lanjutan untuk iCloud” (https://support.apple.com/108756) dan “Tinjauan keamanan 
data iCloud,” tabel mengenai kategori dan enkripsi Data (https://support.apple.com/102651).

  Melihat dan mengubah pengaturan iCloud

Anda dapat melihat dan mengubah pengaturan iCloud Anda di setiap perangkat, termasuk 
app mana (Apple dan pihak ketiga) yang menggunakan iCloud, cadangan iCloud, dan 
lainnya:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > [nama Anda] > iCloud.

Jika fitur ini dinonaktifkan, Anda tidak dapat menggunakannya jika perangkat Anda 
hilang atau dicuri dan dimatikan.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik nama Anda di bagian atas 
bar samping, lalu klik iCloud.

  Keluar dari iCloud

Anda juga dapat keluar dari iCloud sepenuhnya di perangkat. Jika Anda keluar, iCloud tidak 
lagi mencadangkan informasi di perangkat tersebut.

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > [nama Anda], gulir ke bawah, lalu  
ketuk Keluar.

•	 Di Mac Anda: Pilih menu Apple  > Pengaturan Sistem, klik nama Anda di bagian atas 
bar samping, gulir ke bawah, lalu klik Keluar.

 Mengelola pengaturan keamanan di Pesan
Di app Pesan , Anda dapat mengirim pesan teks dengan dua cara berbeda:

•	 Melalui Wi-Fi atau layanan seluler, menggunakan iMessage dengan orang lain yang 
juga menggunakan iMessage di iPhone, iPad, atau Mac. Teks iMessage Anda muncul di 
gelembung biru.

•	 Dengan pesan SMS/MMS yang diteruskan dari iPhone Anda ke perangkat lainnya. Pesan 
SMS/MMS Anda muncul di gelembung hijau.

https://support.apple.com/108756
https://support.apple.com/108756
https://support.apple.com/102651
https://support.apple.com/102651
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Anda dapat menggunakan iMessage untuk mengirim pesan, foto, atau video ke iPhone, 
iPad, atau Mac lain melalui Wi-Fi atau jaringan seluler. Pesan ini selalu dienkripsi dan 
muncul dalam gelembung teks biru di iPhone, iPad, dan Mac Anda.

  Membatasi Pesan ke satu perangkat

Jika Anda ingin membatasi Pesan ke satu perangkat, Anda harus keluar dari akun Pesan di 
perangkat yang tidak lagi ingin Anda gunakan untuk menerima pesan, dan matikan Pesan  
di iCloud.

Lakukan salah satu hal berikut ini:

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Pesan, lalu nyalakan atau matikan 
iMessage.

•	 Di Mac Anda: Buka Pesan , pilih Pesan > Pengaturan, klik iMessage, lalu klik “Keluar”. 
Konfirmasi bahwa Anda ingin keluar, lalu klik “Keluar” lagi.

  Mematikan Pesan di iCloud dari iPhone atau iPad

Saat Anda menggunakan Pesan di iCloud, semua pesan yang Anda kirim, terima, dan hapus 
diperbarui di semua perangkat Apple Anda secara otomatis.

1.	 Buka Pengaturan  > [nama Anda], lalu ketuk iCloud.

2.	 Di bawah App yang menggunakan iCloud, ketuk Tampilkan Semua.

3.	 Ketuk Pesan, lalu matikan Selaraskan [perangkat] ini.

4.	 Ulangi tugas ini di masing-masing perangkat untuk menghapus pesan dari iCloud.
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  Mematikan Pesan di iCloud dari Mac

Saat Anda menggunakan Pesan di iCloud, semua pesan yang Anda kirim, terima, dan hapus 
diperbarui di semua perangkat Apple Anda secara otomatis.

1.	 Buka Pesan  di Mac Anda, pilih Pesan > Pengaturan, lalu klik iMessage.

2.	 Klik Pengaturan, lalu batal pilih Aktifkan Pesan di iCloud.

3.	 Pilih salah satu hal berikut ini:

•	 Nonaktifkan Semua: Mematikan Pesan di iCloud di semua perangkat Anda. Pesan 
tidak lagi disimpan di iCloud dan sebagai gantinya disimpan di masing-masing 
perangkat.

•	 Nonaktifkan Perangkat Ini: Mematikan Pesan di iCloud hanya di Mac Anda. Pesan di 
Mac Anda tidak lagi disimpan di iCloud; di perangkat lain yang menyalakan Pesan di 
iCloud, pesan terus disimpan di iCloud.

  Menyalakan dan mematikan iMessage

iMessage menggunakan enkripsi menyeluruh, melindungi pesan Anda di semua perangkat 
Anda sehingga tidak dapat diakses tanpa kode sandi Anda oleh siapa pun, termasuk Apple. 
Karena percakapan iMessage berlangsung melalui Wi-Fi dan jaringan seluler, informasi 
yang terkait dengan orang yang Anda kirimi pesan tidak muncul di tagihan telepon Anda. 
iMessage dapat dicadangkan, sehingga jika perangkat Anda hilang atau dicuri, Anda masih 
dapat menampilkan kembali topik pesan penting.

Penting: Agar Pesan disimpan ke iCloud, Anda harus mengaktifkan cadangan. Jika 
belum, pesan Anda tidak akan dipulihkan. Lihat Mengatur iCloud untuk Pesan di semua 
perangkat Anda di Petunjuk Pengguna iCloud (https://support.apple.com/guide/icloud/
mm0de0d4528d).

 Saat iMessage menyala

Anda dapat mengirim iMessage menggunakan koneksi Wi-Fi saat Anda tidak memiliki akses 
ke layanan seluler. Fitur Baru Dihapus menyimpan pesan yang dihapus hingga 30 hari, jadi 
jika Anda khawatir seseorang mungkin telah menghapus pesan dari perangkat Anda, pesan 
tersebut mungkin masih ada di tab ini.

 Saat iMessage mati

Saat iMessage dimatikan, fitur seperti pengeditan pesan, pesan tidak terkirim, dan laporan 
dibaca tidak tersedia. Pesan dikirim menggunakan SMS/MMS sebagai gantinya.

Penting: Saat menggunakan SMS/MMS, catatan pesan ini dapat muncul di tagihan telepon 
Anda dan catatan pesan tersebut dapat dirilis melalui penyedia seluler ke pemilik akun 
untuk nomor telepon tersebut.

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Pesan, lalu nyalakan atau matikan 
iMessage.

•	 Di Mac Anda: Buka Pesan , pilih Pesan > Pengaturan, klik iMessage, lalu klik “Keluar”. 
Konfirmasi bahwa Anda ingin keluar, lalu klik Keluar lagi.

https://support.apple.com/guide/icloud/mm0de0d4528d
https://support.apple.com/guide/icloud/mm0de0d4528d
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  Menyalakan dan mematikan laporan dibaca

Laporan dibaca iMessage memberi tahu pengguna iMessage ketika pesan mereka 
telah dibaca. Dengan laporan dibaca menyala, orang yang mengirimi Anda iMessage 
mendapatkan indikator Dibaca di bawah pesan setelah Anda membacanya. Dengan 
mematikan laporan dibaca, mereka hanya melihat bahwa pesan telah terkirim.

Anda memiliki pilihan untuk mengirim laporan dibaca untuk semua percakapan, atau 
hanya untuk satu percakapan. Jika Anda telah menyalakan laporan dibaca untuk semua 
percakapan, Anda masih dapat mematikannya untuk satu percakapan—dan sebaliknya.

Catatan: Laporan dibaca tidak didukung dengan pesan SMS dan teks grup.

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Pesan, lalu nyalakan atau matikan 
Laporan Dibaca.

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Buka Pesan , buka Pesan > 
Pengaturan, klik tab iMessage, lalu pilih atau batal pilih Kirim Laporan Dibaca.

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Buka Pesan , buka Pesan > 
Preferensi, klik tab iMessage, lalu pilih atau batal pilih Kirim Laporan Dibaca.

  Mengedit pesan terkirim

Di iOS 16, iPadOS 16.1, dan macOS 13, atau lebih baru, Anda dapat mengedit pesan yang 
baru saja dikirim hingga lima kali dalam waktu 15 menit setelah mengirimnya. Ini memberi 
Anda kesempatan untuk memperbaiki kesalahan pengetikan. Penerima melihat bahwa 
pesan telah diedit dan dapat melihat riwayat edit.

Catatan: Pesan SMS tidak dapat diedit.

Jika penerima Anda memiliki perangkat Apple dengan versi iOS, iPadOS, atau macOS yang 
lebih lama, mereka akan menerima pesan tindak lanjut dengan kata pengantar “Diedit ke” 
dan pesan baru Anda dalam tanda kutip.

•	 Di iPhone atau iPad Anda: Ketuk Pesan , sentuh dan tahan gelembung pesan, ketuk 
Edit, lalu edit pesan dan kirim lagi.

•	 Di Mac Anda: Buka Pesan , Control-klik gelembung pesan, pilih Edit, lalu edit pesan 
dan kirim lagi.

  Membatalkan pengiriman pesan

Di iOS 16, iPadOS 16.1, macOS 13, atau lebih baru, Anda dapat membatalkan pengiriman 
pesan yang baru dikirim hingga 2 menit setelah mengirimnya. Ini memberi Anda 
kesempatan untuk menarik kembali pesan yang secara tidak sengaja dikirim ke orang yang 
salah. Penerima melihat bahwa pesan tidak terkirim.

Catatan: Pengiriman pesan SMS tidak dapat dibatalkan.

•	 Di iPhone atau iPad Anda: Ketuk Pesan , sentuh dan tahan gelembung pesan, lalu 
ketuk Urungkan Pengiriman.

Catatan yang mengonfirmasi bahwa Anda belum mengirim pesan akan muncul di 
transkrip percakapan—milik Anda dan penerima.

•	 Di Mac Anda: Buka Pesan , Control-klik gelembung pesan, lalu ketuk Urungkan 
Pengiriman.

Catatan yang mengonfirmasi bahwa Anda belum mengirim pesan akan muncul di 
transkrip percakapan—milik Anda dan penerima.
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 Menghindari permintaan menipu untuk berbagi info
Hati-hati jika Anda menerima pesan tanpa persetujuan Anda yang meminta Anda 
untuk menerima hadiah, mengunduh dokumen, menginstal perangkat lunak, atau 
membuka tautan yang mencurigakan. Orang yang menginginkan akses ke informasi 
pribadi Anda menggunakan cara apa pun yang dapat mereka lakukan—email dan 
pesan teks buatan, iklan pop-up yang menipu, unduhan palsu, spam kalender, bahkan 
panggilan telepon—untuk membujuk Anda berbagi informasi, seperti Akun Apple atau  
kata sandi Anda, atau meminta Anda untuk menyediakan kode verifikasi untuk autentikasi 
dua faktor.

Untuk kiat mengenai cara menghindari penipuan yang meretas akun atau informasi pribadi 
Anda, lihat artikel Dukungan Apple “Mengenali dan menghindari skema rekayasa sosial 
termasuk pesan phising, panggilan telepon penipuan, dan penipuan lainnya”  
(https://support.apple.com/102568).

Catatan: Phishing adalah percobaan penipuan untuk mendapatkan informasi pribadi  
dari Anda.

 Memblokir panggilan dan pesan dari orang tertentu
Jika Anda menerima panggilan, panggilan FaceTime, pesan, atau email dari seseorang yang 
tidak Anda inginkan, Anda dapat memblokir mereka agar tidak menghubungi Anda di masa 
mendatang. Jika Anda memblokir seseorang di satu perangkat, mereka diblokir di semua 
perangkat Apple yang masuk dengan Akun Apple yang sama.

 PENTING: Orang yang Anda blokir tidak menerima pemberitahuan bahwa mereka telah 
diblokir dan Anda masih dapat memanggil, mengirimkan pesan, atau mengirimkan email 
kepada kontak yang diblokir tanpa membuka blokir. Namun, jika Anda sebelumnya berbagi 
lokasi Anda dengan mereka, mereka akan menerima pemberitahuan bahwa Anda telah 
berhenti berbagi lokasi setelah Anda memblokir mereka.

Memblokir kontak di Telepon, FaceTime, Pesan, atau Mail memblokir mereka di keempat 
app tersebut.

https://support.apple.com/102568
https://support.apple.com/102568
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  Memblokir panggilan suara, panggilan FaceTime, Pesan, dan Mail dari orang 
tertentu

•	 App Telepon di iPhone Anda: Di app Telepon, ketuk Favorit, Terbaru, atau Pesan Suara, 
ketuk  di samping nama, nomor telepon, atau alamat email kontak yang ingin Anda 
blokir, gulir ke bawah, ketuk Blokir Penelepon ini, lalu ketuk Blokir Kontak.

•	 App FaceTime di iPhone atau iPad Anda: Di riwayat panggilan FaceTime Anda, ketuk  
di samping nama, nomor telepon, atau alamat email kontak yang ingin Anda blokir, gulir 
ke bawah, ketuk Blokir Penelepon ini, lalu ketuk Blokir Kontak.

•	 App FaceTime di Mac Anda: Di riwayat panggilan FaceTime Anda, Control-klik nama, 
nomor telepon, atau alamat email kontak yang ingin Anda blokir, lalu pilih Blokir 
Penelepon ini.

•	 App Pesan di iPhone atau iPad Anda: Di app Pesan, ketuk percakapan, ketuk nama atau 
nomor di bagian atas percakapan, ketuk , gulir ke bawah, lalu ketuk Blokir Penelepon ini.

•	 App Pesan di Mac Anda: Di riwayat Pesan Anda, pilih nama, nomor telepon, atau  
alamat email orang yang ingin Anda blokir. Dari menu Percakapan, pilih Blokir Orang, 
lalu klik Blokir.

•	 App Mail di iPhone atau iPad Anda: Di app Mail, pilih pesan email dari pengirim, ketuk 
namanya di bagian atas email, pilih Blokir Kontak ini, lalu ketuk Blokir Kontak ini.

•	 App Mail di Mac Anda: Di app Mail, pilih pesan email dari pengirim, klik panah di 
samping nama mereka di bagian atas email, lalu dari menu pop-up pilih Blokir Kontak ini.

Ikon Diblokir  muncul di samping nama pengirim di daftar pesan dan spanduk 
ditambahkan ke pesannya untuk menandakan bahwa mereka diblokir. Spanduk juga 
menyediakan tautan ke panel Diblokir pada pengaturan Mail, tempat Anda dapat 
mengelola pengirim yang diblokir.

Catatan: Jika pengirim telah ditandai sebagai VIP di mail, Anda harus mengetuk Hapus dari 
VIP terlebih dahulu sebelum dapat memblokirnya.

  Mengelola kontak Anda yang diblokir

Anda dapat mengelola kontak Anda yang diblokir melalui salah satu dari empat app yang 
memungkinkan pemblokiran—Telepon, FaceTime, Pesan, dan Mail. Membuka blokir di satu 
app akan membuka blokir di keempat app. Lakukan salah satu hal berikut untuk melihat 
daftar nomor yang telah Anda blokir:

•	 iPhone: Buka Pengaturan  > Telepon, lalu ketuk Kontak yang Diblokir.

•	 FaceTime di iPhone atau iPad Anda: Buka Pengaturan  > FaceTime, lalu di bawah 
Panggilan, ketuk Kontak yang Diblokir.

•	 FaceTime di Mac Anda: Buka FaceTime, buka FaceTime > Pengaturan (atau FaceTime > 
Preferensi) di bar menu, lalu klik Diblokir.

•	 App Pesan di iPhone atau iPad Anda: Buka Pengaturan  > Pesan, lalu di bawah  
SMS/MMS, ketuk Kontak yang Diblokir.

•	 App Pesan di Mac Anda: Buka Pesan, buka Pesan > Pengaturan (atau Pesan > 
Preferensi), klik iMessage, lalu klik Diblokir.

•	 App Mail di iPhone atau iPad Anda: Buka Pengaturan > Mail, lalu di bawah Topik, ketuk 
Diblokir.

•	 App Mail di Mac Anda: Buka Mail, buka Mail > Pengaturan  (atau Mail > Preferensi), 
klik Mail Junk, lalu klik Diblokir.
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 Merekam dan mentranskrip panggilan di iPhone
Di beberapa negara dan wilayah, Anda hanya dapat merekam panggilan telepon audio. 
Jika seseorang mulai merekam panggilan, kedua peserta akan menerima pemberitahuan 
audio bahwa panggilan sedang direkam. Pemberitahuan audio diputar ulang secara berkala 
selama panggilan. Anda tidak dapat mencegah seseorang menyalakan rekaman panggilan, 
tapi Anda dapat menghentikannya dengan mengakhiri panggilan.

Rekaman panggilan hanya tersedia di wilayah dan bahasa tertentu. Namun, hanya orang 
yang memulai panggilan yang perlu memiliki fitur ini.

PENTING: Mungkin ada app pihak ketiga (app yang dibuat oleh perusahaan selain Apple) 
yang memungkinkan seseorang merekam panggilan telepon Anda, dan mereka mungkin 
tidak memberikan peringatan.

  Merekam panggilan

Sebelum memulai, pastikan peserta panggilan lainnya bersedia dan memberikan 
persetujuan tegas untuk direkam.

1.	 Buka app Telepon  di iPhone Anda.

2.	 Lakukan panggilan.

3.	 Selama panggilan, ketuk .

Kedua peserta panggilan mendengar pemberitahuan audio bahwa panggilan sedang 
direkam.

4.	 Untuk berhenti merekam, ketuk  atau akhiri panggilan.

Rekaman panggilan secara otomatis disimpan ke folder Rekaman Panggilan di app 
Catatan.

https://www.apple.com/ios/feature-availability/
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  Mengakses rekaman atau transkrip panggilan

Rekaman panggilan yang Anda mulai secara otomatis disimpan ke folder Rekaman 
Panggilan di app Catatan. Di wilayah dan bahasa tertentu, Anda juga dapat melihat 
transkrip panggilan yang direkam. Transkrip mungkin tidak segera tersedia; Anda mungkin 
melihat pesan bahwa transkripsi sedang berlangsung.

Catatan: Verifikasi akurasi transkripsi sebelum mengandalkannya. Ini mungkin bukan 
representasi percakapan yang sempurna.

1.	 Buka app Catatan  di iPhone Anda.

2.	 Pilih catatan di folder Rekaman Panggilan, lalu lakukan salah satu hal berikut:

•	 Memutar rekaman: Ketuk .

•	 Melihat transkrip: Ketuk Transkrip.

•	 Menyimpan atau menghapus rekaman audio dan transkrip: Ketuk , lalu pilih opsi.

  Menghentikan rekaman panggilan

Jika Anda tidak ingin panggilan direkam, lakukan salah satu hal berikut:

•	 Orang yang memulai rekaman dapat berhenti dengan mengetuk . Pesan diputar, yang 
menunjukkan bahwa rekaman panggilan telah berakhir.

•	 Salah satu peserta dapat mengakhiri panggilan dengan mengetuk .

Catatan: Apa pun yang direkam secara otomatis tersimpan di app Catatan orang yang 
memulai rekaman.

  Mematikan Rekaman Panggilan di iPhone Anda

Rekaman Panggilan tersedia secara default, tapi Anda dapat menghapusnya sebagai 
pilihan. Ini mencegah Anda merekam panggilan, tapi tidak mencegah orang lain merekam 
panggilan dengan Anda.

1.	 Buka Pengaturan  > App > Telepon.

2.	 Ketuk Rekaman Panggilan, lalu matikan Rekaman Panggilan.

Tanggal Terbit: 31 Maret 2025

https://www.apple.com/ios/feature-availability/
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 Mengamankan NameDrop

 Apa itu NameDrop?
NameDrop (bagian dari AirDrop) memungkinkan pengguna iPhone dan Apple Watch untuk 
berbagi informasi kontak mereka dengan mudah hanya dengan mendekatkan perangkat 
mereka. Anda dapat memilih detail kontak tertentu yang ingin Anda bagikan—atau tidak 
ingin Anda bagikan.

NameDrop bekerja secara otomatis. Jika Anda perlu mematikan NameDrop, lihat Mematikan 
NameDrop nanti di petunjuk ini.

Catatan: NameDrop memerlukan iOS 17.1, watchOS 10.1, atau lebih baru di kedua 
perangkat; NameDrop didukung di Apple Watch SE generasi ke-2, Apple Watch Series 7 
dan lebih baru, dan model Apple Watch Ultra.

  Meninjau dan memperbarui Kartu Kontak Anda

Anda dapat memperbarui informasi yang Anda bagikan di NameDrop dengan  
memperbarui Kartu Kontak Anda—misalnya, jika Anda hanya ingin membagikan nama depan 
atau inisial Anda.

Catatan: NameDrop hanya membagikan nama Anda, nomor telepon, atau alamat email yang 
Anda pilih, dan informasi Poster Kontak yang terkait dengan Kartu Kontak Anda. NameDrop 
tidak membagikan informasi lain di Kartu Kontak Anda, seperti alamat rumah atau hari 
ulang tahun Anda. Saat membagikan informasi kontak Anda melalui Kontak atau NameDrop, 
kata ganti Anda akan dibagikan secara default. Saat Anda membagikan informasi kontak 
orang lain, kata ganti mereka tidak akan pernah dibagikan.
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1.	 Buka app Kontak .

2.	 Ketuk Kartu Saya > Edit.

3.	 Tinjau dan perbarui nama Anda, nomor telepon, dan alamat email yang ingin Anda 
bagikan melalui NameDrop.

Untuk mempelajari lebih lanjut, lihat:

•	 Menambahkan atau mengedit info kontak dan foto Anda di iPhone di Petunjuk 
Pengguna iPhone

(https://support.apple.com/guide/iphone/iph18b749db1)

•	 Menambahkan atau mengedit info kontak dan foto Anda di iPad di Petunjuk 
Pengguna iPad

(https://support.apple.com/guide/ipad/ipadfcfa2d42)

  Membagikan info kontak Anda

Anda dapat membagikan info kontak Anda dengan orang lain.

1.	 Lakukan salah satu hal berikut ini:

•	 Berbagi dari iPhone atau iPad: Tahan iPhone Anda beberapa sentimeter di atas 
iPhone atau Apple Watch orang lain.

•	 Berbagi dari Apple Watch ke Apple Watch: Buka app Kontak  di Apple Watch 
Anda, ketuk gambar Anda di pojok kanan atas, ketuk Bagikan, lalu satukan jam Anda 
dengan Apple Watch orang lain.

•	 Cahaya muncul dari kedua perangkat, dan Apple Watch bergetar untuk menandakan 
bahwa koneksi sedang dibuat.

2.	 Terus dekatkan perangkat Anda dengan perangkat orang lain hingga NameDrop muncul 
di kedua layar.

3.	 Pilih untuk membagikan kartu kontak Anda (atau nomor telepon atau alamat email 
tertentu) dan menerima kartu kontak orang lain, atau pilih untuk hanya menerima kartu 
kontak orang lain.

Jika Anda membagikan kartu kontak Anda, ketuk , pilih bidang yang ingin Anda 
sertakan, lalu ketuk Simpan. Bidang yang sama dipilih secara default saat Anda 
menggunakan NameDrop di lain waktu.

Untuk membatalkan, jauhkan kedua perangkat atau kunci iPhone Anda sebelum transfer 
NameDrop selesai.

Untuk mempelajari lebih lanjut, lihat:

•	 Menggunakan NameDrop di iPhone untuk berbagi info kontak Anda di Petunjuk 
Pengguna Apple Watch

(https://support.apple.com/guide/iphone/iph1b6c664b7)

•	 Menggunakan NameDrop di Apple Watch untuk berbagi informasi kontak di Petunjuk 
Pengguna Apple Watch

(https://support.apple.com/guide/watch/apd46c6e11cf)

https://support.apple.com/guide/iphone/iph18b749db1
https://support.apple.com/guide/ipad/ipadfcfa2d42
https://support.apple.com/guide/iphone/iph1b6c664b7/ios
https://support.apple.com/guide/watch/apd46c6e11cf/
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  Mematikan NameDrop

1.	 Buka app Pengaturan .

2.	 Ketuk Umum > AirDrop.

3.	 Matikan Menyatukan Perangkat.

 Mengelola pengaturan berbagi Foto di perangkat Apple
Dengan Album Bersama di Foto, Anda memilih foto dan video yang ingin Anda bagikan 
serta dengan siapa Anda ingin berbagi. Anda juga dapat mengubah pengaturan berbagi 
kapan saja. Jika Anda berhenti berbagi foto atau album dengan seseorang, akses mereka 
ke album bersama dan kontennya akan dihapus.

Jika Anda adalah pelanggan album bersama, Anda dapat menghapus foto apa pun yang 
Anda bagikan. Anda juga dapat memilih Batal Berlangganan untuk membatalkan langganan 
dari album bersama.

Untuk mengontrol dengan siapa Anda berbagi konten dari Mac, lihat “Mengelola 
pengaturan Dibagikan dengan Anda di perangkat Apple” nanti di petunjuk ini.
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  Mengelola pengaturan berbagi untuk Album Bersama di Foto di iPhone atau iPad

1.	 Pilih album bersama di iPhone atau iPad Anda, lalu ketuk Undang Orang.

2.	 Lakukan salah satu hal berikut:

•	 Untuk mengundang pelanggan baru: Ketuk Undang Orang, lalu masukkan nama 
pelanggan yang ingin Anda tambahkan.

Pelanggan dapat menambahkan foto dan video ke album. Matikan tombol Pelanggan 
Dapat Memposting sehingga hanya Anda yang dapat menambahkan foto dan video.

•	 Untuk menghapus pelanggan: Ketuk nama pelanggan, lalu ketuk Hapus Pelanggan.

•	 Untuk menghapus diri Anda dari Album Bersama: Lakukan salah satu hal berikut ini:

•	 Ketuk elipsis di pojok kanan atas, lalu ketuk Berhenti Berlangganan.

•	 Ketuk ikon akun iCloud di pojok kanan atas, lalu ketuk Berhenti Berlangganan.

•	 Untuk mematikan pemberitahuan: Geser untuk mematikan Pemberitahuan.

Untuk mempelajari lebih lanjut, lihat:

•	 “Membagikan foto dan video di iPhone” di Petunjuk Pengguna iPhone

(https://support.apple.com/guide/iphone/iphf28f17237)

•	 “Membagikan foto dan video di iPad” di Petunjuk Pengguna iPad

(https://support.apple.com/guide/ipad/ipad4f44c78f)

https://developer.apple.com/library/content/documentation/Cocoa/Conceptual/PropertyLists/AboutPropertyLists/AboutPropertyLists.html#//apple_ref/doc/uid/10000048i-CH3-54303
https://support.apple.com/guide/ipad/ipad4f44c78f
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  Mengelola pengaturan Perpustakaan Foto Bersama iCloud di iPhone atau iPad

Perpustakaan Foto Bersama iCloud memungkinkan Anda berbagi foto dan video dengan 
lancar dengan hingga lima orang lainnya. Saat Anda menambahkan foto dan video ke 
Perpustakaan Foto Bersama iCloud, foto dan video tersebut keluar dari Perpustakaan 
Pribadi Anda dan ke Perpustakaan Bersama. Dengan Perpustakaan Bersama, Anda 
dapat memilih apa yang ingin dibagikan, atau secara otomatis berbagi konten langsung 
dari kamera. Semua peserta memiliki izin yang sama untuk menambahkan, mengedit, 
dan menghapus konten di Perpustakaan Bersama, sedangkan orang yang mengatur 
Perpustakaan Bersama, pembuat perpustakaan, menyediakan penyimpanan iCloud untuk 
semua konten.

Peserta dapat memilih untuk keluar dari Perpustakaan Bersama kapan saja.

Jika Anda adalah pembuat perpustakaan, Anda dapat menghapus peserta dari 
Perpustakaan Bersama atau menghapus perpustakaan bersama kapan saja. Saat Anda 
menghapus peserta dari Perpustakaan Bersama Anda, mereka menerima pemberitahuan 
dan dapat menyalin semua item di Perpustakaan Bersama ke Perpustakaan Pribadi mereka. 
Peserta tidak dapat menghapus peserta lain.

Catatan: Perpustakaan Bersama di Foto memerlukan iOS 16 atau iPadOS 16.1 atau lebih 
baru. Untuk menemukan versi perangkat lunak yang diinstal di perangkat Anda, buka 
Pengaturan > Umum, lalu ketuk Mengenai.

•	 Buka Pengaturan  > Foto > Perpustakaan Bersama, lalu lakukan salah satu hal berikut:

•	 Untuk menghapus peserta dari Perpustakaan Bersama: Ketuk Hapus Peserta.

•	 Untuk meninggalkan Perpustakaan Bersama: Ketuk Tinggalkan Perpustakaan 
Bersama.

Saat Anda keluar dari Perpustakaan Bersama, Anda dapat menyalin apa saja dari 
Perpustakaan Bersama ke perpustakaan Anda sendiri, atau hanya konten yang Anda 
tambahkan.

•	 Untuk menghapus Perpustakaan Bersama (Anda harus menjadi pengelola): Ketuk 
Hapus Perpustakaan Bersama.

Semua peserta diberi tahu bahwa Perpustakaan Bersama telah dihapus.

Untuk mempelajari lebih lanjut, lihat:

•	 “Mengatur atau bergabung dengan Perpustakaan Foto Bersama iCloud di Foto” di 
Petunjuk Pengguna iPhone

(https://support.apple.com/guide/iphone/iph28ac9ea81)

•	 “Mengatur atau bergabung dengan Perpustakaan Foto Bersama iCloud di Foto” di 
Petunjuk Pengguna iPad

(https://support.apple.com/guide/ipad/ipad94c5ed43)

https://support.apple.com/guide/iphone/iph28ac9ea81
https://support.apple.com/guide/ipad/ipad94c5ed43
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  Mengelola pengaturan berbagi untuk Album Bersama di Foto di Mac

1.	 Buka app Foto  di Mac Anda, lalu klik album bersama di bawah Album Bersama di bar 
samping.

2.	 Klik  di bar alat.

3.	 Di bidang Undang Orang, lakukan salah satu hal berikut:

•	 Mengundang pelanggan baru: Masukkan alamat email.

Jika orang yang Anda undang tidak menggunakan iCloud, Anda dapat memilih kotak 
centang Situs Web Publik untuk membuat URL untuk album bersama Anda. Siapa 
pun dengan URL ini dapat melihat dan mengunduh konten album bersama.

•	 Menghapus pelanggan: Pilih alamat email pelanggan, lalu tekan Hapus.

•	 Mengundang kembali pelanggan: Klik panah bawah di samping nama pelanggan dan 
pilih Kirim Ulang Undangan.

Untuk mempelajari lebih lanjut, lihat:

•	 “Apa itu album bersama di Foto di Mac?” di Petunjuk Pengguna Foto

(https://support.apple.com/guide/photos/pht7a4c765b)

•	 “Menambahkan dan menghapus orang di album bersama” di Petunjuk Pengguna Foto

(https://support.apple.com/guide/photos/phtdfcac5c5/)

https://support.apple.com/guide/photos/pht7a4c765b
https://support.apple.com/guide/photos/phtdfcac5c5
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  Menghapus peserta dari Perpustakaan Foto Bersama iCloud di Mac

Catatan: Perpustakaan Bersama di Foto di Mac memerlukan macOS 13 atau lebih baru. 
Untuk menemukan versi perangkat lunak yang diinstal di perangkat Anda, dari menu  
Apple  di pojok kiri atas layar Anda, pilih Mengenai Mac Ini.

Jika peserta sudah menjadi bagian dari Perpustakaan Bersama selama kurang dari 7 hari, 
mereka hanya dapat mengambil item yang mereka tambahkan.

1.	 Di app Foto  di Mac Anda, pilih Foto > Pengaturan, lalu klik Perpustakaan Bersama.

2.	 Klik  di samping orang yang ingin Anda hapus, lalu pilih Hapus.

3.	 Klik Hapus dari Perpustakaan Bersama.

Untuk mempelajari lebih lanjut, lihat:

•	 “Apa itu Perpustakaan Foto Bersama iCloud di Foto di Mac?” di Petunjuk Pengguna Foto

(https://support.apple.com/guide/photos/pht153ab3a01)

  Meninggalkan atau menghapus Perpustakaan Foto Bersama iCloud di Foto di Mac

Peserta dapat memilih untuk keluar dari Perpustakaan Bersama kapan saja. Jika Anda adalah 
pengelola Perpustakaan Bersama, Anda dapat menghapusnya. Saat Anda menghapus 
Perpustakaan Bersama, semua peserta menerima pemberitahuan dan dapat memilih untuk 
menyimpan semua item di Perpustakaan Bersama di Perpustakaan Pribadi mereka.

Jika Anda keluar dari Perpustakaan Bersama kurang dari 7 hari setelah bergabung, Anda 
hanya dapat menyimpan item yang Anda tambahkan.

Catatan: Perpustakaan Bersama di Foto di Mac memerlukan macOS 13 atau lebih baru. 
Untuk menemukan versi perangkat lunak yang diinstal di perangkat Anda, dari menu  
Apple  di pojok kiri atas layar Anda, pilih Mengenai Mac Ini.

1.	 Di app Foto  di Mac Anda, pilih Foto > Pengaturan, lalu klik Perpustakaan Bersama.

2.	 Klik Keluar Perpustakaan Bersama (jika Anda adalah peserta) atau Hapus Perpustakaan 
Bersama (jika Anda adalah pengelola).

3.	 Pilih salah satu pilihan berikut:

•	 Simpan semuanya: Menambahkan semua foto di Perpustakaan Bersama ke 
Perpustakaan Pribadi Anda.

•	 Hanya simpan yang saya tambahkan: Hanya menambahkan foto yang Anda 
tambahkan ke Perpustakaan Bersama ke Perpustakaan Pribadi Anda.

4.	 Klik Hapus Perpustakaan Bersama, lalu klik Hapus Perpustakaan Bersama lagi untuk 
mengonfirmasi hapus.

Untuk mempelajari lebih lanjut, lihat:

•	 “Apa itu Perpustakaan Foto Bersama iCloud di Foto di Mac?” di Petunjuk Pengguna Foto

(https://support.apple.com/guide/photos/pht153ab3a01)

•	 “Meninggalkan atau menghapus Perpustakaan Bersama” di Petunjuk Pengguna Foto

(https://support.apple.com/guide/photos/pht4dd77b3aa#pht82b300b22)

https://support.apple.com/guide/photos/pht153ab3a01
https://support.apple.com/guide/photos/pht153ab3a01
https://support.apple.com/guide/photos/pht4dd77b3aa#pht82b300b22
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 Mengelola Grup Tab bersama di Safari
Anda dapat berbagi Grup Tab dan berkolaborasi dengan orang-orang yang menggunakan 
iCloud. Grup tab bersama dapat memiliki total 100 peserta. Peserta dapat menambahkan 
dan menghapus tab dari Grup Tab, dan setiap orang melihat pembaruan secara real time.

Setiap orang yang Anda ajak berkolaborasi harus masuk ke Akun Apple mereka, 
menyalakan Safari di pengaturan iCloud (https://support.apple.com/guide/iphone/
iphde0f868fd), dan menyalakan autentikasi dua faktor.

  Mengelola Grup Tab bersama di Safari di iPhone atau iPad

Jika Anda tidak melihat tombol Kolaborasi, Anda tidak memiliki Grup Tab bersama.

1.	 Ketuk Safari , lalu ketuk  di pojok kanan atas.

2.	 Ketuk Kelola Grup Tab Bersama, lalu lakukan salah satu hal berikut:

•	 Menghapus seseorang: Ketuk nama, lalu ketuk Hapus Akses.

•	 Berhenti berbagi dengan setiap orang: Ketuk Berhenti Berbagi.

•	 Menambahkan seseorang: Ketuk Bagikan dengan Lebih Banyak Orang, lalu undang 
mereka.

Untuk mempelajari lebih lanjut, lihat:

•	 “Menambahkan dan menghapus orang dari Grup Tab bersama” di Petunjuk  
Pengguna iPhone

(https://support.apple.com/guide/iphone/iph4a323d663#iph5f23c7659)

•	 “Menambahkan dan menghapus orang dari Grup Tab bersama” di Petunjuk  
Pengguna iPad

(https://support.apple.com/guide/ipad/ipad76b9549e#iPad252604e8)

https://support.apple.com/guide/iphone/iph4a323d663#iph5f23c7659
https://support.apple.com/guide/ipad/ipadf0a1530e
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  Mengelola Grup Tab bersama di Safari di Mac

Jika Anda tidak melihat tombol Kolaborasi, Anda tidak memiliki Grup Tab bersama.

1.	 Di app Safari  di Mac Anda, klik  di bar alat.

2.	 Klik Kelola Grup Tab Bersama, lalu lakukan salah satu hal berikut:

•	 Menghapus seseorang: Klik nama, klik Hapus Akses, lalu klik Lanjutkan.

•	 Berhenti Berbagi dengan setiap orang: Klik Berhenti Berbagi, lalu klik Lanjutkan.

•	 Menambahkan seseorang: Klik Bagikan dengan Lebih Banyak Orang, lalu klik Pesan 
untuk mengundang mereka.

Untuk mempelajari lebih lanjut, lihat:

•	 “Menambahkan dan menghapus orang dari Grup Tab bersama” di Petunjuk Pengguna Safari 

(https://support.apple.com/guide/iphone/iph4a323d663#iph5f23c7659)

 Menjaga kerahasiaan riwayat penelusuran Anda di Safari  
dan Peta
Meninjau dan menghapus riwayat pencarian dan cache untuk browser dan app lain mungkin 
merupakan praktik yang baik jika Anda khawatir seseorang memiliki akses ke perangkat 
Anda. Banyak app menyimpan informasi mengenai apa yang telah Anda telusuri dan apa 
yang telah Anda lihat sehingga mudah bagi Anda untuk menemukannya kembali di masa 
mendatang. Misalnya, saat Anda menggunakan app Peta, memiliki riwayat lokasi yang telah 
Anda telusuri atau navigasikan dapat mempermudah untuk menavigasi kembali ke tempat 
yang baru saja Anda kunjungi.

Jika Anda berada dalam situasi pribadi yang tidak aman dan ingin mencari strategi 
keselamatan online tapi tidak ingin Safari menyimpan catatan apa yang telah Anda lihat, 
Anda dapat membuka jendela Penelusuran Pribadi di iPhone, iPad, dan Mac. Saat Anda 
menggunakan Penelusuran Pribadi, detail penelusuran Anda tidak disimpan dan tidak 
dibagikan di semua perangkat Anda. Selain itu, jika Anda telah memperbarui perangkat 
Anda ke iOS 17, iPadOS 17, macOS 14, atau lebih baru, Safari mengunci tab Penelusuran 
Pribadi setelah beberapa lama tidak aktif sehingga hanya dapat dibuka dengan kata sandi, 
kode sandi, Face ID, atau Touch ID, yang melindungi privasi Anda saat Anda jauh dari 
perangkat. Anda dapat menghapus riwayat penelusuran dan membuka jendela Penelusuran 
Pribadi di iPhone, iPad, dan Mac.

https://support.apple.com/guide/iphone/iph4a323d663#iph5f23c7659
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Lihat cara membuka jendela Privasi di iPhone, iPad, atau Mac nanti di petunjuk ini.

  Membersihkan riwayat penelusuran Anda di Safari

Jika Anda mencari informasi mengenai strategi keselamatan online dan khawatir seseorang 
mungkin melihat riwayat penelusuran Anda, Anda dapat menghapus semua catatan lokasi 
penelusuran Anda yang disimpan Safari.

•	 Di iPhone atau iPad Anda: Buka Pengaturan  > Safari > Bersihkan Riwayat dan Data 
Situs Web.

•	 Di Mac Anda: Buka app Safari , pilih Riwayat > Bersihkan Riwayat, klik menu pop-up, 
lalu pilih seberapa jauh Anda ingin membersihkan riwayat penelusuran.

Saat Anda membersihkan riwayat Anda, Safari menghapus data yang disimpan sebagai 
hasil dari penelusuran Anda, termasuk:

•	 Riwayat halaman web yang Anda kunjungi

•	 Daftar mundur dan maju untuk halaman web yang dibuka

•	 Daftar situs yang sering dikunjungi

•	 Pencarian terbaru

•	 Ikon untuk halaman web

•	 Snapshot yang disimpan untuk halaman web yang dibuka

•	 Daftar item yang Anda unduh (file yang diunduh tidak dihapus)

•	 Situs web yang Anda tambahkan untuk Pencarian Situs Web Cepat

•	 Situs web yang meminta untuk menggunakan lokasi Anda

•	 Situs web yang meminta untuk mengirimi Anda pemberitahuan
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  Menghapus petunjuk arah dan favorit terbaru di Peta di iPhone atau iPad

1.	 Buka app Peta , lalu gulir ke bawah di bidang pencarian ke Terbaru.

2.	 Lakukan salah satu hal berikut ini:

•	 Gesek rute terbaru ke kiri.

•	 Ketuk Lainnya langsung di atas daftar, lalu gesek rute terbaru ke kiri; atau untuk 
menghapus grup rute, ketuk Hapus di atas grup.

3.	 Jika Anda ingin menghapus lokasi Favorit, gulir ke Favorit, lalu ketuk Lainnya. Gesek dari 
kanan ke kiri di lokasi Favorit yang ingin Anda hapus, atau ketuk Edit dan ketuk  untuk 
menghapus beberapa Favorit.

  Menghapus petunjuk arah dan favorit terbaru di Peta di Mac

1.	 Buka app Peta , lalu gulir ke Terbaru di bar samping.

2.	 Di bawah Terbaru, klik Hapus Terbaru.

3.	 Jika Anda ingin menghapus lokasi Favorit, Control-klik lokasi (di bar samping di bawah 
Favorit), lalu pilih Hapus dari Favorit.

  Membuka jendela Penelusuran Pribadi di iPhone

1.	 Buka app Safari , lalu ketuk .

2.	 Ketuk  di tengah bawah bar Tab di bagian bawah layar, lalu ketuk Pribadi.

Tab secara otomatis ditambahkan ke Grup Tab yang disebut Pribadi. Anda dapat 
membuka beberapa tab pribadi di grup.

Anda dapat mengonfirmasi dengan mudah bahwa Anda berada dalam Mode Penelusuran 
Pribadi dengan memeriksa bahwa bar bidang pencarian berwarna abu-abu atau yang 
menampilkan kata Pribadi.

Untuk menyembunyikan situs dan keluar dari Mode Penelusuran Pribadi, ketuk , lalu 
ketuk  untuk membuka Grup Tab berbeda dari menu di bagian bawah layar. Situs pribadi 
akan muncul kembali saat Anda menggunakan Mode Penelusuran Pribadi di lain waktu.

Untuk menutup tab pribadi, ketuk , lalu gesek ke kiri setiap tab yang Anda ingin tutup.

  Membuka jendela Penelusuran Pribadi di iPad

•	 Di app Safari, ketuk , lalu ketuk Pribadi.

Saat Mode Penelusuran Pribadi menyala, latar belakang bidang pencarian akan 
berwarna hitam, bukan putih dan situs yang Anda kunjungi tidak muncul di Riwayat pada 
iPad atau di daftar tab pada perangkat Anda lainnya. Anda dapat membuka beberapa 
tab pribadi di Grup Tab Pribadi.

Untuk menyembunyikan dan keluar dari Mode Penelusuran Pribadi, ketuk , lalu 
alihkan ke grup tab berbeda. Tab akan muncul kembali saat Anda menggunakan Mode 
Penelusuran Pribadi di lain waktu.
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  Membuka jendela Penelusuran Pribadi di Mac

1.	 Di app Safari , pilih File > Jendela Pribadi Baru, atau alihkan ke jendela Safari yang 
sudah menggunakan Penelusuran Pribadi.

Jendela yang menggunakan Penelusuran Pribadi memiliki bidang Pencarian Cerdas 
gelap dengan teks putih.

2.	 Telusuri seperti biasanya.

Catatan: Saat perangkat Anda terkunci atau dalam mode tidur, atau jika Anda 
tidak sedang menggunakan Safari secara aktif, jendela pribadi Anda di Safari akan 
terkunci. Saat Anda membuka kunci atau membangunkan perangkat Anda, atau mulai 
menggunakan Safari lagi, cukup buka kunci jendela pribadi Anda dengan Face ID, 
Touch ID, atau kode sandi atau kata sandi perangkat Anda.
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  Jika Anda ingin selalu membuka jendela dengan Penelusuran Pribadi di Mac

1.	 Di app Safari , pilih Safari > Preferensi, lalu klik Umum.

2.	 Klik menu pop-up “Safari membuka dengan”, lalu pilih “Jendela pribadi baru”.

Jika Anda tidak melihat pilihan ini, lakukan salah satu hal berikut:

•	 Di Mac Anda dengan macOS 13 atau lebih baru: Pilih menu Apple  > Pengaturan 
Sistem, klik Desktop & Dock  di bar samping, lalu pastikan “Tutup jendela saat 
menutup app” dipilih.

•	 Di Mac Anda dengan macOS 12 atau lebih lama: Pilih menu Apple  > Preferensi 
Sistem, klik Umum , lalu pastikan “Tutup jendela saat menutup app” dipilih.

  Untuk meningkatkan privasi Safari lebih jauh

•	 Di folder Unduhan Anda, hapus item apa pun yang diunduh saat Anda menggunakan 
jendela Penelusuran Pribadi.

•	 Tutup jendela Penelusuran Pribadi yang masih terbuka untuk mencegah orang lain agar 
tidak menggunakan tombol Mundur dan Maju untuk melihat halaman yang telah Anda 
kunjungi.

 Mengelola pengaturan Dibagikan dengan Anda di  
perangkat Apple
Saat seseorang membagikan konten dengan Anda dari app Musik, Apple TV, News, Foto, 
Podcast, dan Safari, Dibagikan dengan Anda dapat mengaturnya secara otomatis ke bagian 
Dibagikan dengan Anda agar dapat diakses dengan mudah. Konten yang dibagikan dengan 
Anda di app Pesan secara otomatis diatur dalam bagian Dibagikan dengan Anda di app 
Musik, Apple TV, News, Foto, Podcast, dan Safari.

  Mengelola menurut orang di iPhone atau iPad

Jika terdapat konten yang dibagikan dengan Anda melalui Pesan yang tidak ingin Anda 
munculkan di app terkait, Anda dapat mematikan fitur ini menurut orang.

1.	 Ketuk Pesan  di iPhone atau iPad Anda, lalu ketuk percakapan yang kontennya tidak 
ingin Anda bagikan ke semua app.
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2.	 Saat topik terbuka, ketuk nama orang di bagian atas.

3.	 Matikan Tampilkan di Dibagikan dengan Anda, lalu ketuk Selesai.

Untuk mempelajari lebih lanjut, lihat:

•	 “Membagikan konten di Pesan” di Petunjuk Pengguna iPhone

(https://support.apple.com/guide/iphone/iphb66cfeaad)

•	 “Membagikan konten di Pesan” di Petunjuk Pengguna iPad

(https://support.apple.com/guide/ipad/ipad5bf3d77b)

  Mengelola menurut orang di Mac

Jika terdapat konten yang dibagikan dengan Anda melalui Pesan yang tidak ingin Anda 
munculkan di app terkait, Anda dapat mematikan fitur ini menurut orang.

1.	 Buka app Pesan  di Mac Anda, lalu pilih percakapan.

2.	 Klik  di pojok kanan atas percakapan, lalu batal pilih Tampilkan di Dibagikan dengan 
Anda untuk menghapus konten bersama dari bagian Dibagikan dengan Anda.

Saat Dibagikan dengan Anda dimatikan, Anda masih dapat mengepin konten bersama 
untuk menampilkannya di app terkait.

Untuk mempelajari lebih lanjut, lihat:

•	 “Melacak konten bersama di Pesan di Mac” di Petunjuk Pengguna Mac

(https://support.apple.com/guide/messages/ichtdc9ebc32)

  Mengelola menurut app di iPhone atau iPad

Jika Anda ingin menyalakan atau mematikan Dibagikan dengan Anda dalam app Musik, 
Apple TV, News, Foto, Podcast, atau Safari, Anda dapat menyesuaikan pengaturan Anda.

•	 Di iPhone atau iPad Anda, buka Pengaturan  > Pesan > Dibagikan dengan Anda, lalu 
matikan Berbagi Otomatis, atau matikan Dibagikan dengan Anda untuk app tertentu.

  Mengelola menurut app di Mac

Jika Anda ingin menyalakan atau mematikan Dibagikan dengan Anda dalam app Musik, 
Apple TV, News, Foto, Podcast, atau Safari, Anda dapat menyesuaikan pengaturan Anda.

1.	 Buka app Pesan  di Mac Anda.

2.	 Pilih Pesan > Pengaturan atau Preferensi.

3.	 Buka Dibagikan dengan Anda, lalu lakukan salah satu hal berikut:

•	 Untuk mematikan semua app: Klik Matikan.

•	 Untuk mematikan app yang dipilih: Batal pilih app.

Untuk mempelajari lebih lanjut, lihat:

•	 “Melacak konten bersama di Pesan di Mac” di Petunjuk Pengguna Mac

(https://support.apple.com/guide/messages/ichtdc9ebc32)

https://support.apple.com/guide/iphone/iphb66cfeaad
https://support.apple.com/guide/ipad/ipad5bf3d77b
https://support.apple.com/guide/messages/ichtdc9ebc32
https://support.apple.com/guide/messages/ichtdc9ebc32
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 Informasi tambahan

 Pertimbangan keamanan
Sebelum melakukan perubahan atau menghapus informasi, perhatikan:

•	 Anda mungkin ingin merekam aktivitas mencurigakan. Lihat juga Mendapatkan bukti 
terkait Akun Apple lain.

•	 Perubahan yang Anda buat pada berbagi atau akses mungkin diperhatikan orang lain. 
Cari ikon ini di seluruh petunjuk untuk informasi terkait keselamatan yang mungkin ingin 
Anda pertimbangkan sebelum mengambil tindakan: .

•	 Saat Anda mengubah hubungan berbagi, Anda mungkin kehilangan akses ke alat dan 
informasi yang mungkin penting bagi Anda.

•	 App yang dikembangkan oleh perusahaan lain (seperti Youtube atau Instagram) memiliki 
pengaturan masing-masing yang tidak dapat dikontrol Apple. Lihat petunjuk masing-
masing app untuk meninjau, mengelola, atau memeriksa apakah app tersebut mengirim 
pemberitahuan saat diubah. Lihat Pengaturan app pihak ketiga untuk informasi lainnya.

 Sumber daya keselamatan teknologi lainnya
Jika Anda memerlukan informasi atau dukungan lebih lanjut mengenai keselamatan terkait 
teknologi, Anda dapat mengunjungi situs web berikut.

Amerika Serikat

•	 The Safety Net Project di National Network to End Domestic Violence

•	 National Center for Victims of Crime

Inggris

•	 Refuge UK

Australia

•	 WESNET Safety Net Australia

https://www.techsafety.org/resources-survivors
https://victimsofcrime.org/getting-help/
https://refuge.org.uk/i-need-help-now/how-we-can-help-you/national-domestic-abuse-helpline/
https://techsafety.org.au/resources/resources-women/
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﻿Sumber daya dukungan lain
Untuk masalah terkait Apple lainnya, pertimbangkan sumber daya berikut.

 Dukungan Apple
Bantuan umum terkait Apple melalui sumber daya bantuan mandiri atau menghubungi ahli. 
Dukungan Apple memiliki akses yang sangat terbatas ke informasi Anda tanpa izin tertulis 
Anda dan tidak ada akses ke data dan/atau kata sandi Anda.

•	 Dukungan Apple (https://support.apple.com/id-id)

•	 A.S. – 1-800-275-2273; Di Kanada – 1-800-263-3394

 Keamanan Platform Apple
Cari Keamanan Platform Apple untuk informasi mengenai perangkat keras dan keamanan 
sistem, enkripsi dan perlindungan data, serta keamanan layanan—termasuk Akun Apple, 
iCloud, Masuk dengan Apple, Apple Pay, Pesan, FaceTime, dan Lacak.

 Privasi Apple
Jelajahi halaman web Privasi Apple untuk mengetahui fitur yang melindungi data Anda 
dan pengaturan yang memberi Anda kontrol, meninjau label nutrisi untuk app, dan laporan 
transparansi untuk permintaan pemerintah, serta memahami Kebijakan Privasi Apple.

 Data dan Privasi Anda
Masuk ke portal web Data dan Privasi dengan Akun Apple Anda untuk mempelajari lebih 
lanjut mengenai informasi yang dikumpulkan Apple, mendapatkan atau mentransfer salinan 
data Anda, dan memperbaiki, menonaktifkan, atau menghapus data Anda.

 Komunitas Dukungan Apple
Cari Komunitas Dukungan Apple untuk mendapatkan jawaban dan mengajukan pertanyaan 
dari pelanggan Apple lain (secara global).

https://support.apple.com/id-id
https://support.apple.com/guide/security/
https://www.apple.com/id/privacy/
https://privacy.apple.com/account
https://discussions.apple.com/welcome
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 Hak cipta dan merek dagang

Hak Cipta © 2025 Apple Inc. Semua hak cipta dilindungi undang-undang.

Penggunaan logo Apple “papan ketik” (Option-Shift-K) untuk tujuan komersial tanpa persetujuan tertulis dari 
Apple merupakan pelanggaran merek dagang dan persaingan tidak sehat yang melanggar hukum federal dan 
negara.

Apple, logo Apple, AirDrop, AirPods, AirTag, Apple Books, Apple Music, Apple Pay, Apple TV, Apple Wallet, 
Apple Watch, Apple Watch SE, Apple Watch Series, Apple Watch Ultra, Digital Crown, Face ID, FaceTime, FileVault, 
Finder, Find My, HomeKit, HomePod, HomePod mini, iMessage, iPad, iPadOS, iPad Pro, iPhone, iTunes, Launchpad, 
Lightning, Mac, MacBook, MacBook Air, MacBook Pro, macOS, Magic Keyboard, Magic Mouse, Magic Trackpad, 
NameDrop, OS X, Safari, Siri, dan Touch ID adalah merek dagang Apple Inc., yang terdaftar di A.S. dan negara 
serta wilayah lain.

App Store, iCloud, iCloud+, iCloud Keychain, dan iTunes Store adalah merek layanan Apple Inc., yang terdaftar di 
A.S. dan negara serta wilayah lainnya.

Apple
One Apple Park Way
Cupertino, CA 95014
apple.com

IOS adalah merek dagang atau merek dagang terdaftar dari Cisco di A.S. dan negara lain dan digunakan di bawah 
lisensi.

Merek kata dan logo Bluetooth® adalah merek dagang terdaftar milik Bluetooth SIG, Inc. Penggunaan merek ini 
oleh Apple berdasarkan lisensi.

Nama dan logo perusahaan dan produk lain yang disebutkan di sini adalah merek dagang masing-masing 
perusahaan tersebut.

Setiap upaya telah dilakukan untuk memastikan keakuratan informasi dalam buku panduan ini. Apple tidak 
bertanggung jawab atas kesalahan pencetakan atau penulisan.

Beberapa app tidak tersedia di semua wilayah. Ketersediaan app bisa berubah.

ID028-00805

https://www.apple.com
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